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33- វិធីសាស្រ្តងាយៗនៃការងាររដ្ឋបាល

ដោយដ្រើ  Mail Merge ក្នុង Word 2013 

37- គៃ្លឹះងាយៗ្រ្រារ់កកក្រដរា៉ោងនៃ 

Windows 8 Lock Screen

38- រញោឈរ់ការរំខាៃ នៃការដ្ញើ Email  ររ្រ ់

Facebook ៃិង Google+ ដៅកាៃ់ Email 

Account 

39- វិធីសាស្រ្តរដងកើត Recovery Drive

Software Review

41- រ៉ិៃ្រ្ររ់ក្នុងការកែក Partition ជាមួយ 

Easeus Partition Master Server 

Graphic Design & Multimedia

23- រែនាមៃ៉្រោសម៉ខ្រំរកដ�ើ Adobe 

Photoshop CS5
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ព្រឹត្តិការណ៍ជាតតិ នតិងអន្រជាតតិ
11- Hennessy V.S.O.P ្រដេទថ្ីឈាៃែូ

លទី្ោសារដៅកម្នុជា 

14-  ពិធីតាំងរងា្ោញ Wi-fi SD Card 

ែូលដល់ទី្ោសារកម្នុជាដ�ើយ

18-  ដលែធ្ោយលក្ខណាៈពិដ្រ្រនៃទូរ្រ័ព្ទ 

Google Nexus 5

20-  Nexus 7 Tablet ជំនាៃ់ដ្កាយររ្រ់ 

Asus ៃលងែូលរួមដៅ Google 1/0 

ដៅកខឧ្រភា

IT
 C

it
y 

m
ag

az
in

e 
page68page23



ចាងហ្វាងការផវាសាយ

អនុបណ្ឌិត ៈ បឹុល ច័ន្ទវីរៈ

នាយកគ្រប់គ្រង

Mr. ៈ JACKY SAM

គបធានផផនែកព័ត៌មាន និងនិពន្ធ

លោក ៈ អ៊ុក គំនិត

ផផនែកព័ត៌មាន និងនិពន្ធ

លោក ៈ ផាន់ ណូរា៉

លោក ៈ វង្ស វិច្័យ

លោក ៈ នួន គីមហុង

លោក ៈ ស្ុីន ស្ងហុង

ផផនែករចនាទំព័រ

បបធានលោក ៈ ស្្យ ស្រីវុត្្

កញ្ញា ៈ ្រ និមល

ផផនែកទីផវាសារ

លោក ៈ ដួង ចាន់្ុភ័កក្ត

លោក ៈ ្ួន  រា៉

 ផផនែកលក់

បបធានលោក ៈ ឈឹម ធុល

លោក ៈ ្ំរិទ្ិ រ្់ភក្ត្្

No 8AEo, St. 156, Sangkat Veal Vong, 
Khan 7 Makara, Phnom Penh.

Any problem pleas contact us : 
023 99 78 99 / 010 67 67 67

www.itcity.com.kh

161
Quick Study

33- វិធីសាស្រ្តងាយៗនៃការងាររដ្ឋបាល

ដោយដ្រើ  Mail Merge ក្នុង Word 2013 

37- គៃ្លឹះងាយៗ្រ្រារ់កកក្រដរា៉ោងនៃ 

Windows 8 Lock Screen

38- រញោឈរ់ការរំខាៃ នៃការដ្ញើ Email  ររ្រ ់

Facebook ៃិង Google+ ដៅកាៃ់ Email 

Account 

39- វិធីសាស្រ្តរដងកើត Recovery Drive

Software Review

41- រ៉ិៃ្រ្ររ់ក្នុងការកែក Partition ជាមួយ 

Easeus Partition Master Server 

Graphic Design & Multimedia

23- រែនាមៃ៉្រោសម៉ខ្រំរកដ�ើ Adobe 

Photoshop CS5

មាតិកា
ព្រឹត្តិការណ៍ជាតតិ នតិងអន្រជាតតិ
11- Hennessy V.S.O.P ្រដេទថ្ីឈាៃែូ

លទី្ោសារដៅកម្នុជា 

14-  ពិធីតាំងរងា្ោញ Wi-fi SD Card 

ែូលដល់ទី្ោសារកម្នុជាដ�ើយ

18-  ដលែធ្ោយលក្ខណាៈពិដ្រ្រនៃទូរ្រ័ព្ទ 

Google Nexus 5

20-  Nexus 7 Tablet ជំនាៃ់ដ្កាយររ្រ់ 

Asus ៃលងែូលរួមដៅ Google 1/0 

ដៅកខឧ្រភា

IT
 C

it
y 

m
ag

az
in

e 

page68page23



កម្មវិធីថ្មីៗ
68-  ទាញយកកម្វិធីថ្ីៗ

សំណួរមតិត្អ្នកអាន
72 -  ្រំណួរ ៃិង ែដម្ើយ

សំណណើចមតិត្អ្នកអាន
75-  ្រំដណើែមិត្តអ្កអាៃ  

ៃិងរូរភាពអាថ៌កំបាំង

តារាងតមមលៃ
79-   តារាងតនម្ក៉ំពោយូទ័រ ៃិងដ្គឿងរនា្ោ្រ ់ 
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Web

49- រដរៀររែនា Image Slideshow 

ដោយដ្រើ HTML ៃិង Jquiry

Add On 

56- កម្វិធីរកៃថែម

New Feature

58- ដតើរាៃអ្ីករ្ក្រ្រារ់ Microsoft 

Office 2013

Tool Tip

61 - រដរៀរដ្រើ្ បា្់រ Compression Files 

ឬ Folder ក្នុង Windows 

64- រដរៀររដងកើតឲោយកំ៉ពោយូទ័រ Shut Down 

ដោយ្័្រយ្រវតិ្តដៅដពល ដោកអ្កមិៃដ្រើ្ បា្់រ
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ននិងអន្ត�ជាតនិជានកចើននាក់ចូល�ួមនកកប�ស់ជាតនិ�៏

កសទន់�បស់កករុមហ៊រុនករា				Hennessy ដ�លមាន	

�សជាតនិករា	Hennessy V.S.O.P Privilege 

Collection KYRIOS	ដ�លជាផលនិតផលថី្សកមាប់

កបនទសកម្នុជា។	

	 អ្កតំណាងកករុមហ៊រុនករា	Hennessy ក៏	

បានបង្្ញពីលក្ខណៈពនិនសស	 ននិង�សជាតនិ	

�បស់	Hennessy V.S.O.P. Privilege Col-

ប្រភេទថ្មីឈានចូលទមីផ្សារភៅកម្ពុជា 

lection KYRIOS	 នោយអះអាងថាករា	Hen-

nessy កបនេទថ្ីននះមានសញ្្សមា្្ត់ថនភាព

ល្បីល្បាញ�បស់ែ្លួនដ�លមាន៥ចំនរុចមាន�ូចជា	

«ដផ្ទំពំាងបាយជូ�» «ថ�កាន់អាវរុធ» «ឆំ្្១៨១៧» 

«ពណ៌ទង់ដ�ង» ននិង	 «កសនមាលថី្» ដ�លសរុទ្ធដតជា	

មនិននិត្ត�ូបថនករា	 Hennessy V.S.O.P. Privi-

lege Collection KYRIOS	។

	 នៅយប់ថថងៃ�ដ�លក្នុងឱកាសបង្្ញករា	

Hennessy V.S.O.P. Privilege Collection 

KYRIOS	 ននះក៏មានកា�កបគរុំតនន្តីដ�លអន្ជើញ	

ចូល�ួមនោយតារាចនកមៀងកញ្្	ឱក	សរុគន្ធកញ្្	

កពមទាំងតារាជានកចើន�ូបនផ្េងនទៀតផងដ��។	 អ្ក

តំណាង�ូបននះបានបដនថែមនទៀតថាក្នុងនាមកករុមហ៊រុន	

ទាំងមូលនោកសូមដថ្ងអំណ�គរុណនៅ�ល់	

អតនិថនិជនដ�លដតងដតគាំកទ	 Hennessy	 កន្ង	

មកនហើយនោកក៏បានសំណូមព�នៅ�ល់អតនិជន

ឱ្យគាំកទបដនថែមនទៀតកករុមហ៊រុននលឹងបន្តនាំមកជូន	

Hennessy V.S.O.P

អតនិថនិជននូវអ្ីកគប់ដបបយ៉្ងដ�លអតនិថនិជនចង	់

បានតាមតកមរូវកា�។	

	 ក្ នុងឱកាស�៏សប្បាយ�ីករាយននាះកញ្្	

ឱក	សរុគន្ធកញ្្	ក៏បានមានកបរាសន៏ថា	“នាងែ្នុំ	

មាននសចក្តីសប្បាយ�ីករាយខ្្ំងដមនដទន	 នកពាះ	

ថា	 រាល់កម្វិធី�បស់	Hennessy	 គឺដតងដតមាន	

វត្តមាននាងែ្នុំចូល�ួមជាននិច្ច។	 ក្នុងឱកាសកបគំ	

តនន្តនីនះ	 នាងែ្នុក៏ំបាននកជើសន�ីសយកបទចនកមៀង

ថីៗ្ ជាពនិនសសបបទញាក់កនន្្ាក់អា�ម្ណ៍ន�ើម្បីកំ��

នៅ�ល់ទស្េននិកជនផងដ��“។	 គួ�បញ្្ក់ថា	

ករា	 Hennessy នលឹងនធ្ើកា�កបគំតនន្តីនៅតាម	

បណា្្ក្លឹបកម្សាន្តនានានៅក្នុងរាជធានីចំនួនបួន

កដន្ងដ�លកបកពលឹត្តនៅថថងៃទី	១៥	,២២,	២៣	ននិង	

២៥	ដែមីនា	ឆ្្ំ២០១៣	ននះ	នោយមានកា�ចូល	

�ួមពីកំពូលតារាចនកមៀង	ឱក	សរុគន្ធកញ្្	ននិងតារា	

ល្បីជានកចើន�ូបមកពីកបនទសកម្នុជា	 ននិងនៅជរុំវិញ	

ពនិេពនោក៕		(អតថែបទកករុមហ៊រុន)

ព័ត៌មានជាតិLocal News
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	 នៅ	សាល	មនោស្រព	នោះ	នពស្រ	ស្រុមហ៊រុន	Ford 

Motor	បានន្វើ	ោរដា្់	បង្ហាញ	នូវ	រថយន្ត	លំដាប់ថ្ហា្់		

ពិភពនោ្ដែលមានបំពា្់នៅនដាយបន ច្្េ វិទហាយាទំននើប	

និងជាសបនភទរថយន្តដែលផលិតន�ើងនសោមយរុទ្ធសាស្រ្ត	

Ford	 ដតមួយ្រសមាប់ទីផហាសារ្ម្ពុជាដែលបានសបារព្ធ	

្ម្មវិ្ីនបើ្ ្រនមាពហ្ា 	 ពិ្ីតំាងពិព័រណ៍រថយន្តខ្ហាតអន្តរជាតិ		

្្ពុង	រា្រធានី	ភ្ំនពញ	នា	សពរឹ្	ថថងៃទី១៥	១៦	១៧		ដែមីនា	

ឆ្ហាំ	២០១៣	្ន្លងនៅននះ។

	 នោ្	D.J. Simpson	នាយ្	ស្រប់ស្រង	ដផ្្	

ពសងី្សបតិបត្តិោរ	 និងោរនាំន្ញសបចាំតំបន់អា្ររុី	

អាន្រ្យ៍	 បានមានសបសា្រន៍ថ	 វត្តមានរប្រ់	 Ford 

នៅ្្ពុង្ម្មវិ្ីតាំងពិព័រណ៍រថយន្តននះបានបង្ហាញព	ី					

សបនភទរថយន្តែ៏នស ើ្នបំផរុតពរុធ្ំាហាប់មានរប្់រ	Ford	 ដែល	

មាននៅ្ម្ពុជា	 និងជាោរឆ្លពុះបញ្ហាំងពីោរនប្តជា្ហា្ិត្តែ៏	

មរុតមាំ	រប្រ់	ស្រុមហ៊រុន	្ ្ពុងោរ	ផ្តល់្រូន	នូវ	សបនភទ	រថយន្ត	

ដែល	អតិថិ្រន	្ ង់បាន		និង	ផ្តល់	តថម្ល។	

	 នោ្	បាន	មានសបសា្រន៍	បដនថែមនទៀត	ថ	នយើង	

ក្រុមហ៊រុន Ford Motor បានកបារព្ធ​្ ម្មវិធី​

តាំងពិព័រណ៍​រថយន្ត​ខ្ាត​អន្តរជាតិ
​ដែល​ពរុំ​ធ្លាប់មាននៅ​្ ម្ពុជា

បាន	ពហាយាយាម	អភិវឌហាឍ	នូវ	រថយន្ត	សបនភទ	Sedan	រថយន្ត	

Ford Taurus	ន្រ	រី	ឆ្ហាំ២០១៣	ននះ		នដាយ	ោរយ្្ិត្ត	

ទរុ្ដា្់	និង	ផចេិតផចេង់	បំផរុត	នហើយ	នយើង	្រងហាឃរឹមថ	រថយន្ត	

ននះនរឹងទទួលបានោរគំាសទយ៉ាហាងខ្ហាងំោ្ហាពី្ំរណា្់អតិ-	

ថិ្រននៅ្ម្ពុជា។	 ស្រុមហ៊រុន	RMA Cambodia	 បាន	

ទទួល	នូវ	្ 	ិតិ្ត	យ្រ	យ៉ាហាង	លហាបី	រន្ទឺ	្្ពុងនាម	ជា	ស រ្ុមហ៊រុន	ដែល	

ទទួលបាន	នូវ	្រិទ្ធិ	ដ្្ចាយ	រថយន្ត	Ford	ផ្ហា្់មរុែពី	

ស្រុមហ៊រុន	 Ford Motor	 ចាប់តាំងពី	 ឆ្ហាំ១៩៩។	

ស្រុមហ៊រុន	RMA Cambodia	បាន	នាំយ្	រថយន្ត	Ford	

ម្ទីផហាសារ្ម្ពុជា	និងន វ្ើោរភ្ហាប់ទំនា្់ទំនងរវាង	ស រ្ុមហ៊រុន	

និងអតិថិ្រន។	 នែើមហាបីនឆ្លើយតបនៅនរឹងតសមរូវោរជា	

បនា្ហាន់	រប	្់រ	អតិថិ្រន	ម្រហាឈមណ្ឌល	្រួ្រ្ររុល	និង	ដថទាំ	

រថយន្ត	Ford	រប្រ់	ស្រុមហ៊រុន	RMA Cambodia	ទាំង	

នៅ្្ពុង	រា្រធានី	ភ្ំនពញ	និង	នែត្តន្រៀមរាប	បាន	បំពា្់	

នៅនដាយ	បន្ចេ្វិទហាយា	ែ៏ទំននើបៗនិង	្រមហាបូរដបប	ជានស្ើន	

រួមជាមួយជាង្ំរនាញដែលទទួលបានោរបណ្តះបណ្ាហាល	

យា៉ហាង	សតរឹមសតរូវ្រសមាប់	ធានា	ែល់	ោរផ្តល់្រូន	នូវ	ន្រវា	ែ៏	

ល្អឥតនខ្ហាះ	នៅ	ស្រប់	ទី្ដន្លង។

	 ឯ្ឧត្តម	ចម ប្រ សិ ទិ្ធ	នទ្ររែ្ឋមសន្តី	រែ្ឋមសន្តីស្្រួង	

ពាណិ្រ្្ជ ម្មបានមានសបសា្រន៏ថនៅឆ្ហា	ំ២០១៨	តំបន់	

អាសា៊ហាននរឹងោ្ហាយជា្ដន្លងផលិតរថយន្តែ៏្ំជាងន្រ	នៅ	

នលើ	ពិភពនោ្្ំណាត់	ទី	៦	ែូន្្ះ	រយ:នពល	ប៉រុនា្ហានឆ្ហាំ	

នទៀត	អាសា៊ហាន	និង	្ ូល	្ ំណាត់ថ្ហា្់	ទី	៦	នៅ្្ពុង	ននាះ	្ ៏	

មាន	សបនទ្រ	្ ម្ពុជា	ផងដែរ	្្ពុង្ំនណាម	សបនទ្រ	ផលិត	

រថយន្តនៅអាសា៊ហាន។	 ឯ្ឧត្តម	 ្៏មានសបសា្រន៏បន្ត	

នទៀតថ	 ោរតាំងពិព័រណ៏ជានលើ្ែំបូងខ្ហាតអន្តរជាតិ	

ននះ	្រទឺ	ោរតាំង	ពិ	ព័រ	ណ៏	យានយន្ត	នៅ្្ពុង	ទីស្រុង	ភ្ំនពញ	

នហើយនរឹងបន្តជានរៀងរាល់ឆ្ហាំ	ោរតាំងពិព័រណ៏ននះ្៏នៅ	

្្ពុង	្ ម្មវិ្ 	ីតំាង	ពិ	ព័រ	ណ៏នផហាេងៗនទៀត	នៅ	ស្្ួរងពាណិ្រ្្ជ ម្ម		

នែើមហាបី	ទា្់ទាញ	ឲហាយ	ស រ្ុមហ៊រុន	ជានស ើ្ន	នទៀត	្ លូរួម	ឲហាយ	បាន		

ោន់ដតនស ើ្ន	្ ្ពុង	្រោ្ហានរុពល	នៅ្្ពុង	សបនទ្រ្ម្ពុជា	នយើង។	

ោរតាំង	ពិ	ព័រ	ណ៏	រយ:នពល	បី	ថថងៃ	្រទឺ	ថថងៃទី១៥	១៦	១៧	ដែ	

មីនា	ឆ្ហាំ២០១៣ននះ	នាំនូវ	ភពនជា្រ្រ័យ	ែល់	អ្្	តាំង	

ពិព័រណ៏្៏ែូ្ជាោរនាំម្នូវអាម្មរណ៏ដប្ល្ៗែល់អ្្	

ទ្រហាេនា	ទាំងននាះ	ផងដែរ។	ឯ្ឧត្តម	បាន	វាយតថម្ល	ែ្្រ់	

្ំនពាះ	សបធាន	ថន	្រហព័ន្ធ	យានយន្ត	្ ម្ពុជា	នោ្		រ៉ា មី រ៉ា 

ហ្វ័ រ	 ដែល	បាននរៀប្ំ	នូវ	ោរតាំងពិព័រណ៍	ខ្ហាត	អន្តរជាតិ	

នៅរា្រធានីភ្ំនពញអំពីយានយន្ត	ឆ្ហាំ	២០១៣	ជា	នលើ្	

ទីមួយ	 ដែលជាសពិត្តិោរណ៍មួយបនងកើតឲហាយមានោរយល់	

ែរឹង	បដនថែមនទៀត	ពី	្រោ្ហានរុពល	និង	អង្គោរ	នែើមហាបី	វិនិនយា្រ	

នៅ្្ ពុងវិ្រ័យឧ្រហាសាហ្ម្មយានយន្តដែល្ំពរុងរី្	

្នសមើន	នៅ្្ពុង	សបនទ្រ	្ ម្ពុជា៕
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	 កាល	ពីល្ងាច	ថ្ងៃ	ទី	 ០៧	 ខែ	 មិនា	ឆ្ងាំ	 ២០១៣	

ក រ្ុមហ៊រុន Smart Computer បានរ�ៀបចំ្ម្មវិធី		បង្ងាញ

ផលិតផល ្្ម�ីបស់ែ្លួនរៅសណ្ងាគា�ភំ្រពញ។	 ្ម្មវិធី	

រនាះ			បាន	រធវើ	បទ	បង្ងាញ	ពីផលិតផល	្ ្មី	�បស់	ក្រុមហ៊រុន	

Transcend ខែលជាក្រុមហ៊រុនលំដាប់ពិភពរល្។		

រៅ្្នុង្ម្មវិធីរនាះខែ�រ�ើងរ�ើញមានកា�ចូល�ួមព	ី

សំណ្់	ថែ	គូ	ខច្ចា�	�បស់	ក្រុមហ៊រុន Smart Com-

puter ជា	រកចើន	ខែល	ភាគ	រកចើន	ជា	ហាង	ល្់	្ រុពំងាយូទ័�		និង		

រកគឿង	បរចចេ្វិទងាយារៅ្្នុងរាជធានីភ្ំរពញ។	

							រល្		POR	ជានា�្កគប់កគងទូរៅ�បស់ក្រុមហ៊រុន	

Transcend	កបចាំកបរទស្ម្នុជា	បានមានកបសាសន៍	

ថារៅ	្ ្នុង	កា�	ផលិតនូវផលិតផល	បរចចេ្វិទងាយា	្ ្មី	សកមាប់	

ឆ្ងាំ	២០១៣	រនះ	គឺ		ក រ្ុមហ៊រុន	Transcend	បានបរងកើត	

Wi-Fi SD Card	ខែល	ជា	កបរភទ	អង្គ	ចង	ចាំ	ខែល	មាន	

គរុណភាព		និងសមត្ថភាពែ្ស់បំផរុត		 រហើ�ល្្ខណៈ	ពិ

រសស�បស់វាគឺអាចភ្ាងាប់ជាមួ�ឧប្�ណ៍បាន	៣	ជាមួ�	

សមត្ថភាព	 Wireless �បស់វាកពមទាំងអ្្អាចរកបើ	

កបាស់	Tablet / Smart Phone / Notebook	រែើមងាបី	

រមើល	�ូបភាព	ទាំង	រនាះ	រៅ	្ ្នុង	រពល	ខត	មួ�		និង	រល្	

អ្្	អាច		Upload	�ូបភាព	រដា�	ផ្ងាល់	រៅ	កាន់	បណ្ងាញ	

សង្គម	យ៉ងាង	ង�	កសួល	បំផរុត។	មិនកតរឹមខតប៉រុរណណងាះវា	

ពិធីតាំងបង្ាញ

ចូលដល់ទីផ្សារកម្ពុជាហ�ើយ
Wi-Fi SD Card

អាច	សា្ងាល់	ជាមួ�	កបព័ន្ធ	កបតិបត្ិកា�	ែូចជា iOS, An-

droid, Windows, Linux និង	Mac OS X រទៀតផង។	

រល្បានបន្រទៀតថា	កា�តាំងបង្ងាញរនះខែ�មាន	

ផលិតផលជារកចើនរទៀតែូចជា	Wireless Products 

& DVD Writers, Solid State Drives, External 

Hard Drives, USB Flash Drives, Memory 

Cards, Card Readers &Accessories, Digi-

tal Music Players, Digital Photo Frames, 

and Memory Modules.រហើ�មានល្់រៅ្្នុង						

កពះរាជាណចក្្ម្នុជានារពលឆប់ៗរនះ។		 រល្្៏

បានអ�គរុណែល់អតិ្ិជនទំាងអស់ខែលបានជួ�កគំាកទ

ែល់ផលិតផល�បស់	 Transcend ជារ�ៀង�ហូតម្					

ខែលរធវើឲងាយផលិផល	 Transcend មានទីផងាសា�រៅ										

កពះរាជាណចក្មានភាពលូតលស់គួ�ជាទីរមាទន។

	 រែើមងាបីឲងាយមានភាពកាន់ខតសិ្តស្ាងាលក រ្ុមហ៊រុន	 Tran-

scend	 បានកបគល់វិញ្ងាបកតែល់ក្រុមហ៊រុន Smart 

Computer	 ផងខែ�។	 កពមទាំងបាន្ត�ូបទរុ្ជា				

អនរុសងាសាវ�ី�៏�ួមគ្ាងាជាមួ�នរឹងម្ាងាស់ហាងល្់ រ្ុពំងាយូទ័�រៅ	

្្នុងរាជធានីភ្ំរពញ	 និង្៏បានពិសា�អាហា�រពលល្ងាច

យ៉ងាង�ី្រា�ជាមួ�អតិ្ិជនអ្្គាំកទ៕
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	 សព្វថ្ងៃនេះ	ក រ្ុមហ៊រុេ	LG	្ំពរុងតែដំន�ើរការផលិែេូវនាឡិកាដ៏ឆ្លាែថវ Smartwatch	សករាប់កប្ួែកបតែងជាមួយក្រុមហ៊រុេបន្ចេ្វិទលាយាធំៗនៅនលើ

ពិភពនោ្ដូ្ជា	Apple , Google, LG	េិង	Samsung	តដលបាេផលិែកាលពីតែមរុេ។

							បនា្លាប់ពីរាេពា្លាយ្ចាមអារ៉លាមនល្នឡើងកាលពីនដើមឆ្លាំនេះថា	ក្រុមហ៊រុេ	Apple	បាេ្ំពរុងតែដំន�ើរការផលិែេូវ	Smartwatch	ដ៏អស្លារលាយរបស់ែ្លួេ		

នទើបរាេក្រុមហ៊រុេមួយ្ំេួេបាេយ្លំនាំតាមក្រុមហ៊រុេ	Apple	នដើមលាបីផលិែ	Smartwatch	ជា្ម្មសិទ្ធរបស់ក្រុមហ៊រុេែ្លួេតដរ។	ជា្់តសតែងដូ្ជាក្រុមហ៊រុេ	

LG ជានដើម	កាលពីមរុេជាក រ្ុមហ៊រុេផលិែស្លាែហ្វវូេននាះនទ	នោយ	

ន�ើញថា Apple	ផលិែ Smartwatch នទើបសព្វថ្ងៃនេះ	LG 

ចាប់នផតែើមផលិែតដរ។

							នោងតាមកបភពរបាយការ�៍តដលនទើបតែន្ញផលាសាយនានពល	

្្មីៗ នេះបាេឲលាយដឹងថាការផលិែឬការបនងកើែនឡើងថេ	Smartwatch 

ដ៏ឆ្លាែថវរបស់ក្រុមហ៊រុេ	LG	្៏ដូ្ជារបស់ក្រុមហ៊រុេ	Apple តដរ	

សរុទ្ធតែជាគកមរូដ៏ល្អមួយនដើមលាបីសនកម្បាេភាពនជាគែ័យដ៏ធំនធង	

ដូ្	 Google Glasses	 តដលរាេវែតែរាេនៅនលើែំេួញទីផលាសារ	

្េ្ងម្នេះ។	 នោយតឡ្	 នបើនោងតាមកបភពព័ែ៌រាេម្ពី	

Korean Time ្៏បាេបញ្ល្ា ែ្់ះៗផងតដរថា		ការផលិែេូវ	Smart 

watch	 នេះនឡើងគឺពិែជារាេសរៈកបនោែេ៍ខ្លាងំណាស់សករាប់	

នពលអនាគែ៕	

ក្រុមហ៊រុន	LG	ផលិត	Smartwatch ដែរ!	
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	 ក រ្ុមហ៊រុន	 LG	 កាលពីពពល្ន្លងពៅពនះបានផលិតនូវស្មាតហ្វូនមូ៉ដែល	Nexus 4	 សករាប់ក រ្ុមហ៊រុន	Google	 ពហើយសព្ថ ង្ៃពនះរានពា ម្ាយចចាមអារ៉មាម	

មួយចំនួនពលើ្ ព�ើងថាក រ្ុមហ៊រុន		LG		្ំពរុងដតែំព�ើរការផលិតនូវកបពេទ	Nexus Smartphone	រានព្្មាះថា	Google Nexus 5	ឬ	LG Nexus 5។

	 ពោងតាមកបេពព័ត៌រានដែលពទើបដតពចញផមាសាយ្្នុងពពល្្ីៗពនះបានបង្មាញថាទូរស័ព្ទស្មាតហ្វូនម៉ូដែល	Google Nexus 5	ជំនាន់្្ីពនះកតរូវបាន						

រចនាព�ើងពោយរានបំពា្់ម្ជាមួយពេក្ង់កបពេទ	OLED Full HD	ទំហំ5.2 	េីរុង	ជាមួយ	Resolution: 1920 x 1080	េិចដសល	ពែើរពោយេង្គ	

កបតិបត្ិការ	 Qualcomm Snapdragon 800 Processor	 រានពលមាបឿន	 2.3GHz	 េង្គចងចាំ	 ទំហំ3GB និងទំហំផ្ទនុ្ទិន្ន័យជាប់រា៉មាសរុីនរាន	

បីជពកមើសសករាប់	ពកជើសពរើសគឺ	16GB 32GB	និង64GB ។

	 ល ្្ខ�ៈពិពសសបដនថែមពលើសពនះពៅពទៀតរួមរាន្កមិតកាពមរ៉មាដផ្្ខាងពកកាយទំហំ16	 ពមហ្មាេិចដសលជាមួយនឹងសមតថែភាពពិពសសគឺអាច record      

4k សករាប់វើពែេូ្កមិត	30 fps	និង	1080p	្ កមិត	60 frames	្ ្នុងមួយវិនាទី	និង្កមិតកាពមរ៉មាខាងមរុខជា	VGA Camera ទំហំ2.1 ពមហ្មាេិចដសល។

	 ពោយដ�្ថាមពល្្វិញវាអាចផ្ទនុ្បានរហូតែល់	 3300mAh	 ពហើយគួរបញ្មា្់ថាល្្ខ�ៈទាំងេស់ពនះករាន់ដតជាព័ត៌រានដប្ធ្មាយដតប៉រុព្ណមាះ	

ព័ត៌រានជាផ្លវូវការោ៉មាង្ពនាះពយើងនឹងជករាបជូបពោ្េ្្ពៅពពលពកកាយៗពទៀត៕
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	 ក រ្ុមហ៊រុន	 LG	 កាលពីពពល្ន្លងពៅពនះបានផលិតនូវស្មាតហ្វូនមូ៉ដែល	Nexus 4	 សករាប់ក រ្ុមហ៊រុន	Google	 ពហើយសព្ថ ង្ៃពនះរានពា ម្ាយចចាមអារ៉មាម	

មួយចំនួនពលើ្ ព�ើងថាក រ្ុមហ៊រុន		LG		្ំពរុងដតែំព�ើរការផលិតនូវកបពេទ	Nexus Smartphone	រានព្្មាះថា	Google Nexus 5	ឬ	LG Nexus 5។

	 ពោងតាមកបេពព័ត៌រានដែលពទើបដតពចញផមាសាយ្្នុងពពល្្ីៗពនះបានបង្មាញថាទូរស័ព្ទស្មាតហ្វូនម៉ូដែល	Google Nexus 5	ជំនាន់្្ីពនះកតរូវបាន						

រចនាព�ើងពោយរានបំពា្់ម្ជាមួយពេក្ង់កបពេទ	OLED Full HD	ទំហំ5.2 	េីរុង	ជាមួយ	Resolution: 1920 x 1080	េិចដសល	ពែើរពោយេង្គ	

កបតិបត្ិការ	 Qualcomm Snapdragon 800 Processor	 រានពលមាបឿន	 2.3GHz	 េង្គចងចាំ	 ទំហំ3GB និងទំហំផ្ទនុ្ទិន្ន័យជាប់រា៉មាសរុីនរាន	

បីជពកមើសសករាប់	ពកជើសពរើសគឺ	16GB 32GB	និង64GB ។

	 ល ្្ខ�ៈពិពសសបដនថែមពលើសពនះពៅពទៀតរួមរាន្កមិតកាពមរ៉មាដផ្្ខាងពកកាយទំហំ16	 ពមហ្មាេិចដសលជាមួយនឹងសមតថែភាពពិពសសគឺអាច record      

4k សករាប់វើពែេូ្កមិត	30 fps	និង	1080p	្ កមិត	60 frames	្ ្នុងមួយវិនាទី	និង្កមិតកាពមរ៉មាខាងមរុខជា	VGA Camera ទំហំ2.1 ពមហ្មាេិចដសល។

	 ពោយដ�្ថាមពល្្វិញវាអាចផ្ទនុ្បានរហូតែល់	 3300mAh	 ពហើយគួរបញ្មា្់ថាល្្ខ�ៈទាំងេស់ពនះករាន់ដតជាព័ត៌រានដប្ធ្មាយដតប៉រុព្ណមាះ	

ព័ត៌រានជាផ្លវូវការោ៉មាង្ពនាះពយើងនឹងជករាបជូបពោ្េ្្ពៅពពលពកកាយៗពទៀត៕
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	 តាមប្រភពព័ត៌មានដែលចេញផ្សាយនាចពលថ្មីៗចនះបានឲ្យែឹងថាប្រុមហ៊រុន	

Google	នឹងបបារព្ធពិធមីសន្ិសមីទ	I/O Developer Conference ចៅដែឧសភាខាងមរុែចនះ	

ចោយប្រុមហ៊រុន	នឹងចធវើការផ្សពវផ្សាយពមីប្រព័ន្ធប្រតិ្រត្ិការជំនាន់ចបកាយគAឺndroid 5.0 Key 

Lime Pie។

	 បស្រចពលជាមួយនឹងការប្រកាសពមីប្រព័ន្ធប្រតិ្រត្ ិការចនះដែរប្រុមហ៊រុននឹងចធវ ើការ	

ប្រកាសថា	ចតើឧ្រ្រណ៍ណាែ្ះដែលអាេទទួលយ្នូវ	Android 5.0 Key Lime Pie	ជំនាន់		

ចបកាយចនះចហើយចៅចពលចនាះចយើងសង្ឃឹមទរុ្ជាមរុនថានឹងច�ើញមានវត្មានននប្រចភទ	

Nexus 7 tablet	រ្រស់ Asus	្រង្្ញែ្លួនចៅ	Google I/O ចនះដែរ។

	 ចោងតាមសម្មីរាយការណ៍រ្រស់ប្រុមហ៊រុន Asus	បានឲ្យែឹងថាប្រុមហ៊រុនរ្រស់ែ្លួននឹងចធវើ

ការ្រង្្ញនូវ	Nexus 7 Tablet	ជំនាន់ចបកាយចៅ	Google I/O	ចៅដែឧសភាចោយោ្់ល្់	

្្នុងតនម្	 249 ែរុល្្រចហើយអវមីដែលចគរំពឹងទរុ្ោ៉្ងមរុតមាំចនាះគឺថាអាេប្រ្ួតប្រដជងជាមួយ	

Tablet	ទំហំ7	អមីរុង	និង	8	អមីរុង	រ្រស់ប្រុមហ៊រុនែនទចទៀត។

	 អវមីដែលពិចសសសបមា្រ់ប្រចភទ	Google Nexus 7	ជំនាន់ចបកាយចនះគឺនឹងមាន្រំពា្់ម

្ជាមួយចអប្ង់ែ៏ភ្ឺេ្បាស់ប្រចភទ Full HD	និងProcessor	ែ៏ចលឿនចទៀតផង៕

 ជំនាន់ក្រោយរបស	់Asus	
នឹងចូលរួមកៅ Google I/O	
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	 តាមប្រភពព័ត៌មានដែលចេញផ្សាយនាចពលថ្មីៗចនះបានឲ្យែឹងថាប្រុមហ៊រុន	

Google	នឹងបបារព្ធពិធមីសន្ិសមីទ	I/O Developer Conference ចៅដែឧសភាខាងមរុែចនះ	

ចោយប្រុមហ៊រុន	នឹងចធវើការផ្សពវផ្សាយពមីប្រព័ន្ធប្រតិ្រត្ិការជំនាន់ចបកាយគAឺndroid 5.0 Key 

Lime Pie។

	 បស្រចពលជាមួយនឹងការប្រកាសពមីប្រព័ន្ធប្រតិ្រត្ ិការចនះដែរប្រុមហ៊រុននឹងចធវ ើការ	

ប្រកាសថា	ចតើឧ្រ្រណ៍ណាែ្ះដែលអាេទទួលយ្នូវ	Android 5.0 Key Lime Pie	ជំនាន់		

ចបកាយចនះចហើយចៅចពលចនាះចយើងសង្ឃឹមទរុ្ជាមរុនថានឹងច�ើញមានវត្មានននប្រចភទ	

Nexus 7 tablet	រ្រស់ Asus	្រង្្ញែ្លួនចៅ	Google I/O ចនះដែរ។

	 ចោងតាមសម្មីរាយការណ៍រ្រស់ប្រុមហ៊រុន Asus	បានឲ្យែឹងថាប្រុមហ៊រុនរ្រស់ែ្លួននឹងចធវើ

ការ្រង្្ញនូវ	Nexus 7 Tablet	ជំនាន់ចបកាយចៅ	Google I/O	ចៅដែឧសភាចោយោ្់ល្់	

្្នុងតនម្	 249 ែរុល្្រចហើយអវមីដែលចគរំពឹងទរុ្ោ៉្ងមរុតមាំចនាះគឺថាអាេប្រ្ួតប្រដជងជាមួយ	

Tablet	ទំហំ7	អមីរុង	និង	8	អមីរុង	រ្រស់ប្រុមហ៊រុនែនទចទៀត។

	 អវមីដែលពិចសសសបមា្រ់ប្រចភទ	Google Nexus 7	ជំនាន់ចបកាយចនះគឺនឹងមាន្រំពា្់ម

្ជាមួយចអប្ង់ែ៏ភ្ឺេ្បាស់ប្រចភទ Full HD	និងProcessor	ែ៏ចលឿនចទៀតផង៕

 ជំនាន់ក្រោយរបស	់Asus	
នឹងចូលរួមកៅ Google I/O	
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  ក្រុមហ៊រុន  Barnes & Noble ថ្មីៗននះមាន Services ថ្មីន�ៀតនហើយសកមាប់ការ  ល្់ 

Nook HD+ ដែលជា Tablet e-Reader នៅសហរែ្ឋអានមរិ្ ។

 កាលពមីថថងៃ�មី ២៤ ដែ មមីនា ឆ្នាំ ២០១៣ ្ន្លងនៅននះក្រុមហ៊រុន Barnes & Noble បាន 

ចាប់ន្តើមែំន�ើរការល្់ Nook HD+ Tablet និងមាន្តល់ Nook Simple នោយមិនគិតថថ្ល 

ចាប់ពមីថថងៃ ២៤ ែល់ ថថងៃ ៣០ ដែ មមីនា ននះ ។

 នោងតាមរបាយការ�៍របស់ក្រុមហ៊រុន Barnes & Noble បាននិោយថាសកមាប់         

E-Reader ននះគឺមានមរុែងារជានករើនអារនកបើកបាស់បានជាមួយ្ម្វិធមីន្នាេងៗ នហើយ Tablet 

ននះគឺជា Multimedia Devices ដែលមាន e-Book ្្នុងការអាន្មនាសានត ។

 នបើតាម intomobile បាននរញ ន្ាសាយថា Nook HD+ មានបំពា្់នូវល្្ខ�ៈែូរជា Full 

HD 1920x1280 Display Processor Dual-Core ដែលមាននលនាបឿន 1.5 GHZ 

ជាមួយ     Storage 16GB ឬ 32 GB កពមទាំង microSD slot ន�ៀត្ង។

 គួរបញ្នា្់ថា Nook HD+ មានល្់ 16 GB ្្នុងតថម្លនែើម ២៦៩ ែរុល្នារ និង 32GB 

្្នុងតថម្ល ២៩៩ែរុល្នារ ប៉រុន្ណនាះ៕ កបភពៈ intomobile

មានផ្តល់ Nook Simple ជាមួយ Nook HD+

ក រ្ុមហ៊រុន

Barnes & Noble

Nook 
Simple

Nook 
HD+
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រចនា មនុស្សមុខ

សំបកឈ�ើ

	 ជារ�ឿយៗទស្សនាវដ្តីទតីក រ្ុងពត៌មានវិទ្យាតតងពំានំានូវកា��ចនា		Graphic Design ពតីមួយរេខរៅមួយរេខតតងតតមានភាព	ខរុសគ្្ៗលាយឡំ	

នឹងគំនិតចចនៃក្រឌិតត្រល្ែ ៗ	 វិធតីសាសស្េ្ៗអ សកមា្់រក្ិរយមិត្អនរុវត្ន៍តាមតដេទំាងអស់រនះពិតជាមានរៅ ន្ៃនុងទស្សនាវដ្តីទតីក រ្ុងពត៌មានវិទ្យារយើង។	

រោយតឡ្ ន្ៃនុងរេខរនះតដ�	ក រ្ុមកា�ងា��្រស់រយើងនឹងនំាអា�ម្មណ៍�្រស់រលា្អន្ៃ ម្រធវើកា�អនរុវត្ន៍ជាមួយនឹងកា��ចនាតដេមិនធ្្្់រជួ្រពតីមរុន	

ម្រៅ្នៃនុង	Adobe Photoshop		គឺកា��ចនាមនរុស្សមរុខសំ្រ្រ�ើវិញម្ង	តដេរយើងនឹងរធវើកា�្រង្្ាញជូនជាជំហានៗដូចខាងរកកាម៖

Adobe Photoshop CS5
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	 មរុននឹងចា្រ់រ្្ើមរលា្អនៃ្កតរូវចូេរៅ	 Download	 �ូ្រភាពតាម	

�យៈរគហទំព័�មួយចំនួន	តដេ�ូ្រទាំងរនាះមានដូចជា៖

	 -	�ូ្រមរុខ្ររុ�សមា្្្់	និង�ូ្រសំ្រ្រ�ើដូចខាងរកកាម

	

	 ជា្ិច្ចចា្រ់រ្្ើមសូមរលា្អនៃ្រ្រើ្្ម្មវិធតី	 Adobe Photoshop	 �ួច	

្ររងកើតនូវផ្្ំងកា�ងា�ថ្មតីមួយរោយចូេរៅកាន់	File > New  ឬ Ctrl + N 

រហើយសូម្ំណត់ទំហំ 1563   x 1173  px		កពមជាមួយនិង	Resolu-

tion 300 px	�ួចចរុច្រ៊ូតរុង	OK	ជាកា�រកសច	។	

01
សូមរ្រើ្�ូ្រ្ររុ�សខាងរេើចូេរៅ្នៃនុងផ្្ ំងកា�ងា�	

�្រស់រលា្អនៃ្	 ្រនា្្្រ់ម្រក្រើ	 Pen Tool	 រោយ	

្ំណត់	Paths not Shape Layers រហើយកាត់	

យ្តតមរុខតត្រ៉រុរ្ណ្ះ(រមើេ�ូ្រ)៖

សូមរធវើកា�ចមលែង�ូ្រភាពរោយយ្តតពណ៌រខៀវមួយ	

តត្រ៉រុរ្ណ្ះរោយចូេរៅកាន់	 Window > 

Channels	្រនា្្្រ់ម្	Right Click រេើ	Layer 

Blue យ្ពា្្យ	Duplicate Channel 	រហើយ្ំណត់ដូច�ូ្រខាងរកកាម�ួច	

Save ជា�ូ្រ	មួយថ្មតីរទៀតរោយចរុចរេើ្រ៊ូតរុង	Ok	៖

	 ្រនា្្្រ់ម្សូម្ំណត់នូវ	Gaussian Blur	ទំហំ	2 pixel	រៅរេើ�ូ្រ	

ថ្មតីតដេបានរកជើសរ�ើសពតី		Channels	ខាងរេើ	រោយចូេរៅ			Filter > 

Blur > Gaussian Blur
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Blur > Gaussian Blur

02

IT City Magazine
www.itcity.com.kh24

	 រកកាយម្រទៀតសូមចូេរៅរធវើកា�ត្តក្រពនលែខឺលែះរដើម្បតីឲ្យមានេ ្្ខណៈ	

កសស់សា្្ត់រោយចូេរៅ Image > adjustments > auto levels	

ឬចរុច	Ctrl +L	្ំណត់តាម�ូ្រ�ួចសូមចរុច Save	(adisplace.psd)

្ររងើកត	Layer	ថ្មតីរ្ម្ះ	Bark	�ួចរ្រើ្�ូ្រសំ្រ្រ�ើ	

រោយ��រេើ	Layer Bark	�ួចចូេរៅកាន់	Fil-

ter > Distort > Displace	្រនា្្្រ់ម្សូមរធវើ

កា�្ំណត់តំចេរៅតាម�ូ្រខាងរកកាម�ួចចរុច	្ូ៊រតរុង	Ok	៖

	 ��រេើ	Layer Bark	ដតដេ	រកកាយម្សូម	Brow	 រៅ�្ទតីតាំង	

�្រស់	 File adisplace.psd	 តដេរយើងបានរធវើ�ួចជារកសច	 ្រនា្្្រ់ម្	

សូមចរុច្រ៊ូតរុង	Open	៖

	 សូម្ំណត ់ Layer Blending Mode	ជាក្ររេទ	Multiply	 រនាះ

រលា្អនៃ្នឹងទទួេបាននូវេទ្ធ្េដូចខាងរកកាម៖

សូមរធវើកា�ចំេង	 Layer Bark	 ចំនួនពតី�	 រោយ	

ទតីមួយ្ំណត់	Mode ជា	Multiply	 កពមជាមួយ	

Opacity 100%	 និងទតីពតី�្ំណត់	 Mode	 ជា	

Normal	កពមជាមួយនឹង Opacity 40 %	សូមរមើេ�ូ្រខាង	រកកាម៖	

ចរុចរេើ	Layer Face	ពតីដងរដើម្បតី្ររងកើត	Selec-

tion	 �ួច��រេើ	Layer Bark Normal 40%	

្រនា្្្រ់ម្សូមចូេរៅកាន់	 Layer > Layer 

Mask > Reveal selection	៖
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	 ចំរពាះ Layer Bark Multiply 100%	 ្៏អនរុវត្ន៍ដូចគ្្រៅនឹង 

Layer Bark Normal 40%	តដ�	គឺចូេរៅLayer > Layer Mask > 

Reveal selection	៖

	 សូម��រេើ	Layer Bark Multiply 100%	 	 �ួចរក្រើ	Pen tool 

រោយគូ�រេើរៅរេើ	 តេនៃ្	 និង	 ម្៉ាត់	 ្រនា្្្រ់ម្សូមរធវើកា�	 Right Click 

រេើគំនរុស	Pen tool	តដេបានគូ��ួច	យ្ពា្្យថា	Make Selectio	រដើម្បតី	

Load Selection	៖

	 ��រេើ	Layer Bark Normal 40%	�ួចសូមយ្រ�៉្ចរុចរេើ	Mask 

តដេមាន	 Background ពត៌រ្ម្	 ្រនា្្្រ់ម្សូមចរុច	 Delect Key	 ។	

ចំរពាះ Layer Bark Multiply 100%	 ្៏អនរុវត្ន៍ដូចគ្្រៅនឹង Layer 

Bark Normal 40%	្ងតដ�៖

សូមចូេរៅកាន់ Layer > New Adjustment 

Layer > Curves		�ួចសូមចា្់	Background	ចន	

Curves	 ពណ៌រ្ម្	 កពមទាំងត្តក្រតំចេមួយចំនួន	

ដូចខាងរកកាម៖
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	 ចំរពាះ Layer Bark Multiply 100%	 ្៏អនរុវត្ន៍ដូចគ្្រៅនឹង 

Layer Bark Normal 40%	តដ�	គឺចូេរៅLayer > Layer Mask > 

Reveal selection	៖

	 សូម��រេើ	Layer Bark Multiply 100%	 	 �ួចរក្រើ	Pen tool 

រោយគូ�រេើរៅរេើ	 តេនៃ្	 និង	 ម្៉ាត់	 ្រនា្្្រ់ម្សូមរធវើកា�	 Right Click 

រេើគំនរុស	Pen tool	តដេបានគូ��ួច	យ្ពា្្យថា	Make Selectio	រដើម្បតី	

Load Selection	៖

	 ��រេើ	Layer Bark Normal 40%	�ួចសូមយ្រ�៉្ចរុចរេើ	Mask 

តដេមាន	 Background ពត៌រ្ម្	 ្រនា្្្រ់ម្សូមចរុច	 Delect Key	 ។	

ចំរពាះ Layer Bark Multiply 100%	 ្៏អនរុវត្ន៍ដូចគ្្រៅនឹង Layer 

Bark Normal 40%	្ងតដ�៖

សូមចូេរៅកាន់ Layer > New Adjustment 

Layer > Curves		�ួចសូមចា្់	Background	ចន	

Curves	 ពណ៌រ្ម្	 កពមទាំងត្តក្រតំចេមួយចំនួន	

ដូចខាងរកកាម៖
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ចរុចរោះតេនៃ្រេើ	Layer Bark ្រនា្្្រ់ម្សូម��	

រេើ	 Layer Face �ួចរក្រើ	Pen Tool	 គូ�រៅ្នៃនុង	

្រ�ិរវណមាត់	្រន្្ា្រ់ម្	Make Selection រហើយ	

្រ្ដូ�រៅ��រេើ	Layer Curves1	ចន Mask	រក្រើ	Brush Tool		្ ំណត់ទំហំ	

15 px Opacity 16%	និងោ្់ពណ៌ស					រកកាយម្យ្	Brush	គូរេើ	

Selection	រនាះ	រដើម្បតីរមើេរៅឲ្យដូច	ជាមនរុស្សតដេមានសា្្មកជរួញ៖

្នៃនុងជំហានរនះគឺវាហា្់្រតីដូចជាជំហានទតី	 7	 តដ�	

្៏្រ៉រុតន្ខរុសគ្្	កតង់ថារយើងត្រ�រៅអនរុវត្ន៍រៅរេើ

កត្រ្តេនៃ្វិញម្ង	 រោយរក្រើ	Brush Tool នឹង	

្ំណត់ដូចេ្្ខ័ណរៅ្នៃនុងជំហានទតី	 ៧	 រហើយរធវើកា�គូ�រៅរេើកត្រ្តេនៃ្	

ទាំងពតី�	រនាះរលា្អនៃ្នឹងទទួេបានជា�ូ្រ	កត្រ្	តេនៃ្ដូចខាងរកកាម៖

្ររងកើត	Selection	 រោយចរុចពតី�ដងរៅរេើ	Lay-

er Face	្រនា្្្រ់ម្��រេើ	Layer Curves 1	

រហើយចរុចរេើ Mask	�ួចរក្រើ	Brush tool	រោយ	

្ំណត់ពណ៌ស	ទំហំ	150 px	និង	Opacity 16% រកកាយម្សូមបាញ់	

Brush	 តាម	Selection	 រៅរេើមរុខ	 រដើម្បតីឲ្យ	រមើេរៅដូចជាមរុខមនរុស្ស	

្រុសរឡើង៖
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	 រដើម្បតី	Deselect	សូមចរុច	Select > Deselect	 	ឬ	Ctrl + D  

��រេើ	 Layer Curves 1	 រហើយចរុចរេើ	 Mask	 ្រនា្្្រ់ម្សូម	

ចូេរៅកាន់	 Filter > Blur > Gaussian Blur	 រោយ្ំណត់ទំហំ	

រស្មើនឹង 0.6 px	៖

	 រនះគឺជាេទ្ធ្េតដេរលា្អនៃ្នឹងទទួេបាន	៖

រធវើកា�ចមលែង	Layer bark	រោយ្ំណត់	Opacity 

40 % ្រនា្្្រ់សូម្ររងកើត	 Layer	 ថ្មតីមួយរទៀត	

ោ្់រ ម្ះ្ថា	Color	រហើយចា្់	ពណ៌ដូចតំចេតដេ

បាន្ំណត់ដូចខាងរកកាម៖

	 ោ្់		Layer Bark copy	 រៅខាងរេើ	Layer Bark	 និង	Layer 

color រៅខាងរកកាម Layer Bark	សូមរមើេ�ូ្រភាពខាងរកកាម៖

	

	 ្រនា្្្រ់ម្សូម	Load Selection	រៅរេើ	Layer face	�ួច��រេើ	

Layer Curves 1	រហើយចរុចរេើ	Mask	រកកាយ	ម្ចូេរៅ	កាន់	Select 

> Inverse	 រកកាយម្រទៀតចូេ	 Select > Modify > Expand	

រោយ្ំណត់ទំហំ	2 px	ដូច�ូ្រ៖
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	 រដើម្បតី	Deselect	សូមចរុច	Select > Deselect	 	ឬ	Ctrl + D  

��រេើ	 Layer Curves 1	 រហើយចរុចរេើ	 Mask	 ្រនា្្្រ់ម្សូម	

ចូេរៅកាន់	 Filter > Blur > Gaussian Blur	 រោយ្ំណត់ទំហំ	

រស្មើនឹង 0.6 px	៖

	 រនះគឺជាេទ្ធ្េតដេរលា្អនៃ្នឹងទទួេបាន	៖

រធវើកា�ចមលែង	Layer bark	រោយ្ំណត់	Opacity 

40 % ្រនា្្្រ់សូម្ររងកើត	 Layer	 ថ្មតីមួយរទៀត	

ោ្់រ ម្ះ្ថា	Color	រហើយចា្់	ពណ៌ដូចតំចេតដេ

បាន្ំណត់ដូចខាងរកកាម៖

	 ោ្់		Layer Bark copy	 រៅខាងរេើ	Layer Bark	 និង	Layer 

color រៅខាងរកកាម Layer Bark	សូមរមើេ�ូ្រភាពខាងរកកាម៖

	

	 ្រនា្្្រ់ម្សូម	Load Selection	រៅរេើ	Layer face	�ួច��រេើ	

Layer Curves 1	រហើយចរុចរេើ	Mask	រកកាយ	ម្ចូេរៅ	កាន់	Select 

> Inverse	 រកកាយម្រទៀតចូេ	 Select > Modify > Expand	

រោយ្ំណត់ទំហំ	2 px	ដូច�ូ្រ៖
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	 ��រេើ	Layer Curves 1																																								ដតដេ	រហើយរធវើកា�ចា្់	ពណ៌រៅរេើ	

Mask	្៉ររុតន្ត ន្្ៃ ខាងរករៅចន�ូ្រមរុខមនរុស្សរោយ្ំណត់ពណ៌ដូចខាងរកកាម៖

	 សូម Deselect	រោយចរុច	Ctrl + D	រដើម្បតីរោះ	Selection	៖

រធវើកា�្ររងកើតនូវ	 Curves	 ថ្មតីមួយរទៀតរោយចូេ	

រៅកាន់	Layer > New Adjustment Layer > 

Curves	 ្រនា្្្រ់ម្ត្តក្រពនលែឺរធវើរម៉ចឲ្យសមរៅ	

តាមតដេរលា្អនៃ្ចង់បាន៖

	 ្រនា្្្រ់ម្សូមចូេរៅ	Layer > New Adjustment Layer >   

Hue/Saturation �ួចត្តក្រតំចេដូចខាងរកកាម៖

Selected	 រាេ់	 Layer	 ទាំងអស់រោយចរុច				

Selecte	 រេើ	 Layer រេើរគ្រំ្រុត�ួចចរុច	Shift	

្រនា្្្រ់ម្សូមចរុចរេើ	Layer	ខាងរកកាម	រគ្រង្អស់	

្រនា្្្រ់ម្រទៀតសូមចរុចរ�៉្សា្្ ំ (Right Click)	 រេើ	 Selection យ្	

ពា្្យថា	 Flatten image	 រដើម្បតីរធវើកា�	 Convert Layers	 ទាំងអស់	

ឲ្យរៅជា	Layer Background	តតមួយសូមអនរុវត្ថន៍ដូច�ូ្រ៖
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	 ្រនា្្្រ់ម្សូមចូេរៅកាន់	Filter > Liquify	ឬ	ចរុច	Shift + Ctrl 

+ X ្រនា្្្រ់ម្រកជើសរ�ើស	 Bloat tool រដើម្បតីរធវើឲ្យរៅរេើមរុខ	

មានេ្្ខណៈដូចជា	3D	រៅរេើ	ថា្្ស		ថ្្ាេ់	្៏ដូចជាកចមរុះជារដើម៖

ជំហានរនះសូមរលា្អនៃ្រធវ ើកា�តសវង�្នូវ� ូ្រ	

អរណដើ្មាស	និង�ូ្រកតរួយរ�ើ	 រោយកាត់�ូ្រទាំង	

រនះរោយ	Pen tool	រហើយរធវើកា�	តរុ្រតតងរោយ	

្ររងកើត Layer	ចំនួនពតី�	ដូច�ូ្រ	ខាងរកកាម៖

ជំហានទតី		១៥៖

រធវើកា�រ្រើ្ �ូ្រ Logo �្រស់ទស្សនាវដ្តីទតីក រ្ុងពត៌មាន

វិទ្យា�ួច	 Load Selection	 ចរុច	 Delete Key	

្រនា្្្រ់ម្រទៀត��រេើ	 Layer Background	

ចរុច	Ctrl + J	រដើម្បតី	Cut	នឹង្ររងកើត	Layer	ថ្មតី	៖
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	 ្រនា្្្រ់ម្សូមចូេរៅកាន់	Filter > Liquify	ឬ	ចរុច	Shift + Ctrl 

+ X ្រនា្្្រ់ម្រកជើសរ�ើស	 Bloat tool រដើម្បតីរធវើឲ្យរៅរេើមរុខ	

មានេ្្ខណៈដូចជា	3D	រៅរេើ	ថា្្ស		ថ្្ាេ់	្៏ដូចជាកចមរុះជារដើម៖

ជំហានរនះសូមរលា្អនៃ្រធវ ើកា�តសវង�្នូវ� ូ្រ	

អរណដើ្មាស	និង�ូ្រកតរួយរ�ើ	 រោយកាត់�ូ្រទាំង	

រនះរោយ	Pen tool	រហើយរធវើកា�	តរុ្រតតងរោយ	

្ររងកើត Layer	ចំនួនពតី�	ដូច�ូ្រ	ខាងរកកាម៖

ជំហានទតី		១៥៖

រធវើកា�រ្រើ្ �ូ្រ Logo �្រស់ទស្សនាវដ្តីទតីក រ្ុងពត៌មាន

វិទ្យា�ួច	 Load Selection	 ចរុច	 Delete Key	

្រនា្្្រ់ម្រទៀត��រេើ	 Layer Background	

ចរុច	Ctrl + J	រដើម្បតី	Cut	នឹង្ររងកើត	Layer	ថ្មតី	៖
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រកកាយម្សូម��រេើ	Layer Logo	�ួចសូមចូេរៅកាន ់Layer > Layer Style > Bevel and Emboss	សូមរមើេ�ូ្រ៖

��រេើ	Layer Logo	ដតដ�	Layer > Layer Style > Drop Shadow រដើម្បតី្ំណត់	Affect	រៅរេើ	Logo	្រតន្ថមរទៀត៖
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សូម្ំណត់តំចេ File	រស្មើ�	០(សូន្យ)។		�ូ្រភាពខាងសា្្ំគឺជាេទ្ធ្េតដេទទួេបាន៖

	 រកកាយពតីកា�្ំណត់	 តំចេ	File	 រស្មើ�	 ០	

(សូន្យ)	 រលា្អនៃ្្៏អាច	 រធវើកា�្រ្ដូ�ទតីតាំងចន	

Logo	 រៅកគ្រ់ទតី្តនលែង	 រហើយវារៅតតចា្រ់	

តំចេ	Background	រធវើជាច្ទៃ�្រស់វាដតដេ៕
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Quick
Study

វិធីសាស្រ្តងាយៗនៃការងាររដ្ឋបាល

ដោយដ្រើ  Mail Merge ក្នុង Word 2013

គៃ្លឹះងាយៗ្រ្រារ់កកក្រដរាោ ងនៃ 

Windows 8 Lock Screen

រញ្ឈរ់ការរខំាៃ នៃការដ្ញើ Email  ររ្់រ 

Facebook ៃិង Google+ ដៅកាៃ់ Email Account 

វធីិសាស្រ្តរដងកើត Recovery Drive
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សូម្ំណត់តំចេ File	រស្មើ�	០(សូន្យ)។		�ូ្រភាពខាងសា្្ំគឺជាេទ្ធ្េតដេទទួេបាន៖
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តំចេ	Background	រធវើជាច្ទៃ�្រស់វាដតដេ៕
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Quick
Study

វិធីសាស្រ្តងាយៗនៃការងាររដ្ឋបាល

ដោយដ្រើ  Mail Merge ក្នុង Word 2013

គៃ្លឹះងាយៗ្រ្រារ់កកក្រដរាោ ងនៃ 

Windows 8 Lock Screen

រញ្ឈរ់ការរខំាៃ នៃការដ្ញើ Email  ររ្់រ 

Facebook ៃិង Google+ ដៅកាៃ់ Email Account 

វធីិសាស្រ្តរដងកើត Recovery Drive
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	 ក្នុងការងាររដ្ឋបាលគ្របស់្ថា បន័មនិថារដ្ឋ	 ឯកជន	 ឬគករុមហ៊នុនតូចធំតតងតតជគជើសជរ ើសយកកម្មវធិីមយួតដលជាផលិតផលរបស់គករុមហ៊នុន	 Microsoft		

ជ ្្ម ោះ	Microsoft	Word	 ជោយខានពនុំបាន។	ពីមយួជំនានជ់ៅមយួជំនាន	់Microsoft	Word	បានជធវើការ	Update	ទាងំ	Version	និងសមថាភាពតដលបង្ករ		

លក្ខណៈងាយគសរួលដល់អ្កជគបើគបាស់។	យ៉ា ងណាមញិក្នុងជលខជនោះតដរ	 គករុមការងាររបស់ជយើងនឹងជធវើការបងាហា ញពីរជបៀបជគបើ	 Mail	 Merge	 ជៅក្នុង									

Microsoft	Word	2013	ជូនដល់គបិយមតិ្តតដលនិយមគាគំ្រ្រស្សនាវដ្ី្រី	គករុងពតម៌ានវ្ិរយា។	ជតើអវីជៅជា	Mail	Merge?	ជ្រជគបើក្នុងជគាលបំណងអវី?	តាមពឹត	

ជៅ	 Mail	 Merge	 គតរូវបានជ្រជគបើសគមាបជ់ធវើការងាររដ្ឋបាលមយួចំនួនដូចជា	 ការជធវើនាមបណ័្ណ 	 លិខិតអជ ជ្ ើញ	 ជគស្មសំបនុគតអជ ញ្ ើញពិធីអាពាហ៍ពិពាហ៍	

ជោយមានពតម៌ានដតដលៗដូចជា	ជ ្្ម ោះ	អាស័យោ្ឋ ន	ជលខ្ូររស័ព្ទ	ជាជដើម	ជោយជោកអ្កជធវើតតម្ង្ឺរបានទាងំអស់។	ដូជច្ោះ	ជដើម្ឲី្យយល់កានត់តចបាស់

សូមអននុវត្តនជ៍ាមយួគ្ានឹងគករុមការងារ	របស់ជយើងតដលមានជាដំណាកក់ាលដូចខាង	ជគកាម៖

 ១.	ជបើកកម្មវធិី	Microsift	Word	ជោយចូលជៅកាន	់Start	>	All	Pro-
gram	>	Microsoft	Office	>	word	2013	ឬជោយជគបើ	Command	Start	

+	R	 >	Windord	 >	Enter	។	បនា្ទ បម់កបជង្កើត	 Table	មយួតដលមាន	6	

Rows		5	Columns	

វិធីសាស្រ្តងាយៗនៃការងារ
រដ្ឋបាលដោយដ្រើ Mail Merge 

ក្នុង Word 2013

 ២.	 ជធវើការបំជពញតមមលៃជៅតាមតគមរូវការតដលជោកអ្កចងប់ាន	 ប៉ានុតន្ត	

សគមាបក់ារអននុវត្តនរ៍បស់គករុមការងាររបស់ជយើងមានដូចជា	 ID,	 Name,	

Sex,	Position,	Image	សូមជមើលរូប៖

	 បន្ទប់មកសូមរកសា្រនុកជៅក្នុង្ីរតាំងមួយជោយោក់ជ ្្ម ោះ	 Staff		

ជហើយ	Save	 រចួបិ្រ	Document	 ជនោះចនុោះ	 ជដើម្ឲី្យកានត់តចបាស់សូមជមើល	

រូបខាងជគកាម៖
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 ៣.	 ជធវើការបជង្កើតនូវ	 Document	Word	 មយួថ្មីជ្រៀត	 បនា្ទ បម់កសូម	

ជធវើការរចនាជា្រគមង់នាមប័ណ្ណ ជោយឧទាហរណ៍របស់គករុមការងារជយើង	

បានជធវើការរចនារូបមយួតដលជា	 Logo	 របស់គករុមហ៊នុន្រនុកជាជគសចជហើយ	

ដូជច្ោះសូមជោកអ្ក	 Insert	 រូបជនាោះចូលមកក្នុង	 Document	 របស់ជយើង	

ជោយចូលជៅកាន	់Insert	>	Pictures	>	Brow	ជៅរក្រីតាងំតដលវាសថាិត

ជៅបនា្ទ បម់កសូមចនុចប៊ូតនុង	Insert	ជាការជគសច៖

	 សូមចនុចជៅជលើរបូភាពជនាោះ	បនា្ទ បម់កសូមចូលជៅកាន	់Picture	Toos	

ជហើយជធវើការកំណត	់Picture	Style	ជា	Reflected	Rounded	Rectangle	

	 បនា្ទ ប់មកជោកអ្កនឹង្រ្ួរលបានល្រ្ធផលដូចរូបខាងជគកាមតដល		

មានសណា្ឋ នដូចជានាមបណ័្ណ សូមជមើលរូប៖

	 ៤.	 ជគបើ	 Text	 Box	 ជដើម្្ូីរជាចំណនុ ចសគមាបោ់ក្់រិន្នយ័ជៅតាម				

តគមរូវការរបស់ជោកអ្កក្នុងជគាលបំណងងាយគសរួលគ្រប់គ្រង្រគមង់ឲ្យ		

មានលក្ខណៈ	គសស់ស្អា តជោយចូលជៅកាន	់Insert	>	Text	Box	>	Draw	

Text	Box	រចួជធវើការ្ូររជាកាជគសច៖

	 សូមជោកអ្កជមើលល្រ្ធផលតដល្រ្រួលបានដូចរូបភាពខាងជគកាម៖

	 សូមជធវើការជោោះបនា្ទ តជ់ចញពី	Text	Box	ជោយចនុចជៅជលើ	Text	Box	

ទាងំអស់	 រចួចូលជៅកាន	់ Format	 >	 Shap	 Outline	 >	 No	 Outline		

សូមជមើលរូបខាងជគកាម៖
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	 ក្នុងការងាររដ្ឋបាលគ្របស់្ថា បន័មនិថារដ្ឋ	 ឯកជន	 ឬគករុមហ៊នុនតូចធំតតងតតជគជើសជរ ើសយកកម្មវធិីមយួតដលជាផលិតផលរបស់គករុមហ៊នុន	 Microsoft		

ជ ្្ម ោះ	Microsoft	Word	 ជោយខានពនុំបាន។	ពីមយួជំនានជ់ៅមយួជំនាន	់Microsoft	Word	បានជធវើការ	Update	ទាងំ	Version	និងសមថាភាពតដលបង្ករ		

លក្ខណៈងាយគសរួលដល់អ្កជគបើគបាស់។	យ៉ា ងណាមញិក្នុងជលខជនោះតដរ	 គករុមការងាររបស់ជយើងនឹងជធវើការបងាហា ញពីរជបៀបជគបើ	 Mail	 Merge	 ជៅក្នុង									

Microsoft	Word	2013	ជូនដល់គបិយមតិ្តតដលនិយមគាគំ្រ្រស្សនាវដ្ី្រី	គករុងពតម៌ានវ្ិរយា។	ជតើអវីជៅជា	Mail	Merge?	ជ្រជគបើក្នុងជគាលបំណងអវី?	តាមពឹត	

ជៅ	 Mail	 Merge	 គតរូវបានជ្រជគបើសគមាបជ់ធវើការងាររដ្ឋបាលមយួចំនួនដូចជា	 ការជធវើនាមបណ័្ណ 	 លិខិតអជ ជ្ ើញ	 ជគស្មសំបនុគតអជ ញ្ ើញពិធីអាពាហ៍ពិពាហ៍	

ជោយមានពតម៌ានដតដលៗដូចជា	ជ ្្ម ោះ	អាស័យោ្ឋ ន	ជលខ្ូររស័ព្ទ	ជាជដើម	ជោយជោកអ្កជធវើតតម្ង្ឺរបានទាងំអស់។	ដូជច្ោះ	ជដើម្ឲី្យយល់កានត់តចបាស់

សូមអននុវត្តនជ៍ាមយួគ្ានឹងគករុមការងារ	របស់ជយើងតដលមានជាដំណាកក់ាលដូចខាង	ជគកាម៖

 ១.	ជបើកកម្មវធិី	Microsift	Word	ជោយចូលជៅកាន	់Start	>	All	Pro-
gram	>	Microsoft	Office	>	word	2013	ឬជោយជគបើ	Command	Start	

+	R	 >	Windord	 >	Enter	។	បនា្ទ បម់កបជង្កើត	 Table	មយួតដលមាន	6	

Rows		5	Columns	

វិធីសាស្រ្តងាយៗនៃការងារ
រដ្ឋបាលដោយដ្រើ Mail Merge 

ក្នុង Word 2013

 ២.	 ជធវើការបំជពញតមមលៃជៅតាមតគមរូវការតដលជោកអ្កចងប់ាន	 ប៉ានុតន្ត	

សគមាបក់ារអននុវត្តនរ៍បស់គករុមការងាររបស់ជយើងមានដូចជា	 ID,	 Name,	

Sex,	Position,	Image	សូមជមើលរូប៖

	 បន្ទប់មកសូមរកសា្រនុកជៅក្នុង្ីរតាំងមួយជោយោក់ជ ្្ម ោះ	 Staff		

ជហើយ	Save	 រចួបិ្រ	Document	 ជនោះចនុោះ	 ជដើម្ឲី្យកានត់តចបាស់សូមជមើល	

រូបខាងជគកាម៖
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 ៣.	 ជធវើការបជង្កើតនូវ	 Document	Word	 មយួថ្មីជ្រៀត	 បនា្ទ បម់កសូម	

ជធវើការរចនាជា្រគមង់នាមប័ណ្ណ ជោយឧទាហរណ៍របស់គករុមការងារជយើង	

បានជធវើការរចនារូបមយួតដលជា	 Logo	 របស់គករុមហ៊នុន្រនុកជាជគសចជហើយ	

ដូជច្ោះសូមជោកអ្ក	 Insert	 រូបជនាោះចូលមកក្នុង	 Document	 របស់ជយើង	

ជោយចូលជៅកាន	់Insert	>	Pictures	>	Brow	ជៅរក្ីរតាងំតដលវាសថាិត

ជៅបនា្ទ បម់កសូមចនុចប៊ូតនុង	Insert	ជាការជគសច៖

	 សូមចនុចជៅជលើរបូភាពជនាោះ	បនា្ទ បម់កសូមចូលជៅកាន	់Picture	Toos	

ជហើយជធវើការកំណត	់Picture	Style	ជា	Reflected	Rounded	Rectangle	

	 បនា្ទ ប់មកជោកអ្កនឹង្រ្ួរលបានល្រ្ធផលដូចរូបខាងជគកាមតដល		

មានសណា្ឋ នដូចជានាមបណ័្ណ សូមជមើលរូប៖

	 ៤.	 ជគបើ	 Text	 Box	 ជដើម្្ូីរជាចំណនុ ចសគមាបោ់ក្់រិន្នយ័ជៅតាម				

តគមរូវការរបស់ជោកអ្កក្នុងជគាលបំណងងាយគសរួលគ្រប់គ្រង្រគមង់ឲ្យ		

មានលក្ខណៈ	គសស់ស្អា តជោយចូលជៅកាន	់Insert	>	Text	Box	>	Draw	

Text	Box	រចួជធវើការ្ូររជាកាជគសច៖

	 សូមជោកអ្កជមើលល្រ្ធផលតដល្រ្រួលបានដូចរូបភាពខាងជគកាម៖

	 សូមជធវើការជោោះបនា្ទ តជ់ចញពី	Text	Box	ជោយចនុចជៅជលើ	Text	Box	

ទាងំអស់	 រចួចូលជៅកាន	់ Format	 >	 Shap	 Outline	 >	 No	 Outline		

សូមជមើលរូបខាងជគកាម៖
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	 ៥.	សូមជធវើការ	Start	Mail	Merge	ជោយចូលជៅកាន	់Mailings	>	

Select		Recipients	>	Use	an	Existing	List	>	Brow	ជៅរក	File	Staff	

តដលផ្ទនុក	្ិរន្នយ័	ជហើយចនុច	Open	ជាការជគសច៖

	 បនា្ទ បពី់បានជធវើការ	 Start	 Mail	 Merge	 រចួមកសូមជោកអ្កោក	់

Cursor	 ជៅក្នុង	 Text	 Box	 Name	 រចួចូលជៅកាន	់Mailings	 >	 Insert	

Merge	Field	>	Name	៖

	 ជធវើដូចខាងជលើដតដលៗ	 រហូតទាល់តតអស់តគមរូវការតដលមានជៅក្នុង	

នាមបណ័្ណ ទាងំអស់	សូមជមើលរូបភាពខាងជគកាម៖

	 ៦.	 ជគកាយពីជោកអ្កបានជធវើការអននុវត្តនជ៍ាជំហានៗដូចគករុមការងារ

របស់ជយើងខាងជលើជោកអ្កនឹង្រ្រួលបានល្រ្ធផល្រួរជា្រីគាប់ចិត្ត។	

ជោកអ្ក	អាចជមើលល្រ្ធផលបានជោយគគានត់តចនុច	Preview	Results	៖

	 ជៅជពលតដលជោកអ្កចនុចប៊ូតនុង	 Next	 Recode	 ជនាោះវានឹងជធវើការ	

ទាញ្ិរន្នយ័ពី	Row	បនា្ទ បត់ដលមានជៅក្នុង	Table	 មន	 staff	 File	 សូម	

ជមើលរូបជដើម្ឲី្យកានត់តចបាស់៖

	 សូមបញ្ជ កត់ដលថាជៅជពលជយើងជធវើការ	 Print	 គបសិនជបើជោកអ្ក	

មាន្ិរន្នយ័ជៅក្នុង	Table	មន	Staff	File	100	Record	ជនាោះវានឹងជធវើការ	

Print  ទាំងអស់ជោយពនុំចាំបាច់ជោកអ្កជធវើការបជង្កើតនូវនាមប័ណ្ណ ជនោះ	

ដតដលៗរហូតដល់	100	ដងជនាោះជ្រ៕
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	 គបសិនជបើជោកអ្កជគបើ	 Windows	 8	 ជៅជពលតដលជោកអ្កចនុច	 Lock	 Screen	 ឬកច៏នុច	 Start	 +	 L	 ជនាោះជតើជោកអ្កនឹងជ�ើញអវីជកើតជ�ើង	 ?	

បា្រពឹតណាស់កនុំព្ូយ្ររ័	Windows	 របស់ជោកអ្កគបាកដជា	Lock	Screen	 ជហើយ	តម៉ានជ្រ?	មយា៉ាងវញិជ្រៀតវានឹងបងាហា ញគពមជាមយួនូវ	 ជមា៉ា ង	 មថងៃតខ	និង	

អាកាសធាតនុជាជដើម។	 ជតើការបរជិចឆេតមនជមា៉ា ងរបស់ជោកអ្កមាន្រគមងយ៉ា ងដូចជម្ច?	 ជាធម្មតាវាគបាកដជាចាបយ់កតមមលៃដូចជៅនឹង្រគមងមន	 Taskbar	

របស់ជោកអ្កមនិខាន។	ប៉ានុតន្តមនិថវីជ្រជោកអ្កអាចជធវើការតកតគប្រគមងរបស់វាបានយ៉ា ងងាយបំផនុត។

	 ចំជពាោះការតកតគប្រគមងរបស់ជមា៉ា ងជោកអ្កអាចចូលជៅ	 Control	

Panel	 តដលអននុញ្ញ តឲ្យជយើងអាចជធវើការតកតគបបានយ៉ា ងងាយគសរួលមន	

Lock	Screen	របស់ជមា៉ា ង	និងការបរជិចឆេតមនកនុំព្ូយ្ររ័របស់ជយើង។	មយា៉ាងវញិ	

ជ្រៀតជោកអ្កកអ៏ាចជធវើការតកតគបបានតាមរយៈ	Registry

គៃ្លឹះងាយៗ្រ្រារ់កកក្រដរា៉ោង
នៃ Windows 8 Lock Screen

	 ជដើម្ចូីលជៅកាន	់Regedit	សូមចនុច	Start	+	R	>	regedit	>	Enter	

បនា្ទ បម់ក	 Windows	 នឹងបងាហា ញ	 Dialog	 Registry	 Editor	 ដូចរូបខាង	

ជគកាម៖

	 បនា្ទ បម់កសូមចូលជៅកាន្់រីតាងំមន	 LocaleInfo	 ជោយចនុចជលើ	

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\

CurrentVersion\	 SystemProtectedUserData\S-1-5-21-[unique	

ID]\	AnyoneRead\LocaleInfo	ជគកាយមកសូម	Right	Click	ជលើ	Loca-

leInfo		យលពាក្យថា	Permissions	ជមើលរូប៖
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	 ៥.	សូមជធវើការ	Start	Mail	Merge	ជោយចូលជៅកាន	់Mailings	>	

Select		Recipients	>	Use	an	Existing	List	>	Brow	ជៅរក	File	Staff	

តដលផ្ទនុក	្ិរន្នយ័	ជហើយចនុច	Open	ជាការជគសច៖

	 បនា្ទ បពី់បានជធវើការ	 Start	 Mail	 Merge	 រចួមកសូមជោកអ្កោក	់

Cursor	 ជៅក្នុង	 Text	 Box	 Name	 រចួចូលជៅកាន	់Mailings	 >	 Insert	

Merge	Field	>	Name	៖

	 ជធវើដូចខាងជលើដតដលៗ	 រហូតទាល់តតអស់តគមរូវការតដលមានជៅក្នុង	

នាមបណ័្ណ ទាងំអស់	សូមជមើលរូបភាពខាងជគកាម៖

	 ៦.	 ជគកាយពីជោកអ្កបានជធវើការអននុវត្តនជ៍ាជំហានៗដូចគករុមការងារ

របស់ជយើងខាងជលើជោកអ្កនឹង្រ្ួរលបានល្រ្ធផល្រួរជា្រីគាប់ចិត្ត។	

ជោកអ្ក	អាចជមើលល្រ្ធផលបានជោយគគានត់តចនុច	Preview	Results	៖

	 ជៅជពលតដលជោកអ្កចនុចប៊ូតនុង	 Next	 Recode	 ជនាោះវានឹងជធវើការ	

ទាញ្ិរន្នយ័ពី	Row	បនា្ទ បត់ដលមានជៅក្នុង	Table	 មន	 staff	 File	 សូម	

ជមើលរូបជដើម្ឲី្យកានត់តចបាស់៖

	 សូមបញ្ជ កត់ដលថាជៅជពលជយើងជធវើការ	 Print	 គបសិនជបើជោកអ្ក	

មាន្ិរន្នយ័ជៅក្នុង	Table	មន	Staff	File	100	Record	ជនាោះវានឹងជធវើការ	

Print  ទាំងអស់ជោយពនុំចាំបាច់ជោកអ្កជធវើការបជង្កើតនូវនាមប័ណ្ណ ជនោះ	

ដតដលៗរហូតដល់	100	ដងជនាោះជ្រ៕
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	 គបសិនជបើជោកអ្កជគបើ	 Windows	 8	 ជៅជពលតដលជោកអ្កចនុច	 Lock	 Screen	 ឬកច៏នុច	 Start	 +	 L	 ជនាោះជតើជោកអ្កនឹងជ�ើញអវីជកើតជ�ើង	 ?	

បា្រពឹតណាស់កនុំព្ូយ្ររ័	Windows	 របស់ជោកអ្កគបាកដជា	Lock	Screen	 ជហើយ	តម៉ានជ្រ?	មយា៉ាងវញិជ្រៀតវានឹងបងាហា ញគពមជាមយួនូវ	 ជមា៉ា ង	 មថងៃតខ	និង	

អាកាសធាតនុជាជដើម។	 ជតើការបរជិចឆេតមនជមា៉ា ងរបស់ជោកអ្កមាន្រគមងយ៉ា ងដូចជម្ច?	 ជាធម្មតាវាគបាកដជាចាបយ់កតមមលៃដូចជៅនឹង្រគមងមន	 Taskbar	

របស់ជោកអ្កមនិខាន។	ប៉ានុតន្តមនិថវីជ្រជោកអ្កអាចជធវើការតកតគប្រគមងរបស់វាបានយ៉ា ងងាយបំផនុត។

	 ចំជពាោះការតកតគប្រគមងរបស់ជមា៉ា ងជោកអ្កអាចចូលជៅ	 Control	

Panel	 តដលអននុញ្ញ តឲ្យជយើងអាចជធវើការតកតគបបានយ៉ា ងងាយគសរួលមន	

Lock	Screen	របស់ជមា៉ា ង	និងការបរជិចឆេតមនកនុំព្ូយ្ររ័របស់ជយើង។	មយា៉ាងវញិ	

ជ្រៀតជោកអ្កកអ៏ាចជធវើការតកតគបបានតាមរយៈ	Registry

គៃ្លឹះងាយៗ្រ្រារ់កកក្រដរា៉ោង
នៃ Windows 8 Lock Screen

	 ជដើម្ចូីលជៅកាន	់Regedit	សូមចនុច	Start	+	R	>	regedit	>	Enter	

បនា្ទ បម់ក	 Windows	 នឹងបងាហា ញ	 Dialog	 Registry	 Editor	 ដូចរូបខាង	

ជគកាម៖

	 បនា្ទ បម់កសូមចូលជៅកាន្់រីតាងំមន	 LocaleInfo	 ជោយចនុចជលើ	

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\

CurrentVersion\	 SystemProtectedUserData\S-1-5-21-[unique	

ID]\	AnyoneRead\LocaleInfo	ជគកាយមកសូម	Right	Click	ជលើ	Loca-

leInfo		យលពាក្យថា	Permissions	ជមើលរូប៖
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 បនា្ទ បម់កសូមជធវើការផល់្សិ្រ្ធជិៅឲ្យអក្ជគបើគបាស់	Full	Control	 ជដើម្	ី
អននុញ្ញ តឲ្យអ្កជគបើគបាស់មានសិ្រិ្ធគ្របគ់គានស់គមាបជ់ធវើការតកតគបតមមលៃជៅ	
ជលើ	Regedit	ជោយគគានត់តតែកជៅជលើ	Full	Control	បនា្ទ បម់ក	សូមចនុច	
ប៊ូតនុង	Ok	ជាការជគសច៖

	 ចំណនុ ចជនោះជោកអ្កសូមចនុចពីរដងជៅជលើ	TimeFormat	ជនាោះវានឹង	
ជលចជ�ើងនូវ	 Dialog	 Box	 មយួសគមាបជ់ោកអ្កអាចតកតគប្រគមងជមា៉ា ង	
ជៅតាមតដលជោកអ្កចងប់ាន	ជៅក្នុង	TextBox	Value	data	បនា្ទ បម់ក	
សូមចនុចប៊ូតនុង	Ok	

	 បនា្ទ ប់ពីជោកអ្កបានអននុវត្តន៍ជៅតាមការតណនាំរបស់គករុមការងារ	
ជយើងជនាោះជោកអ្កនឹង្រ្រួលបាន្រគមង់ជមា៉ា ងថ្មីជៅជពលតដលជោកអ្ក
ជធវើការ	Lock	Screen	ដូចល្រ្ធផលមនរូបខាងជគកាម	៖

	 ជាជរឿយៗជោកអ្កតដលជាគបិយមតិ្តមនបណា្ត ញសង្គម	 Facebook	

និង	 Google+	 កំពនុងតតមានការរខំានដល់ជោកអ្កមយួចំនួនបូករមួទាងំ	

គករុមការងារជយើងផងតដរ	តាមរយៈការជផញើស្រជអ�ិចគតរូនិចចូល	ក្នុងអាសយ

ោ្ឋ នអនុីតម៉ាលរបស់ជោកអ្កណាស់តមនជ្រ?	តាមពិតជៅ	វាពិត	ជាមានស្រៈ

សំខាន់ណាស់សគមាប់ជោកអ្កតដលមានបំណងចង់បញ្ឈប់ការរខំានពី	

ការជផញើ	Email	របស់	Facebook	និង	Google+	មកកាន	់Email	Account	

ឲ្យដឹងពីការ	ផ្លៃ ស់ប្តូរថ្មីៗ	ពីមតិ្តភក្តិរបស់អ្កតាមរយៈការផនុសរបស់ពួកជ្រ	។	

ចនុោះជបើជោកអ្កអនឡាញជស្ទើរតត៥	ជៅ	១០ជមា៉ា ង	ក្នុងមយួមថងៃជនាោះ	ជតើជោ

កអ្កចាបំាចគ់តរូវ្រ្រួលយកការជផញើស្រជនាោះជ្រៀតតដរជ្រ?	ចជមលៃើយ	គបាកដជា	

អតជ់ហើយ!

	 *	ដំជណាោះគស្យជដើម្បីញ្ឈបក់ាររខំាន
 ក.	សគមាប	់FACEBOOK

	 ជាដំបូង	 សូម	 Login	 ចូលជៅកាន្់រណនី	 Facebook	 របស់អ្ករចួ	

បន្តសូមចនុចជលើសញ្ញ 	Setting	(*)	ជហើយចូលជៅកាន	់Account	Settings

រញោឈរ់ការរំខាៃ នៃការដ្ញើ
 Email  ររ្រ់ Facebook ៃិង 

Google+ ដៅកាៃ់ email Account  
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	 បនា្ទ បម់កសូមចនុចជលើ	 Tab	 Notification	 តដលជៅខាងជែវងមដរបស់	

ជោកអ្កជនាោះវានឹងជលចជចញនូវ	Form	មយួដូចរូបខាងជគកាម៖

	 សូមជោកអ្កបន្ត	ចនុចជលើ	Edit	 គតង	់Email	 រចួជធវើការកំណតថ់ា	 ជតើ	

ជោកអ្កចងឲ់្យ	 Facebook	 ជផញើជៅជោកអ្កនូវគតងច់ំននុចណាខលៃោះ	 ឬអាច	

ជធវើតាម	រូបខាងជគកាមជាការជគសច៖

 ខ.	សគមាប	់GOOGLE+

	 សគមាប	់Google	 Plus	 វញិជោកអ្ក	អាចបិ្រការជផញើស្ររខំានចូល	

Inbox	 Gmail	 របស់អ្កបានជោយចូលផ្្ទ ល់ជៅកាន់	 https://www.

google.com/settings/plus

	 បនា្ទ បម់ក	 សូម	 Scroll	 ចនុោះជគកាម	 រហូតដល់គតងច់ំណនុ ច	 Receive	

Notifications	 រចួជោកអ្កអាចជគជើសជរ ើសជជគមើសណាមយួតដលជោក	

អ្កមនិចង	់្រ្រួល	បានស្រចូលក្នុង	Inbox	អ្ក	។

	 ជគកាយពីជោកអ្កបានអននុវត្តនដូ៍ចតដលគករុមការងាររបស់ជយើងបាន	

ជធវើការបងាហា ញខាងជលើជនាោះ	 រាល់ការរខំានព់ីសំណាកស់្រជអ�ិចគតរូនិចពិត	

ជា	គា្ម នការរខំានដ់ល់	Account	Email	របស់ជោកអ្កជ្រៀតជហើយ៕
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 បនា្ទ បម់កសូមជធវើការផ្ល់សិ្រ្ធជិៅឲ្យអ្កជគបើគបាស់	Full	Control	 ជដើម្	ី
អននុញ្ញ តឲ្យអ្កជគបើគបាស់មានសិ្រិ្ធគ្របគ់គានស់គមាបជ់ធវើការតកតគបតមមលៃជៅ	
ជលើ	Regedit	ជោយគគានត់តតែកជៅជលើ	Full	Control	បនា្ទ បម់ក	សូមចនុច	
ប៊ូតនុង	Ok	ជាការជគសច៖

	 ចំណនុ ចជនោះជោកអ្កសូមចនុចពីរដងជៅជលើ	TimeFormat	ជនាោះវានឹង	
ជលចជ�ើងនូវ	 Dialog	 Box	 មយួសគមាបជ់ោកអ្កអាចតកតគប្រគមងជមា៉ា ង	
ជៅតាមតដលជោកអ្កចងប់ាន	ជៅក្នុង	TextBox	Value	data	បនា្ទ បម់ក	
សូមចនុចប៊ូតនុង	Ok	

	 បនា្ទ ប់ពីជោកអ្កបានអននុវត្តន៍ជៅតាមការតណនាំរបស់គករុមការងារ	
ជយើងជនាោះជោកអ្កនឹង្រ្រួលបាន្រគមង់ជមា៉ា ងថ្មីជៅជពលតដលជោកអ្ក
ជធវើការ	Lock	Screen	ដូចល្រ្ធផលមនរូបខាងជគកាម	៖

	 ជាជរឿយៗជោកអ្កតដលជាគបិយមតិ្តមនបណា្ត ញសង្គម	 Facebook	

និង	 Google+	 កំពនុងតតមានការរខំានដល់ជោកអ្កមយួចំនួនបូករមួទាងំ	

គករុមការងារជយើងផងតដរ	តាមរយៈការជផញើស្រជអ�ិចគតរូនិចចូល	ក្នុងអាសយ

ោ្ឋ នអនុីតម៉ាលរបស់ជោកអ្កណាស់តមនជ្រ?	តាមពិតជៅ	វាពិត	ជាមានស្រៈ

សំខាន់ណាស់សគមាប់ជោកអ្កតដលមានបំណងចង់បញ្ឈប់ការរខំានពី	

ការជផញើ	Email	របស់	Facebook	និង	Google+	មកកាន	់Email	Account	

ឲ្យដឹងពីការ	ផ្លៃ ស់ប្តូរថ្មីៗ	ពីមតិ្តភក្តិរបស់អ្កតាមរយៈការផនុសរបស់ពួកជ្រ	។	

ចនុោះជបើជោកអ្កអនឡាញជស្ទើរតត៥	ជៅ	១០ជមា៉ា ង	ក្នុងមយួមថងៃជនាោះ	ជតើជោ

កអ្កចាបំាចគ់តរូវ្រ្រួលយកការជផញើស្រជនាោះជ្រៀតតដរជ្រ?	ចជមលៃើយ	គបាកដជា	

អតជ់ហើយ!

	 *	ដំជណាោះគស្យជដើម្បីញ្ឈបក់ាររខំាន
 ក.	សគមាប	់FACEBOOK

	 ជាដំបូង	 សូម	 Login	 ចូលជៅកាន្់រណនី	 Facebook	 របស់អ្ករចួ	

បន្តសូមចនុចជលើសញ្ញ 	Setting	(*)	ជហើយចូលជៅកាន	់Account	Settings

រញោឈរ់ការរំខាៃ នៃការដ្ញើ
 Email  ររ្រ់ Facebook ៃិង 

Google+ ដៅកាៃ់ email Account  
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	 បនា្ទ បម់កសូមចនុចជលើ	 Tab	 Notification	 តដលជៅខាងជែវងមដរបស់	

ជោកអ្កជនាោះវានឹងជលចជចញនូវ	Form	មយួដូចរូបខាងជគកាម៖

	 សូមជោកអ្កបន្ត	ចនុចជលើ	Edit	 គតង	់Email	 រចួជធវើការកំណតថ់ា	 ជតើ	

ជោកអ្កចងឲ់្យ	 Facebook	 ជផញើជៅជោកអ្កនូវគតងច់ំននុចណាខលៃោះ	 ឬអាច	

ជធវើតាម	រូបខាងជគកាមជាការជគសច៖

 ខ.	សគមាប	់GOOGLE+

	 សគមាប	់Google	 Plus	 វញិជោកអ្ក	អាចបិ្រការជផញើស្ររខំានចូល	

Inbox	 Gmail	 របស់អ្កបានជោយចូលផ្្ទ ល់ជៅកាន់	 https://www.

google.com/settings/plus

	 បនា្ទ បម់ក	 សូម	 Scroll	 ចនុោះជគកាម	 រហូតដល់គតងច់ំណនុ ច	 Receive	

Notifications	 រចួជោកអ្កអាចជគជើសជរ ើសជជគមើសណាមយួតដលជោក	

អ្កមនិចង	់្រ្រួល	បានស្រចូលក្នុង	Inbox	អ្ក	។

	 ជគកាយពីជោកអ្កបានអននុវត្តនដូ៍ចតដលគករុមការងាររបស់ជយើងបាន	

ជធវើការបងាហា ញខាងជលើជនាោះ	 រាល់ការរខំានពី់សំណាកស់្រជអ�ិចគតរូនិចពិត	

ជា	គា្ម នការរខំានដ់ល់	Account	Email	របស់ជោកអ្កជ្រៀតជហើយ៕
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 ជា្ូរជៅ	កាលតដលជោកអ្កជគបើគបាស់មា៉ា សីនុនកនុំព្ូយ្ររ័ជាជរៀងរាល់មថងៃ
ជនាោះចបាស់ជាជជៀសមិនផនុតជ�ើយពីការជកើតមានជ�ើងនូវបញ្ហា ជផ្សងៗ។	
ជហើយ	ជដើម្ជីាការសគមរួល	និងជោោះគស្យបញ្ហា 	មចដន្យរជបៀបជនោះបានអ្ក
ជគបើគបាស់្រួរតតបជង្កើត	Recovery	Drive		មយួជ�ើងជគពាោះថាការជធវើតបបជនោះ
បានផ្តល់		ឲ្យអ្កជគបើគបាស់នូវយនុ្រ្ធ	ស្សស្ដល៏អាក្នុងការ	Boot	មា៉ា សីនុនកនុពំ្ូយ្ររ័រប
ស់ជោកអ្កជ�ើងវញិ	 រចួជហើយជ្រើបចាបជ់ផ្តើមដំជណើ រការជៅដល់ដំណាក់
កាល		 Recovery	 Tool	 តតម្តង។	 ផ្ទនុយមកវញិជដើម្អីាចជធវើការបជង្កើត	 Re

-
covery	 Drive	 បានជាបឋមជោកអ្កគតរូវចូលជៅកាន	់ Start	 Search	
រចួចនុចជលើ	មនុខងារ	“Settings”	និងបន្តវាយពាក្យ	“Recovery	ឬ	Recover”	
ចូលក្នុងគបអប	់Settings		បនា្ទ បម់កសូមជគជើសជរ ើសយក		“Create	a	recov-
ery	drive”	។

 ជាមយួគ្ាជនោះតដរ	 Recovery	 Drive	 Creator	 នឹងចាបជ់ផ្តើមបងាហា ញ	
ជោកអ្កជាលក្ខណៈ	Desktop-based	Wizard	 តដលជៅក្នុងផ្្ទ ងំជនាោះ	
មានភាជ ប់មកនូវ	 Option	 អននុញ្ញ តឲ្យអ្កជគបើគបាស់អាចជធវើការបជង្កើត										
Recovery	Drive	បានយ៉ា ងងាយ	។

	 ជគកាយពីជោកអ្កចនុចជលើប៊ូតនុង	 “Next”	 ជពលជនាោះការភាជ បជ់ៅកាន	់
USB	 Flash		 Drive	 នឹងជកើតជ�ើងភាលៃ ម។		 មយា៉ាងជ្រៀតជោកអ្កកនឹ៏ងបាន
ជ�ើញផងតដរនូវ	 Drives	ទាងំអស់តដលជៅជាបម់ា៉ា សីនុន	កនុំព្ូយ្ររ័ជនាោះដូចជា	
CD-RW	 ឬ	 DVD-R	 ជាជដើម។	 បតនថាមជលើជនោះជៅជ្រៀតជោកអ្កកអ៏ាច		
ជគជើស	Drives	ទាងំជនាោះជំនួសឲ្យ	USB	Flash	Drive	កប៏ាន្ឺរជោកអ្ក	
គគានត់តចនុចជលើមនុខងារ		 “Create	a	system	repair	disk	with	a	CD	or	
DVD”	។

	 បនា្ទ បម់កសូមចាបជ់ផ្តើមជធវើការ	 Select	 ជៅជលើ	 Drive	 ណាមយួ	
តដលជោកអ្កគតរូវការ	Recovery	Drive	រចួជហើយបន្តចនុចជលើប៊ូតនុង	“Next”	
ភាលៃ មជនាោះជ�ើញថា	Recovery	Wizard	នឹងបងាហា ញបញ្ជ កជ់ោកអ្កថាអវីៗ
ជៅក្នុង	Drives	នឹងគតរូវបានលនុបជចាលទាងំគសរុង	បនា្ទ បម់កជោកអ្ក	ចនុច	
ជលើប៊ូតនុង	“Create”	។

	 ភាលៃ មជនាោះ	 Recovery	 Drive	 Wizard	 នឹងចាបជ់ផ្តើមបងាហា ញជ�ើង	
គពមជាមយួដំជណើ រការមនការ	 Formatting	 Drive	 ផងតដរ	 ជហើយវានឹងជធវើ	
ការថតចមលៃង	Utilities,	Tool	 រមួជាមយួ	Files	ជាជគចើនជផ្សងជ្រៀតតដលជា	
តគមរូវការក្នុងការបជង្កើត	Recovery	Environment	៕
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 ជា្ូរជៅ	កាលតដលជោកអ្កជគបើគបាស់មា៉ា សីនុនកនុំព្ូយ្ររ័ជាជរៀងរាល់មថងៃ
ជនាោះចបាស់ជាជជៀសមិនផនុតជ�ើយពីការជកើតមានជ�ើងនូវបញ្ហា ជផ្សងៗ។	
ជហើយ	ជដើម្ជីាការសគមរួល	និងជោោះគស្យបញ្ហា 	មចដន្យរជបៀបជនោះបានអ្ក
ជគបើគបាស់្រួរតតបជង្កើត	Recovery	Drive		មយួជ�ើងជគពាោះថាការជធវើតបបជនោះ
បានផ្តល់		ឲ្យអ្កជគបើគបាស់នូវយនុ្រ្ធ	ស្សស្ដល៏អាក្នុងការ	Boot	មា៉ា សីនុនកនុពំ្ូយ្ររ័រប
ស់ជោកអ្កជ�ើងវញិ	 រចួជហើយជ្រើបចាបជ់ផ្តើមដំជណើ រការជៅដល់ដំណាក់
កាល		 Recovery	 Tool	 តតម្តង។	 ផ្ទនុយមកវញិជដើម្អីាចជធវើការបជង្កើត	 Re

-
covery	 Drive	 បានជាបឋមជោកអ្កគតរូវចូលជៅកាន	់ Start	 Search	
រចួចនុចជលើ	មនុខងារ	“Settings”	និងបន្តវាយពាក្យ	“Recovery	ឬ	Recover”	
ចូលក្នុងគបអប	់Settings		បនា្ទ បម់កសូមជគជើសជរ ើសយក		“Create	a	recov-
ery	drive”	។

 ជាមយួគ្ាជនោះតដរ	 Recovery	 Drive	 Creator	 នឹងចាបជ់ផ្តើមបងាហា ញ	
ជោកអ្កជាលក្ខណៈ	Desktop-based	Wizard	 តដលជៅក្នុងផ្្ទ ងំជនាោះ	
មានភាជ ប់មកនូវ	 Option	 អននុញ្ញ តឲ្យអ្កជគបើគបាស់អាចជធវើការបជង្កើត										
Recovery	Drive	បានយ៉ា ងងាយ	។

	 ជគកាយពីជោកអ្កចនុចជលើប៊ូតនុង	 “Next”	 ជពលជនាោះការភាជ បជ់ៅកាន	់
USB	 Flash		 Drive	 នឹងជកើតជ�ើងភាលៃ ម។		 មយា៉ាងជ្រៀតជោកអ្កកនឹ៏ងបាន
ជ�ើញផងតដរនូវ	 Drives	ទាងំអស់តដលជៅជាបម់ា៉ា សីនុន	កនុំព្ូយ្ររ័ជនាោះដូចជា	
CD-RW	 ឬ	 DVD-R	 ជាជដើម។	 បតនថាមជលើជនោះជៅជ្រៀតជោកអ្កកអ៏ាច		
ជគជើស	Drives	ទាងំជនាោះជំនួសឲ្យ	USB	Flash	Drive	កប៏ាន្ឺរជោកអ្ក	
គគានត់តចនុចជលើមនុខងារ		 “Create	a	system	repair	disk	with	a	CD	or	
DVD”	។

	 បនា្ទ បម់កសូមចាបជ់ផ្តើមជធវើការ	 Select	 ជៅជលើ	 Drive	 ណាមយួ	
តដលជោកអ្កគតរូវការ	Recovery	Drive	រចួជហើយបន្តចនុចជលើប៊ូតនុង	“Next”	
ភាលៃ មជនាោះជ�ើញថា	Recovery	Wizard	នឹងបងាហា ញបញ្ជ កជ់ោកអ្កថាអវីៗ
ជៅក្នុង	Drives	នឹងគតរូវបានលនុបជចាលទាងំគសរុង	បនា្ទ បម់កជោកអ្ក	ចនុច	
ជលើប៊ូតនុង	“Create”	។

	 ភាលៃ មជនាោះ	 Recovery	 Drive	 Wizard	 នឹងចាបជ់ផ្តើមបងាហា ញជ�ើង	
គពមជាមយួដំជណើ រការមនការ	 Formatting	 Drive	 ផងតដរ	 ជហើយវានឹងជធវើ	
ការថតចមលៃង	Utilities,	Tool	 រមួជាមយួ	Files	ជាជគចើនជផ្សងជ្រៀតតដលជា	
តគមរូវការក្នុងការបជង្កើត	Recovery	Environment	៕
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 ២. វិធមីសាសស្តននការបបបើបរាស់

	 ជាដំបូងក្រុមការងារសូមបងា្ហាញពីជំហាននីមួយៗរបស់្ម្មវិធី	 ទៅទ�ើ	

Hardisk ដូចខាងទកកាមៈ

+ បទងកើត	Partition ថ្មី

	 ទដើមហាបីបទងកើតនូវទំហំ	ឬ្ ៏Partition ថ្មីទចញពី	Partition ដដ�មាន	

ទិន្នន័យទហើយមិនបានបង់ទិន្នន័យទោះដំណា្់កា�ដំបូងកតរូវដតដឹងយ៉ហាង	

ចហាបាស់នូវទំហំទំទនររបស់	Partition ដដ�កតរូវបទងកើត	ទហើយ	Partition ដដ�	

បទងកើតថ្មីកតរូវមានទំហំតូចជាទំហំទំទនរននទំហំ	Partition ដដ�កតរូវយ្ម្	

បទងកើតទោយ	Right+Click ទ�ើ	Partition ទោះរួចយ្ពា្ហាយ			Resize/

Move partition

 បងា្ហាញផ្ហាំង	Resize/Move partition

	 កា�ពីទ�ខមរុន	 ទសហាសោវដី្ទីក រ្ុងពត៌មានវិទហាយាបានង្ាហាញទៅដ�់កបិយ	

មិត្យ៉ហាង�ម្ិតទា្់ទងទៅនឹងការបទងកើត	Auto Play ទៅ	ទ�ើបន្ះ	CD & 

DVD រួចម្ទហើយ។	 ទោយដែ្ទៅ្្ននុងការទចញផហាសាយទ�ខទនះផងដដរ			

ក្រុមការងារននទសហាសោវដ្ីទយើងនឹងពាំោំទ�ើ្យ្ម្បង្ាហាញនូវចំទេះដឹងថ្មី

ៗ្៏ដូចជាបទពិទោធន៍�្ៗ។	 ទា្់ទងទៅនឹង	 Partition	 របស់	 Hardisk	

Drive	 ទៅ្្ននុងមា៉ហាសរុីន្រុំពហាយូទ័រទោយ្្ននុងទោះរួមមានការដបងដច្	 ក្រប់ក្រង	

បទងកើតនូវ	Partition HDD	។	និយយពី�្្ខេៈពិទសសដដ�្ម្មវិធីនឹង				

កតរូវទ�ើ្យ្ម្បងា្ហាញទនះ	 ្រឺបានផ្�់នូវោរៈកបទយជន៍ដ៏ទកចើន	 និង						

ដំទណាះកោយដ៏�្បំផរុត។	ជាងទនះទៅទទៀតទោះបានសិ្ហាសាបទងកើតផ្�់នូវ	

ភាពងាយកសួ�ទៅទ�ើការទកបើកបាស់	 និងភាពសំបូរដបបននសមត្ិភាពទាំង	

កសរុងទៅទ�ើ	Hardisk	ដូចជា	មរុខងារពោ្ហានូវ	NTFS system partition 

ទោយមិនចាំបាច់	reboot	មា៉ហាសរុីន្រុំពហាយូទ័រ។	មរុខងារ	Merge partitions	

កចបាច់បញូ្�នូវ	Partition ទំាងអស់ឲហាយទៅជា	Partition ដតមួយ	មរុខងារ	

បំដបលែង	(Convert) កបទេទ	File System ពី	FAT ទៅ	NTFS និងជាពិទសស	

ទកបើកបាស់ទៅនឹងជំោន់	Microsoft Windows XP, Vista, 7 និង 8 

ដថមទទៀតផង៕  	 

១. របបៀបដំប�ើរការកម្វិធមី
	 បោ្ហាប់ពីទោ្អ្ន្បានដំទែើង្ម្មវិធីរួចរា�់ទហើយ	 	 សូមចរុចទៅទ�ើ	

មឺរុនរុយ	Start > All Programs > easeUS Partition Master 

9.2.1 Server Edition> easeUS Partition Master 9.2.1 

Server Edition ទព�ទោះផ្ហាំ្ម្មវិធីអនរុវត្ន៍នឹងទ�ចទចញទែើងដូចរូប	

ខាងទកកាមៈ
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 ២. វិធមីសាសស្តននការបបបើបរាស់

	 ជាដំបូងក្រុមការងារសូមបងា្ហាញពីជំហាននីមួយៗរបស់្ម្មវិធី	 ទៅទ�ើ	

Hardisk ដូចខាងទកកាមៈ

+ បទងកើត	Partition ថ្មី

	 ទដើមហាបីបទងកើតនូវទំហំ	ឬ្ ៏Partition ថ្មីទចញពី	Partition ដដ�មាន	

ទិន្នន័យទហើយមិនបានបង់ទិន្នន័យទោះដំណា្់កា�ដំបូងកតរូវដតដឹងយ៉ហាង	

ចហាបាស់នូវទំហំទំទនររបស់	Partition ដដ�កតរូវបទងកើត	ទហើយ	Partition ដដ�	

បទងកើតថ្មីកតរូវមានទំហំតូចជាទំហំទំទនរននទំហំ	Partition ដដ�កតរូវយ្ម្	

បទងកើតទោយ	Right+Click ទ�ើ	Partition ទោះរួចយ្ពា្ហាយ			Resize/

Move partition

 បងា្ហាញផ្ហាំង	Resize/Move partition

	 កា�ពីទ�ខមរុន	 ទសហាសោវដី្ទីក រ្ុងពត៌មានវិទហាយាបានង្ាហាញទៅដ�់កបិយ	

មិត្យ៉ហាង�ម្ិតទា្់ទងទៅនឹងការបទងកើត	Auto Play ទៅ	ទ�ើបន្ះ	CD & 

DVD រួចម្ទហើយ។	 ទោយដែ្ទៅ្្ននុងការទចញផហាសាយទ�ខទនះផងដដរ			

ក្រុមការងារននទសហាសោវដ្ីទយើងនឹងពាំោំទ�ើ្យ្ម្បង្ាហាញនូវចំទេះដឹងថ្មី

ៗ្៏ដូចជាបទពិទោធន៍�្ៗ។	 ទា្់ទងទៅនឹង	 Partition	 របស់	 Hardisk	

Drive	 ទៅ្្ននុងមា៉ហាសរុីន្រុំពហាយូទ័រទោយ្្ននុងទោះរួមមានការដបងដច្	 ក្រប់ក្រង	

បទងកើតនូវ	Partition HDD	។	និយយពី�្្ខេៈពិទសសដដ�្ម្មវិធីនឹង				

កតរូវទ�ើ្យ្ម្បងា្ហាញទនះ	 ្រឺបានផ្�់នូវោរៈកបទយជន៍ដ៏ទកចើន	 និង						

ដំទណាះកោយដ៏�្បំផរុត។	ជាងទនះទៅទទៀតទោះបានសិ្ហាសាបទងកើតផ្�់នូវ	

ភាពងាយកសួ�ទៅទ�ើការទកបើកបាស់	 និងភាពសំបូរដបបននសមត្ិភាពទាំង	

កសរុងទៅទ�ើ	Hardisk	ដូចជា	មរុខងារពោ្ហានូវ	NTFS system partition 

ទោយមិនចាំបាច់	reboot	មា៉ហាសរុីន្រុំពហាយូទ័រ។	មរុខងារ	Merge partitions	

កចបាច់បញូ្�នូវ	Partition ទំាងអស់ឲហាយទៅជា	Partition ដតមួយ	មរុខងារ	

បំដបលែង	(Convert) កបទេទ	File System ពី	FAT ទៅ	NTFS និងជាពិទសស	

ទកបើកបាស់ទៅនឹងជំោន់	Microsoft Windows XP, Vista, 7 និង 8 

ដថមទទៀតផង៕  	 

១. របបៀបដំប�ើរការកម្វិធមី
	 បោ្ហាប់ពីទោ្អ្ន្បានដំទែើង្ម្មវិធីរួចរា�់ទហើយ	 	 សូមចរុចទៅទ�ើ	

មឺរុនរុយ	Start > All Programs > easeUS Partition Master 

9.2.1 Server Edition> easeUS Partition Master 9.2.1 

Server Edition ទព�ទោះផ្ហាំ្ម្មវិធីអនរុវត្ន៍នឹងទ�ចទចញទែើងដូចរូប	

ខាងទកកាមៈ
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 ទៅ្្ននុងផ្ហា ំង	 Resize/Move partition ទហើយកតង់ចំេុច					

Unallocated Space After កតរូវវាយតនមលែទ�ខននទំហំ	 Partition 

ដដ�កតរូវបទងកើតថ្មីទោយ្រិតជា	 MB។	 ចំេុចទនះផងដដរក្រុមការងារទយើង	

សូមទកជើសយ្ទំហំ	5 GB = 5120 MB ទោយយ្ទំហំសររុបទាំងអស់	

របស់	Partition Size 19994.9 ដ្នូវទំហំ	 partition ថ្មីដដ�កតរូវ	

បទងកើត្រឺ	19994.9 - 5120 = 14874.9 យ្ទៅវាយទៅកតង់កបទោះ	

Partition Size ដូចរូប។	ខា្ហាតឯ្តា	1GB = 1024MB។

 

 បោ្ហាប់ម្ចរុចទ�ើប៊ូតរុង	OK ដដ�ស្ិតទៅដផ្ន្ខាងទកកាម

	

	 ចរុចទ�ើប៊ូតរុង	 OK រួចទៅទ�ើផ្ហាង្ម្មវិធីអនរុវត្ទយើងដដដ�នឹងទ�ច	

ទែើងនូវ	Partition ថ្មីមួយដដ�	Partition ថ្មីមួយទោះមាន	ទំហំ	5	GB 

ទហើយ	Right+Click ទ�ើ	Partition ថ្មទីោះយ្ពា ហ្ាយ	Create Partition

 បងា្ហាញផ្ហាំង	Crate Partition

	 + Partition Label ្រឺជាទ្មហាះរបស់	Partition	ថ្មី

	 + Create As ទកជើសយ្	Logical 

 + File System ទកជើសយ្	NTFS

 + Drive Letter តាមតកមរូវការ

	 + Cluster Size ទកជើសយ្	Default

រួចចរុចប៊ូតរុង	OK

 បងា្ហាញ	Partition ថ្មីទៅ្្ននុង្ម្មវិធីអនរុវត្
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	 បោ្ហាប់ចរុចប៊ូតរុង	Apply

 ផ្ហាំងបោ្ហាប់ចរុចទ�ើប៊ូតរុង	YES

 បងា្ហាញផ្ហាំង្ម្មវិធីដំទេើរការ

	 បងា្ហាញផ្ហាំងទកកាយពីការបទងកើតទទួ�ទជា្រជ័យ

	 បងា្ហាញ	Partition ដដ�បានបទងកើតថ្មី

	 + បដន្មទំហំទំទនរពី	Partition D (Data) ទៅកាន់	Partition C 

(Windows)

 ទៅកតង់ដំណា្់កា�ទនះក្រុមការងារទយើងនឹងទធវើការបងា្ហាញទោយ	

យ្ទំហំ	Free Space 2 GB ពី	Partition D (Data) ទៅ	បញ្ូ�្្ននុង	

Partition C (Windows)។	Right + Click ទ�ើ	Partition D (Data) 

យ្ពា្ហាយ	Resize/Move partition

 ទៅទ�ើផ្ហាំង	 Resize/Move partition កតរូវយ្ទំហំ	 Partition 

Size ទាំងអស់្រិតជា	MB ្រឺ	14880.5 MB ដ្ទំហំ	2 GB ្រិតជា	MB 

្រឺ		2048។	14880.5 - 2048 = 12832.5 MB ទហើយយ្តនមលែទោះ	

វាយបញ្ូ�ទៅ្្ននុងកបទោះ	Partition Size ដូចរូប
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	 បោ្ហាប់ចរុចប៊ូតរុង	Apply

 ផ្ហាំងបោ្ហាប់ចរុចទ�ើប៊ូតរុង	YES

 បងា្ហាញផ្ហាំង្ម្មវិធីដំទេើរការ

	 បងា្ហាញផ្ហាំងទកកាយពីការបទងកើតទទួ�ទជា្រជ័យ

	 បងា្ហាញ	Partition ដដ�បានបទងកើតថ្មី

	 + បដន្មទំហំទំទនរពី	Partition D (Data) ទៅកាន់	Partition C 

(Windows)

 ទៅកតង់ដំណា្់កា�ទនះក្រុមការងារទយើងនឹងទធវើការបងា្ហាញទោយ	

យ្ទំហំ	Free Space 2 GB ពី	Partition D (Data) ទៅ	បញ្ូ�្្ននុង	

Partition C (Windows)។	Right + Click ទ�ើ	Partition D (Data) 

យ្ពា្ហាយ	Resize/Move partition

 ទៅទ�ើផ្ហាំង	 Resize/Move partition កតរូវយ្ទំហំ	 Partition 

Size ទាំងអស់្រិតជា	MB ្រឺ	14880.5 MB ដ្ទំហំ	2 GB ្រិតជា	MB 

្រឺ		2048។	14880.5 - 2048 = 12832.5 MB ទហើយយ្តនមលែទោះ	

វាយបញ្ូ�ទៅ្្ននុងកបទោះ	Partition Size ដូចរូប
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ទកកាយពី្ំេត់តាមតកមរូវការទហើយ	ចរុចទ�ើប៊ូតរុង	OK

	 ចរុចទ�ើប៊ូតរុង	OK រួចទៅ្្ននុងផ្ហាំង្ម្មវិធីអនរុវត្នឹងទ�ចទចញ	នូវ	Par-

tition ថ្មីមួយដដ�មានទំហំ	2GB និងមាន	File System (Unallocat-

ed) ដូចរូបខាងទកកាម

	 កតង់ចំេុចទនះដដដ�ទដើមហាបីបញូ្�ទំហំទំទនរទៅ្្ននុង	 Partition C 

(Windows) ទោះទៅដផ្ន្ខាងទកកាមកតរូវទកបើនូវ	Cursors ទដើមហាបីទាញទំហំ	

ទំទនរ 2GB ទោះទៅោ្់ពីខាងមរុខ	Partition C (Windows) ដូចរូប

	 បងា្ហាញទំហំទំទនរ ស្ិតទៅពីខាងមរុខ	Partition C (Windows)

 បោ្ហាប់ពីបានទំហំ	 Free Space ស្ិតទៅពីខាងមរុខ	 Partition C 

(Windows) ទហើយទោះ	 កតរូវ	Right+Click ទ�ើ	Partition C (Win-

dows) ទោះយ្ពា្ហាយ	Resize/Move partition

 ទៅ្្ននុងផ្ហាំង	Resize/Move partitio ននដផ្ន្ខាងទ�ើ	កតរូវទកបើ

Cursors ោ្់ឲហាយទចញដូចរូប	 	រួចទាញពីោ្ហាំទៅទ្វង
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	 បងា្ហាញទំហំ	Partition Size ថ្មីទកកាយពីអនរុវត្

	 ចរុចប៊ូតរុង	OK ទដើមហាបីសទកមច

	 ចរុងទកកាយចរុចប៊ូតរុង	Apply

 

 ផ្ហាំង	Apply Change ចរុចទ�ើបូ៊តរុង	Yes

 រួចទៅ្្ននុងផ្ហាំង	Warning ចរុចទ�ើប៊ូតរុង	Yes ទដើមហាបី	Restart

 ផ្ហាំងដំទេើរការ

	 ដំទេើរការអនរុវត្
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	 បងា្ហាញទំហំ	Partition Size ថ្មីទកកាយពីអនរុវត្

	 ចរុចប៊ូតរុង	OK ទដើមហាបីសទកមច

	 ចរុងទកកាយចរុចប៊ូតរុង	Apply

 

 ផ្ហាំង	Apply Change ចរុចទ�ើបូ៊តរុង	Yes

 រួចទៅ្្ននុងផ្ហាំង	Warning ចរុចទ�ើប៊ូតរុង	Yes ទដើមហាបី	Restart

 ផ្ហាំងដំទេើរការ

	 ដំទេើរការអនរុវត្

IT City Magazine
www.itcity.com.kh46

	 ដំទេើរការចប់ទទួ�បានទជា្រជ័យ

	 បងា្ហាញទំហំទំទនរ 2 GB បដន្មទៅទ�ើ	Partition C (Windows) 

ទកកាយពីអនរុវត្

	

+ មរុខងារ	Copy Partition 

 Copy Partition មានន័យថា	 ថតចមលែងនូវឯ្ោរទិន្នន័យពី្្ននុង	

Partition ណាមួយចូ�ទៅ្្ននុង	 Partition	 មួយទផហាសងទទៀតឲហាយមាន	

ទិន្នន័យដូចគ្ហា។	 កតង់ចំេុចទនះទដើមហាបី	 Copy	 បាន�រុះកតាដត	 Partition 

ដដ�កតរូវ	Copy	ោ្់ទោះមានជា� ្្ខេៈ	Unallocated ដូទច្នះកតរូវបទងកើត	

Partition Unallocated មួយទោយ	Right +Click រ ួចយ្ពា្ហាយ						

Resize/Move partition 

 រួចបទងកើត	Unallocated Space 1024 MB រួចចរុចប៊ូតរុង	OK

 

	 បងា្ហាញ	Unallocated ដដ�បានបទងកើត

	 បោ្ហាប់ម្	Right+Click ទ�ើ	Partition ដដ�កតរូវ	Copy យ្ពា្ហាយ	

Copy Partition 
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 បោ្ហាប់ម្្្ននុងផ្ហាំង	Partition Copy Wizard ចរុចប៊ូតរុង	Next

 ផ្ហាំងបោ្ហាប់ទកជើសយ្	Partition ដដ�មាន	File System Unal-

located ដដ�បានបទងកើតពីខាងទ�ើរួចចរុចប៊ូតរុង	Next ទដើមហាបី	បន្

	 ចរុចប៊ូតរុង	Apply

 ចរុចប៊ូតរុង	Yes

 ស្ម្មភាពទព�ដំទេើរការ

	 ផ្ហាំង	Finish ចរុចប៊ូតរុង	OK

 ទព�ទោះទយើងនឹងទទួ�បាន	 Partition ថ្មីមួយដដ�មានទិន្នន័យ	

ដូចគ្ហាទបះបិទទៅនឹង	Partition (E) ដដ�បានថតចមលែងរួចរា�់

	 តាមរយៈ្ម្មវិធីអនរុវត្	Easeus Partition Master Server ទនះ	

ដដដ�នូវរា�់ការបងា្ហាញពីមរុខងារមួយចំនួនទផហាសងទទៀតនឹងមានបងា្ហាញទៅ	

ទ�ខ	(162)។

( តទៅទេខ 162 )
IT City Magazine
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 បោ្ហាប់ម្្្ននុងផ្ហាំង	Partition Copy Wizard ចរុចប៊ូតរុង	Next

 ផ្ហាំងបោ្ហាប់ទកជើសយ្	Partition ដដ�មាន	File System Unal-

located ដដ�បានបទងកើតពីខាងទ�ើរួចចរុចប៊ូតរុង	Next ទដើមហាបី	បន្

	 ចរុចប៊ូតរុង	Apply

 ចរុចប៊ូតរុង	Yes

 ស្ម្មភាពទព�ដំទេើរការ

	 ផ្ហាំង	Finish ចរុចប៊ូតរុង	OK

 ទព�ទោះទយើងនឹងទទួ�បាន	 Partition ថ្មីមួយដដ�មានទិន្នន័យ	

ដូចគ្ហាទបះបិទទៅនឹង	Partition (E) ដដ�បានថតចមលែងរួចរា�់

	 តាមរយៈ្ម្មវិធីអនរុវត្	Easeus Partition Master Server ទនះ	

ដដដ�នូវរា�់ការបងា្ហាញពីមរុខងារមួយចំនួនទផហាសងទទៀតនឹងមានបងា្ហាញទៅ	

ទ�ខ	(162)។

( តទៅទេខ 162 )
IT City Magazine
www.itcity.com.kh48

រប�ៀ�រចនា

បោយប�ើ HTML CSS និង Jquiry
Image Slideshow
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	 ប�ើប�ើងក្របេ្រប�ើលបេហទំពរ័��ួចំនួនទាងំ្រ្នុង	 និងបករៅក�បទស			

្រំពនុងតែមានវែ្តមានបៅបលើ�ណ្ដា ញអនុីនប�ើតែែ	ប�ើងសបងកេែប�ើញថាការ	

រចនាមានល្រ្ខែៈខនុសៗត�លែ្រគ្្	្រ�៏៉នុតន្តបេហទំពរ័ទាងំបនាះេឺពនុំសូវជាប�ើល

រលំងនូវការដា្រ�់ញូ្ល	 Image	 Slideshow	 ចូលបៅ្រ្នុងបេហទំពរ័រ�ស់	

ខលែួន	បេើ�។	ការដា្រ�ញូ្លនូវ	Image	Slideshow	ចូលបៅ្រ្នុងបេហទំពរ័

េឺបាន�បងកេើននូវបោភែ័្ឌ ភាព	ភាពរស់របវ ើ្រ	និងការទា្រទ់ាញតែ���ួ	្រ� ្
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�ញ្ជា ្រៈ់	 បដើ�្បីាន	 Library	 រ�ស់	 Jquery	 បោ្រអ្្រអាចទាញ�្រត្�	

រ�ៈ	Link:	http://ajax.googleapis.com/ajax/libs/jquery/1.3.2/jquery	

.min.js	សកមា�	់jquery.min.js		និង	http://ajax.googleapis.com/ajax/

libs/jqueryui/1.5.3/jquery-ui.min.js	សកមា�	់jquery-ui.min.js។
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<html>

	 <head>

	 	 <title>Image	Slide	Show	</title>

	 </head>

<body>	

<div	id=”logo”><img	src=”images/logo_itcity.png”	/></div>

	 <div	id=”featured”	>

	 <ul	class=”ui-tabs-nav”>

	 	 <li	class=”ui-tabs-nav-item	ui-tabs-selected”	

	 	 	 id=”nav-fragment-1”>

	 	 	 <a	href=”#fragment-1”><img	src=”images/

	 	 	 image1-small.jpg”	alt=””	/>

	 	 	 <span>15+	Excellent	High	Speed	Photo

	 	 	 graphs</span></a>

	 	 </li>

	 					 <li	class=”ui-tabs-nav-item”

	 	 	 	id=”nav-fragment-2”>

	 	 	 <a	href=”#fragment-2”><img	src=”images/

	 	 	 image2-small.jpg”	alt=””	/>

	 	 	 <span>20	Beautiful	Long	Exposure	

	 	 	 Photographs</span></a>

	 	 </li>

	 					 <li	class=”ui-tabs-nav-item”	

	 	 	 id=”nav-fragment-3”>

	 	 	 <a	href=”#fragment-3”><img	src=”images/

	 	 	 image3-small.jpg”	alt=””	/>

	 	 	 <span>35	Amazing	Logo	Designs

	 	 	 </span></a>

	 	 </li>

	 					 <li	class=”ui-tabs-nav-item”	

	 	 	 id=”nav-fragment-4”>

	 	 	 <a	href=”#fragment-4”><img	src=”images/

	 	 	 image4-small.jpg”	alt=””	/>
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	 	 	 <span>Create	a	Vintage	Photograph	in	

	 	 	 Photoshop</span></a>

	 	 </li>

	 </ul>

	 				 	 	<!--	First	Content	-->

	 <div	id=”fragment-1”	class=”ui-tabs-panel”	style=””>

	 	 <img	src=”images/image1.jpg”	alt=””	/>

	 	 <div	class=”info”	>

	 	 	 <h2><a	href=”#”	>15+	Excellent	High		 	

	 	 	 Speed	Photographs</a></h2>

	 	 	 <p>Lorem	ipsum	dolor	sit	amet,	consecte	 	

	 	 tur	adipiscing	elit.	Nulla	tincidunt	condi	 	 	

	 	 mentum	lacus.	Pellentesque	ut	diam....

	 	 	 <a	href=”#”	>read	more</a></p>

	 	 </div>

	 </div>

	 	 	 <!--	Second	Content	-->

	 <div	id=”fragment-2”	class=”ui-tabs-panel	

	 ui-tabs-hide”	style=””>

	 	 <img	src=”images/image2.jpg”	alt=””	/>

	 	 <div	class=”info”	>

	 	 	 <h2><a	href=”#”	>20	Beautiful	Long

	 	 	 Exposure	Photographs</a></h2>

	 	 	 <p>Vestibulum	leo	quam,	accumsan	

	 	 	 nec	porttitor	a,	euismod	ac	tortor.	Sed		 	

	 	 	 ipsum	lorem,	sagittis	non	egestas	id,		 	

	 	 	 suscipit....<a	href=”#”	>read	more</a>

	 	 	 </p>

	 	 </div>

	 </div>

	 	 	 <!--	Third	Content	-->

	 <div	id=”fragment-3”	class=”ui-tabs-panel	ui-tabs-

	 hide”	style=””>

	 	 	 <img	src=”images/image3.jpg”	alt=””	/>

	 	 <div	class=”info”	>

	 	 	 <h2><a	href=”#”	>35	Amazing	Logo	

	 	 	 Designs</a></h2>

	 	 	 <p>liquam	erat	volutpat.	Proin	id	volutpat	

	 	 	 nisi.	Nulla	facilisi.	Curabitur	facilisis	sollici

	 	 	 tudin	ornare....

	 	 	 <a	href=”#”	>read	more</a></p>

	 	 </div>

	 </div>

	 	 	 <!--	Fourth	Content	-->

	 <div	id=”fragment-4”	class=”ui-tabs-panel	

	 ui-tabs-hide”	style=””>

	 	 <img	src=”images/image4.jpg”	alt=””	/>

	 	 <div	class=”info”	>

	 	 	 <h2><a	href=”#”	>Create	a	Vintage	

	 	 	 Photograph	in	Photoshop</a></h2>

	 	 	 <p>Quisque	sed	orci	ut	lacus	viverra	

	 	 	 interdum	ornare	sed	est.	Donec	porta,		 	

	 	 	 erat	eu	pretium	luctus,	leo	augue		 	 	

	 	 sodales....

	 	 	 <a	href=”#”	>read	more</a></p>

	 	 </div>

	 </div>

	 </div>

	 </div>

</body>
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	 	 	 Photoshop</span></a>
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	 	 	 <a	href=”#”	>read	more</a></p>

	 	 </div>

	 </div>

	 	 	 <!--	Second	Content	-->

	 <div	id=”fragment-2”	class=”ui-tabs-panel	

	 ui-tabs-hide”	style=””>

	 	 <img	src=”images/image2.jpg”	alt=””	/>

	 	 <div	class=”info”	>

	 	 	 <h2><a	href=”#”	>20	Beautiful	Long

	 	 	 Exposure	Photographs</a></h2>

	 	 	 <p>Vestibulum	leo	quam,	accumsan	

	 	 	 nec	porttitor	a,	euismod	ac	tortor.	Sed		 	

	 	 	 ipsum	lorem,	sagittis	non	egestas	id,		 	

	 	 	 suscipit....<a	href=”#”	>read	more</a>

	 	 	 </p>

	 	 </div>

	 </div>

	 	 	 <!--	Third	Content	-->

	 <div	id=”fragment-3”	class=”ui-tabs-panel	ui-tabs-

	 hide”	style=””>

	 	 	 <img	src=”images/image3.jpg”	alt=””	/>

	 	 <div	class=”info”	>

	 	 	 <h2><a	href=”#”	>35	Amazing	Logo	

	 	 	 Designs</a></h2>

	 	 	 <p>liquam	erat	volutpat.	Proin	id	volutpat	

	 	 	 nisi.	Nulla	facilisi.	Curabitur	facilisis	sollici

	 	 	 tudin	ornare....

	 	 	 <a	href=”#”	>read	more</a></p>

	 	 </div>

	 </div>

	 	 	 <!--	Fourth	Content	-->

	 <div	id=”fragment-4”	class=”ui-tabs-panel	

	 ui-tabs-hide”	style=””>

	 	 <img	src=”images/image4.jpg”	alt=””	/>

	 	 <div	class=”info”	>

	 	 	 <h2><a	href=”#”	>Create	a	Vintage	

	 	 	 Photograph	in	Photoshop</a></h2>

	 	 	 <p>Quisque	sed	orci	ut	lacus	viverra	

	 	 	 interdum	ornare	sed	est.	Donec	porta,		 	

	 	 	 erat	eu	pretium	luctus,	leo	augue		 	 	

	 	 sodales....

	 	 	 <a	href=”#”	>read	more</a></p>

	 	 </div>

	 </div>

	 </div>

	 </div>

</body>
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	 �ន្ា�ពី់បោ្រអ្្របានសរបសរ	Code	html	ដូចក្ររុ�ការង្រ	ប�ើងខាង	

បលើរចួ�្រ	បោ្រអ្្រនឹងទទួលបានលទ្ធ្លដូចរូ�ខាង	បកកា�៖

ជំហានទី	២ៈ
	 បនះជាជំហាន�ន្ា�ស់កមា�ប់�វើការបរៀ�ចំរាល់		Content		ននបេហទំពរ័	

រ�ស់ប�ើងឲ្យមានភាពកសស់ោអា ែបៅត្�ចំែងចំែូលចិែ្ត	 និងបសច្រដាី	

កែរូវការ។	 រាល់ការរចនាបេហទំពរ័	 ពិែជាពនុំអាចខវះនូវ	 CSS	 បានបេើ�	

សកមា�ែ់នុ�តែងលំអរទក�ងរ់�ស់	Page	។	ដូបច្ះបោ្រអ្្រកែរូវ�បងកេើែ	File	

��ួប ្្ម ះ	style.css		បហើ�្្នុ្របៅ្រ្នុង	Folder	CSS	រចួសរបសរ	Code	

បៅ្រ្នុង	File	បនាះដូចខាងបកកា�៖
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	 បកកា�ពីបោ្រអ្្របានសរបសរ	 Code	 ដូចតដលក្ររុ�ការង្ររ�ស់	

ប�ើងបានប�វើការ�ង្ហា ញជូនដូចខាងបលើ	 បនាះប�ើងនឹងទទួលបាននូវទក�ង	់

Interface	នន	Image	Slide	Show		យ៉ងកសស់ោអា ែដូ់ចរ�ូខាង	បកកា�បនះ៖
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ជំហានទី	៣ៈ
 បនះជាជំហានចនុងបកកា�តដលប�ើងកែរូវបក�ើនូវភាោ	Jquery	សកមា�	់

�តនថែ�	 Animation	 បដើ�្ឲី្យ	 Slide	 Show	មានសភាពរស់របវ ើ្របដា�ការ		

ផ្លែ ស់�ដាូររូ�ភាពពី��ួបៅ��ួជាសវ័�ក�វែ្តិមានល្រ្ខែៈ	Ramdom	 	 និង	

អាចចនុចបាន្ងតដរ	កគ្នត់ែសរបសរ	 Code	 បៅ្រ្នុង	 Tag	 <head>T</

head>	ដូចខាងបកកា�ជាការបកសច៖

<script	type=”text/javascript”	src=”js/jquery.min.js”	></script>

<script	type=”text/javascript”	src=”js/jquery-ui.min.js”	></script>

<script	type=”text/javascript”>

	 $(document).ready(function(){

	 	 $(“#featured	 >	 ul”).tabs({fx:{opacity:	 “toggle”}}).

tabs(“rotate”,	5000,	true);

	 });

</script>

	 ខាងបកកា�បនះេឺជាលទ្ធ្លតដលប�ើងទទួលបានបកកា�ពី	

បានអននុវែ្តននូ៍វជំហានខាងបលើ៖
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	 line-height:18px;	

}
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peat;		

}
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}
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}
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}
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}
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បានអននុវែ្តននូ៍វជំហានខាងបលើ៖

55www.itcity.com.kh
IT City Magazine



www.itcity.com.kh

Add-ons

www.itcity.com.kh56 IT City Magazine



www.itcity.com.kh

Add-ons

www.itcity.com.kh56 IT City Magazine

 សម្រាប់មុខងារមួយនេះនោកអ្នកអាចចចករំចែែនអម្កង់ (Screen) 

បាេភ្លាមៗពីខាងក្ននុង Gmail។ ចាប់ន្តើមចចករំលែកេូវនអម្កង់របស់ នោកអ្នក

ជាមួយេឹងការចុចចែមួយដងគែ់នោយពុំចាំបាច់ចាកនចញពី Gmail។ ការចាប់

ន្តើមចចករំលែករបស់នោកអ្នកនចញព ីGmail ក្ននុងរយៈនពែែិចជាង 5 វិនាទី 

( ម្ែរូវការ Java នដើមលាបី Share)។

 Troll Faces គឺជា  Add-On ចដែបចេថែមេូវ  Troll Faces ដ៏រាេ 

ភពនពញេិយមនៅក្ននុងផ្លាងំ Facebook chat ចដែអាចឲលាយនោកអ្នកនម្បើម្បាស់

បាេកាេ់ចែនម្ចើេរូបភពយ៉លាងងាយម្សួែ។ ដូនច្នះនោកអ្នករាេភពងាយ 

ម្សួែនម្បើ Troll Faces ខណៈនពែកំពុងជចជកកមលាសាេតជាមួយមិែតភ័កតបាេ

យ៉លាងសបលាបាយរីករាយ។

2

4

 នែើនោកអ្នករាេភពធុញថប់ជាមួយការនោសនា្លាសាយែក់របស់ក្ននុង 

វីនដអូចដែរាេនៅនែើ Youtube ចដររឺនទ? 

 នពែនេះនោកអ្នកអស់កង្វែ់ជាមួយបញ្លានេះនទៀែន�ើយនោយម្រាេ់ 

ចែដំន�ើងកម្មវិធី Adblock for Youtube ភ្លាម  ម្គប់ Pre-Roll Ads នៅនែើ 

Youtube គឺម្ែរូវបិទជានរៀងរ�ូែ។ Adblock វានធ្វើការដកនចញការ្លាសាយ     

ពាណិជកម្មវីនដអូមុេនពែបងា្លាញវីនដអូរបស់នោកអ្នក។

1 Adblock for Youtube
មុខងារបិទ Advert វីដេអូ :

Screenleap for Gmail 
មុខងារចែករំចែក Screen ពី Gmail:

 ចំនពាះការនម្បើម្បាស់មុខងារ  Add-On នេះ  នោកអ្នកម្រាេ់ចែ  Right 

Click ក្ននុងទំព័រ បនា្លាប់មកចុច “Download Facebook album(s)”។ នោក 

អ្នកអាចនធ្វើចបបនេះនៅក្ននុង Album រូបភពមួយ ឬរូបភពមួយ “Photos of 

You” េិងរូបភពទាំងអស់ “Photos” ក្ននុងនគ�ទំព័ររបស់នោកអ្នក។ នោក 

អ្នកអាច Download បាេនម្ចើេ Albums ពីអ្នកនម្បើ  ម្បាស់នោយនធ្វើចបបនេះ 

នៅនែើទំព័រ “Albums”។ នោកអ្នកក៏អាច Download វីនដអូក្ននុង Albums 

ដូចរូបភពចដរ។

3 Download Album រូបភាពក្នុង 
Facebook ជាមួយ facepaste:

Troll Faces សម្រាប់ Facebook Chat:
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 ចំពោះការអភិវឌ្ឍន៍នាពេលបច្ចុប្បន្នពនះមានការព�ឿនពលឿនខ្ពស់គ្រប់វិស័យទាំង Hardware Software និងបពច្កវិទ្យានានាជាពគចើន 

ពទៀត។ ការវិវត្តន៍ទាំងពនាះសុទ្ធតតផ្តល់ភាេងាយគសរួល រហ័ស និងចំពេញពេលវាលាក្នចុងការព្វើការងាយដល់អ្នកពគបើគរាស់ឲ្យទទរួលរាននូវ 

គបសិទ្ធភាេការងារខ្ពស់ គេមទាំងមានទំនុកចិត្ត។ ក្នចុងចំពោមការអភិវឌ្ឍន៍ទាំងពនាះក៏មានកម្មវិ្ី Microsoft Office ក៏គតរូវរានវិវត្តន៍ពៅ មុខកាន់

តតេិពសសក្នចុងការបពគមើការងារ�ូនពលាកអ្នកជាមរួយមុខងារ និង្រុេសម្បត្តិរបស់វា ពនាះ្រឺ Microsoft Office 2013។ ជាងពនះ ពៅពទៀតពដើម្បី

ឲ្យកាន់តតជាក់ច្បាស់ថាវាមានអវីតបលែកចំពោះការបងា្្ញខលែលួនថ្មីពនះ សូមព្វើការតាមដានទាំងអស់គ្្។

Microsoft Office 2013 ?
ត�ើមានអ្វីប្លែកសម្មា្់
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 ចំពោះការអភិវឌ្ឍន៍នាពេលបច្ចុប្បន្នពនះមានការព�ឿនពលឿនខ្ពស់គ្រប់វិស័យទាំង Hardware Software និងបពច្កវិទ្យានានាជាពគចើន 

ពទៀត។ ការវិវត្តន៍ទាំងពនាះសុទ្ធតតផ្តល់ភាេងាយគសរួល រហ័ស និងចំពេញពេលវាលាក្នចុងការព្វើការងាយដល់អ្នកពគបើគរាស់ឲ្យទទរួលរាននូវ 

គបសិទ្ធភាេការងារខ្ពស់ គេមទាំងមានទំនុកចិត្ត។ ក្នចុងចំពោមការអភិវឌ្ឍន៍ទាំងពនាះក៏មានកម្មវិ្ី Microsoft Office ក៏គតរូវរានវិវត្តន៍ពៅ មុខកាន់

តតេិពសសក្នចុងការបពគមើការងារ�ូនពលាកអ្នកជាមរួយមុខងារ និង្រុេសម្បត្តិរបស់វា ពនាះ្រឺ Microsoft Office 2013។ ជាងពនះ ពៅពទៀតពដើម្បី

ឲ្យកាន់តតជាក់ច្បាស់ថាវាមានអវីតបលែកចំពោះការបងា្្ញខលែលួនថ្មីពនះ សូមព្វើការតាមដានទាំងអស់គ្្។

Microsoft Office 2013 ?
ត�ើមានអ្វីប្លែកសម្មា្់
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 ពនះ្រឺជាសារៈគបពោ�ន៍មរួយនន Micro-

soft Office 2013 តដលដំពេើការគ្រប់វិ្ី 

តាមតតអាចព្វើរាន។ 

 សគមាប់វាពនះ្រឺមានភាេល្អពគចើននូវមូល

ដា្្នរបស់ Office 2013។ គ្រប់ឯកសាររបស់

ពលាកអ្នកសវ័យគបវត្តិចំពោះការ Save ពៅកាន់ 

SkyDrive folder ពៅពលើ Desktop មានន័យ

ថាពលាកអ្នកអាចចូលពៅកាន់េរួកវាេីឧបករេ៍

នានារបស់ពលាកអ្នក។ ពលើសេី ពនះ 

ពលាកអ្នកអាច Send ពគរៅ Link ពដាយផ្្ល់ េី 

SkyDrive ពេលតដលកំេត់កគមិតននការ   

តកតគបសិទ្ធពៅពេលពលាកអ្នកគតរូវការ  Share 

ឯកសារ (Document) ជាមរួយមិត្តភ័ត្ត និងអ្នក    

ររួមការងារ។ គបសិនពបើមនុស្សតដលពលាកអ្នក 

Send ពៅមិនមាន Office 2013 វាមិនមានជា 

បញ្្ពនាះពទ។  ពដាយគគន់តតចុចម្តងពៅពលើ 

Link ខេៈពនាះវាពបើកព�ើងនូវ Browser 

(Online) សគមាប់វាពដើម្បីអានរានភា្្មៗ។

 វាពមើលពៅមានអារម្មេ៍ថាមានភាេដឹកនាំ

ចំពោះវិ្ីសាសស្ត ររួមជាមរួយការផ្្ស់ប្តតូរចំពោះ 

ោក្យ។ (ពតើមានចំនរួនពគចើនប៉ុោ្្តដលអាចឲ្យ   

ចំនរួនមរួយបតនថែមពៅកាន់ការពគ�ើសពរើសេ័ត៌មាន

ោក្យពៅចុងបញ្ប់ក្នចុងមរួយនថងៃ?) Office 15 ឬ 

2013 អាចេឹងោក់ជាមរួយនាម (Nomencla-

ture) តដលពលាកអ្នកចូលចិត្តរក្សាទុកគទង់ 

គទាយ Ribbon Style ររួមជាមរួយ File View      

គបពភទការពគ�ើសពរើសការគតដាងមកពគរៅនីមរួយៗ 

ឆលែងកាត់ពអគកង់ ដូចពលាកអ្នកចុចពៅពលើគ្រប ់

Tab។ វាមានមកជាមរួយ Layout Preview និង 

Share ជាកតនលែងតដលវតថែចុចាប់ពផ្តើមពដើម្បីទទរួល 

រានការចាប់អារម្មេ៍។

 គគន់តតចុចពៅពលើ View tab ររួចពហើយ 

ពលាកអ្នកនឹងព�ើញតារាង Read Mode ដំបូង 

បនា្្ប់មក នឹងព�ើញជាបន្តបនា្្ប់គ្រប់ការ បងា្្ញ 

ពផ្សងៗតាម្ម្មតា។ Read Mode ដំពេើរការ 

ដូចជាពស្តចនន Slide Show េីទំេ័ររបស់ពលាក អ្នក 

ររួចវាព្វើការបំតបកអតថែបទរបស់ពលាកអ្នកពៅ ក្នចុង 

Column ពដាយសវ័យគបវត្តពដើម្បីផ្តល់ឲ្យវាពមើល

ពៅមិន្ររួរឲ្យព�ឿ។ វាមានភាេងាយគសរួល 

អានោ៉្ងេិតគរាកដ។

 មរួយក្នចុងចំពោមមុខងារ Read Mode 

ពលាកអ្នកអាច double click ពៅពលើ Object 

តដលរានបញ្តូល។  ដូពច្នះ ដូចជា Table Chart-

But រូបភាេ និងវើពដអ ូឥ�តូវព្វើការបំតបកចំពោះ

ការបិទឲ្យមានទំហំពេញពអគកង់ពៅពលើតគមរូវការ 

និងអនុញ្្តមិនគតឹមតតការបងា្្ញ េរួកវាពនាះពទ 

ប៉ុតន្តអាចព្វើអន្តរកម្មជាមរួយេរួកវាក្នចុងបញ្្ទំនាក់

ទំនងននភាេយន្ត។

 ជាមរួយ SkyDrive តដលមានពៅក្នចុង 

helm ដូចជាចំេុចននការរក្សាទុកការបពងកើតនូវ 

្រំនិតពនះ្រឺសគមាប ់ Resume នូវការអានរបស់

ឯកសាររបស់ពលាកអ្នកពៅពលើទំហំថ្មី។ វាមិន      

គតឹមតតអាចឲ្យពលាកអ្នកទាញយកេីកតនលែងតដល

ពលាកអ្នករានចាកពចញពនាះពទ ប៉ុតន្តពលាកអ្នក

អាចព្វ ើអញ្ ឹងពដាយឆលែងកាត់ឧបករេ៍មរួយ 

ចំនរួន។ Open Word តដលមានពៅពលើ Win-

dows Phone ្រឺសគមាប់ពេល ពលាកអ្នកពចញ

ពៅខាងពគរៅផ្ះតដលអាចឲ្យពលាកអ្នកអានបន្ត 

រាន។

 ពតើអាចព្វើសហគបតិបត្តិការពៅពលើឯកសារ

រានតដរឬពទ? ឥ�តូវ Word 2013 ផ្តល់ឲ្យពលាក 

អ្នកនូវលទ្ធភាេននការគត�ប់ someone else’s 

hard work ពៅក្នចុងការគបមរួលផ្តចុនំនការេិភាក្សា 

គ្្។ ចុចក្នចុង Margin របស់ឯកសារ បនា្្ប់មក 

ពលាកអ្នកបតនថែមនូវ Comment។ ចុចពៅពលើ 

Comment របស់មនុស្សមា្្ក់ពផ្សងពទៀតបនា្្ប់ 

មកពលាកអ្នកអាច Reply ពៅកាន់វាក្នចុងការេិភាក្សា 

តបបបោ្្ញសារពអ�ិចគតរូនិច។

ភភភភ ភាពទូទៅរបស ់Office 2013  :

Cloud syncing:

Word 2013:

Object Zoom:

វិធីនៃការអាៃៈ

ការអាៃបៃ្ៈ

ការណែនាំ ៃិងទ្លើយតបៈ
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 សគមាប់�ំនាន់ថ្មីននកម្មវិ្ី Word មានន័យថាវាមាន Template 

ថ្មីពដើម្បីពគបើគរាស់។ តាមរយ ៈការបិទកម្មវិ្ីវានឹងផ្តល់ឲ្យពលាកអ្នកនូវ Blog 

Post, Annual Report, Family Photo Calendar, Sports Cer-

tificate, Wedding Invitation និង Host of other pre-set de-

signs ពដើម្បីផ្តល់ឲ្យពលាកអ្នកនូវការចាប់ពផ្តើមេីខាងពដើមពៅពលើពគគងការ

ពលាកអ្នក។

 វាមានភាេេិពសសតដលជាតគមរូវការពៅពលើគបេ័ន្ធរបស់ពលាកអ្នក 

ជាេិពសសគបសិនពបើ PDF ឋិតពៅក្នចុងបញ្្ ពហើយបញ្្ពនាះ្រឺជាកញ្ប់ 

រូបភាេ ប៉ុតន្ត Word 2013 នឹងអនុញ្្តឲ្យពលាកអ្នកពបើក និងបង្្ាញ 

ឯកសារ PDF គេមទាំងអាចតកតគមរូវ (Edit) េរួកវារានោ៉្ងល្អតដលេិតជា

បងា្្ញឲ្យព�ើញចំពោះលក្ខេៈខុសចំនុចនន PDF ក្នចុងទីតាំងដំបូងប៉ុតន្ត 

ពលាកអ្នកអាចពគបើគរាស់រានរាន្ម្មតា។

Templates ៃិង Tools: ការណែសម្រួល PDF: 
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 សគមាប់�ំនាន់ថ្មីននកម្មវិ្ី Word មានន័យថាវាមាន Template 

ថ្មីពដើម្បីពគបើគរាស់។ តាមរយ ៈការបិទកម្មវិ្ីវានឹងផ្តល់ឲ្យពលាកអ្នកនូវ Blog 

Post, Annual Report, Family Photo Calendar, Sports Cer-

tificate, Wedding Invitation និង Host of other pre-set de-

signs ពដើម្បីផ្តល់ឲ្យពលាកអ្នកនូវការចាប់ពផ្តើមេីខាងពដើមពៅពលើពគគងការ

ពលាកអ្នក។

 វាមានភាេេិពសសតដលជាតគមរូវការពៅពលើគបេ័ន្ធរបស់ពលាកអ្នក 

ជាេិពសសគបសិនពបើ PDF ឋិតពៅក្នចុងបញ្្ ពហើយបញ្្ពនាះ្រឺជាកញ្ប់ 

រូបភាេ ប៉ុតន្ត Word 2013 នឹងអនុញ្្តឲ្យពលាកអ្នកពបើក និងបង្្ាញ 

ឯកសារ PDF គេមទាំងអាចតកតគមរូវ (Edit) េរួកវារានោ៉្ងល្អតដលេិតជា

បងា្្ញឲ្យព�ើញចំពោះលក្ខេៈខុសចំនុចនន PDF ក្នចុងទីតាំងដំបូងប៉ុតន្ត 

ពលាកអ្នកអាចពគបើគរាស់រានរាន្ម្មតា។

Templates ៃិង Tools: ការណែសម្រួល PDF: 

IT City Magazine
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Toll Tip
រប�ៀ�ប្�ើ្រាស់ Compression Files ឬ Folder

ក្នុង Windows បោយមិនប្�ើ្រាស់កម្មវិធី�ននថែម

រប�ៀ��បងកើតឲ្យកុំព្យូទ័រ Shut Down បោយ

ស្័យ្�វតិ្តបៅបពល បោកអ្កមិនប្�ើ្រាស់

រប�ៀ��បងកើត�៊ូតុង Shutdown / Restart / Lock Icons 

ក្នុង Windows បោយខ្លួនឯង

រប�ៀ��ិទ Power Management ក្នុង Windows 7
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 ជាការពិតរាល់ពពលពោកអ្នកចង់ Zip Files គឺតតងតតបញ្ចូលកម្មវិធីបត្ថែមព�ើម្បី Zip Files ទំ្ងពោះ។ ក៏ប៉ុត្តែពៅក្ននុង Windows ត�លពោកអ្នកកំ

ពុងព្បើ្រាស់រាល់ថ្ងៃក៏អាច Zip Files រា្ត�រ។  NTFS Compression វាអាចពធវើឲ្យ Files របស់ពោកអ្នក មា្ទំហំតូចពៅពលើ Hard Drive។ ម្យ៉្ងពទៀត 

ពោកអ្នកអាច �ំព�ើរការ  ្ិងព្បើ្រាស់ Fiels តាមធម្មតា ពហើយមិ្ចាំរាច់ពធវើការ  Unzip ពទ។

 បោ្្ប់ចុចពលើ Advanced ប៊ូតុង 

 ប ត្ែពទៀតដាក់ធីកពលើពាក្យ Compress contents to save disk 

space រួចចុច OK ប៊ូតុងពីរ�ង។

 ព�ើម្បីចាប់ព្តែើម�ំបូងពោកអ្នក្តរូវចុច Mouse ខាងស្្ំពលើ Files, 

Folder ឬ Drive ត�លពោកអ្នកចង់ Compress ពហើយ ព្រើសយកពាក្យ 

Properties។

 

រប�ៀ�ប្�ើ្រាស់ Compression Files 

  ឬ Folder ក្នុង Windows 

   បោយមិនប្�ើ្រាស់កម្មវិធី�ននថែម
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 ជាការពិតរាល់ពពលពោកអ្នកចង់ Zip Files គឺតតងតតបញ្ចូលកម្មវិធីបត្ថែមព�ើម្បី Zip Files ទំ្ងពោះ។ ក៏ប៉ុត្តែពៅក្ននុង Windows ត�លពោកអ្នកកំ

ពុងព្បើ្រាស់រាល់ថ្ងៃក៏អាច Zip Files រា្ត�រ។  NTFS Compression វាអាចពធវើឲ្យ Files របស់ពោកអ្នក មា្ទំហំតូចពៅពលើ Hard Drive។ ម្យ៉្ងពទៀត 

ពោកអ្នកអាច �ំព�ើរការ  ្ិងព្បើ្រាស់ Fiels តាមធម្មតា ពហើយមិ្ចាំរាច់ពធវើការ  Unzip ពទ។

 បោ្្ប់ចុចពលើ Advanced ប៊ូតុង 

 ប ត្ែពទៀតដាក់ធីកពលើពាក្យ Compress contents to save disk 

space រួចចុច OK ប៊ូតុងពីរ�ង។

 ព�ើម្បីចាប់ព្តែើម�ំបូងពោកអ្នក្តរូវចុច Mouse ខាងស្្ំពលើ Files, 

Folder ឬ Drive ត�លពោកអ្នកចង់ Compress ពហើយ ព្រើសយកពាក្យ 

Properties។

 

រប�ៀ�ប្�ើ្រាស់ Compression Files 

  ឬ Folder ក្នុង Windows 

   បោយមិនប្�ើ្រាស់កម្មវិធី�ននថែម
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 ្បសិ្ពបើពោកអ្នកដាក់ Compression ស្មាប់ Folder ពោះ 

Windows បង្្ញសរសួរពោកអ្នក: Ask you whether you also 

want to encrypt subfolders and files ពហើយចុច OK ប៉ូងតុង។

 ស្មាប់ឧទហរ�៍ព្ះពយើង Compress ពលើ Folder មួយជា 

្បពេទ Text Files ត�លទំហំព�ើមរបស់វាគឺ 356 KB ព្កាយពពល    

Compress គឺ 255 KB វាអាចកាត់ប ថ្ែយទំហំថ្ files ពោះរា្ 40% ។

  

 ស្មាប់ Folder ឬ Files ត�លរា្ Compress គឺវាបតែចូរព្ម្ះ 

របស់វាមកជាព�៌ព�ៀវក្ននុង Windows Explorer។

 ពហើយពៅពពលណាមួយពោកអ្នកចង់ Uncompress មក វិញ្រា្់ 

តតចូលពៅកា្់ Advanced attributes រួចពដាះធីកពចញពីពាក្យ     

Compress contents to save disk space ជាការព្សច៕
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 ពដាយតែកចំពពាះការព្បើ្ រាស់ជាមួយ Windows រាល់ថ ង្ៃពោកអ្នក 

្បតហលជាមិ្រា្�ឹងពទថាពៅពលើ Windows ក៏អាច កំ�ត់ឲ្យវា�ំព�ើរ 

ការ Restart ឬ Shutdown ពដាយសវវ័យ្បវតតែិ រា្ត�រ។  ព្ពាះថាព្ះក៏

ជាវិធីសសស្្មួយត�លរួយស្មរួល�ល់ ការព្បើ្រាស់របស់ ្ិងកាត់ប្ថែយ

ពពលពវោពោកអ្នក្ងត�រ។  ខាងព្កាយព្ះជាការបង្្ញពីរពបៀបកំ�ត់ 

ឲ្យ  Shutdown ពដាយ សវវ័យ្បតតែិតាមរយៈ Task Scheduler។ 

 ពោកអ្នក្តរូវចូលពៅកា្់ Start ប៊ូងតុងពហើយវាបញ្ចូលពាក្យ Task 

Scheduler ក្ននុង្បអប់ Search។ បោ្្ប់មកផំ្្ងរបស់ Task Scheduler 

ពែើង រួចពមើលពៅត្្នកខាងស្្ំព្រើសយកពាក្យ  Create Task។

 ឥែចូវត្មរូវឲ្យពោកអ្នកដាក់ព ម្្ះឲ្យ Task ។

 ជាប្តែចូលពៅ Triggers Tab ចុចពលើ Click New ប៊ូតុង បោ្្ប់ 

កំ�ត់ Schedule ឲ្យវា។

 ប្តែពៅ Actions Tab ចុច Click New ប៊ ូតុង រ ួចបញ្ ចូលពាក្យ   

Shutdown ពៅក្ននុង Program Box ពហើយវាយ /S ពៅក្ននុង Parame-

ters box។ ្បសិ្ពបើពោកអ្នកចង់ឲ្យវា Force Shutdown ពហើយបិទ

្ូវកម្មវិធីពោកអ្នកពោកអាចព្បើ /S /F។

រប�ៀ��បងកើតឲ្យកុំព្យូទ័រ Shut Down 
  បោយស្័យ្�វតិ្តបៅបពល 

   បោកអ្កមិនប្�ើ្រាស់
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 ពដាយតែកចំពពាះការព្បើ្ រាស់ជាមួយ Windows រាល់ថ ង្ៃពោកអ្នក 

្បតហលជាមិ្រា្�ឹងពទថាពៅពលើ Windows ក៏អាច កំ�ត់ឲ្យវា�ំព�ើរ 

ការ Restart ឬ Shutdown ពដាយសវវ័យ្បវតតែិ រា្ត�រ។  ព្ពាះថាព្ះក៏

ជាវិធីសសស្្មួយត�លរួយស្មរួល�ល់ ការព្បើ្រាស់របស់ ្ិងកាត់ប្ថែយ

ពពលពវោពោកអ្នក្ងត�រ។  ខាងព្កាយព្ះជាការបង្្ញពីរពបៀបកំ�ត់ 

ឲ្យ  Shutdown ពដាយ សវវ័យ្បតតែិតាមរយៈ Task Scheduler។ 

 ពោកអ្នក្តរូវចូលពៅកា្់ Start ប៊ូងតុងពហើយវាបញ្ចូលពាក្យ Task 

Scheduler ក្ននុង្បអប់ Search។ បោ្្ប់មកផំ្្ងរបស់ Task Scheduler 

ពែើង រួចពមើលពៅត្្នកខាងស្្ំព្រើសយកពាក្យ  Create Task។

 ឥែចូវត្មរូវឲ្យពោកអ្នកដាក់ព ម្្ះឲ្យ Task ។

 ជាប្តែចូលពៅ Triggers Tab ចុចពលើ Click New ប៊ូតុង បោ្្ប់ 

កំ�ត់ Schedule ឲ្យវា។

 ប្តែពៅ Actions Tab ចុច Click New ប៊ ូតុង រ ួចបញ្ ចូលពាក្យ   

Shutdown ពៅក្ននុង Program Box ពហើយវាយ /S ពៅក្ននុង Parame-

ters box។ ្បសិ្ពបើពោកអ្នកចង់ឲ្យវា Force Shutdown ពហើយបិទ

្ូវកម្មវិធីពោកអ្នកពោកអាចព្បើ /S /F។

រប�ៀ��បងកើតឲ្យកុំព្យូទ័រ Shut Down 
  បោយស្័យ្�វតិ្តបៅបពល 

   បោកអ្កមិនប្�ើ្រាស់
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 បោ្្ប់មកពទៀតចុចពលើ Conditions Tab ្តង់ចំ្ុចព្ះពោកអ្នក 

្តរូវកំ�ត់ស្មាប់ការបញ្ប់ Task ក្ននុងករ�ីពោកអ្នកចង់ប្តែព្បើ្រាស់      

កុំព្យចូទវ័រប្តែ្បសិ្ពបើពោកអ្នកមិ្ចង់ព្បើប្តែវា្ឹង �ំព�ើរការពដាយសវវ័យ  

្បវតតែិតាមរយៈពពលត�លរា្កំ�ត់ឲ្យវា។

រប�ៀ��បងកើត�៊ូតុង 

  Shutdown / Restart / Lock Icons 
   ក្នុង Windown បោយខ្លួនឯង

 ចំត�ក្តង់ Settings tab គឺពោកអ្នកអាចកំ�ត់ឲ្យវា Resart 

Task រាល់ 30 ោទីមតែង ពរ្ៀសវាងពៅពពល Task មិ្ �ំព�ើរការ។

 ពោកអ្នក្ឹងទទួលរា្ការ Shutdown ពដាយសវវ័យ្បវតតែិ 

តាមរយៈពពលកំ�ត់៕

 ្បសិ្ពបើពោកអ្នកមិ្ចង់ព្បើ្រាស់ជាមួយប៊ូតុង Shutdown / Restart / Lock Icons ពលើ Windows ពោកអ្នកអាច បពងកើតវារា្ពដាយ�្លួ្អ្នក 

ផ្្ល់ ្ិងព្បើ្រាស់រា្យ៉្ងងយ្សួល ្ិងមិ្ចំោយពពលពវោយូរ។ 
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      rundll32.exe powrprof.dll,SetSuspendState 0,1,0

 ជាប្តែចុច Next រួចដាក់ព្ម្ះឲ្យ Shortcut ពោះ។

 

 ពហើយចុចប៊ូតុត Finish ព្កាយមកពោកអ្នកទទួលរា្ icon ្្មីមួយ 

្បសិ្ពបើយកចុចពីរ�ងពលើ icon វា្ឹង�ំព�ើរការពៅតាម Command 

ត�លរា្បញ្ចូលឲ្យ Shortcut។

 មួយវិញពទៀត្បសិ្ពបើពោកអ្នក្តរូវការផ្្ស់បតែចូរពលើរូប icon  ពោះគឺ 

្តរូវយក Mouse ដាក់ Select ពលើ icon ពោះរួចយក Properties 

 បោ្្ប់មកចុចពលើ Change Icon បូ៊តុង ពហើយពោកអ្នក្ឹង ព�ើញរូប 

icon ជាព្ចើ្ត�លមា្្សប់ក្ននុង Windows រួចព្រើស យក icon មួយ 

ណាត�លពោកអ្នកពពញចិតតែ ពហើយចុច Ok៕

 ជា�ំបូងចុច Mouse ខាងស្្ំពលើ Desktop ពហើយព្រើសយក ពាក្យ 

New --> Shortcut។ 

 ជាបោ្្ប់ផ្្ំងរបស់ Shortcut បង្្ញពែើង ចំត�កពៅក្ននុង្បអប់ 

ព្កាមពាក្យ Type the Location fo the item ្តរូវបញ្ចូល  Command 

ខាងព្កាមដាក់ក្ននុង្បអប់ពោះពៅតាម Shortcut ត�លបពងកើត។

 1.Shutdown Computer

      Shutdown.exe -s -t 00

 2.Restart Computer

      Shutdown.exe -r -t 00

 3.Lock Workstation

      Rundll32.exe User32.dll,LockWorkStation

 4.Hibernate Computer

      rundll32.exe PowrProf.dll,SetSuspendState

 5.Sleep Computer
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 ពៅពពលពោកអ្នកព្បើ្រាស់កុំព្យចូទវ័រគឺរាល់ពពលពោក អ្នកឈប់ព្បើ 

្រាស់វាប្តែិចគឺវាតតងតត Sleep ពដាយសវវ័យ្បវតតែិ ពហើយពពល�្ះពោក  

អ្នកក៏មា្ការធ្់្ទ្់ត�រ។ �ូពច្នះព�ើម្បី្សយ បញ្្ព្ះសូមពមើលការ  

បង្្ញ�ូចខាងព្កាម៖

 មុ្ចាប់ព្តែើមត្មរូវឲ្យពោកអ្នកចុចពលើ More Power icon

រប�ៀ��ិទ Power 
  Management 
   ក្នុង Windows 7

 ពហើយផ្្ំងរបស់ Power Options បង្្ញពែើង ចំត�កពៅ ព្កាម 

ពាក្យ “Additional plans” ្តរូវ Select ពលើ High Performance 

បោ្្ប់ចុច្តង់ “Change plan settings”។
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      rundll32.exe powrprof.dll,SetSuspendState 0,1,0

 ជាប្តែចុច Next រួចដាក់ព្ម្ះឲ្យ Shortcut ពោះ។

 

 ពហើយចុចប៊ូតុត Finish ព្កាយមកពោកអ្នកទទួលរា្ icon ្្មីមួយ 

្បសិ្ពបើយកចុចពីរ�ងពលើ icon វា្ឹង�ំព�ើរការពៅតាម Command 

ត�លរា្បញ្ចូលឲ្យ Shortcut។

 មួយវិញពទៀត្បសិ្ពបើពោកអ្នក្តរូវការផ្្ស់បតែចូរពលើរូប icon  ពោះគឺ 

្តរូវយក Mouse ដាក់ Select ពលើ icon ពោះរួចយក Properties 

 បោ្្ប់មកចុចពលើ Change Icon បូ៊តុង ពហើយពោកអ្នក្ឹង ព�ើញរូប 

icon ជាព្ចើ្ត�លមា្្សប់ក្ននុង Windows រួចព្រើស យក icon មួយ 

ណាត�លពោកអ្នកពពញចិតតែ ពហើយចុច Ok៕

 ជា�ំបូងចុច Mouse ខាងស្្ំពលើ Desktop ពហើយព្រើសយក ពាក្យ 

New --> Shortcut។ 

 ជាបោ្្ប់ផ្្ំងរបស់ Shortcut បង្្ញពែើង ចំត�កពៅក្ននុង្បអប់ 

ព្កាមពាក្យ Type the Location fo the item ្តរូវបញ្ចូល  Command 

ខាងព្កាមដាក់ក្ននុង្បអប់ពោះពៅតាម Shortcut ត�លបពងកើត។

 1.Shutdown Computer

      Shutdown.exe -s -t 00

 2.Restart Computer

      Shutdown.exe -r -t 00

 3.Lock Workstation

      Rundll32.exe User32.dll,LockWorkStation

 4.Hibernate Computer

      rundll32.exe PowrProf.dll,SetSuspendState

 5.Sleep Computer
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 ពៅពពលពោកអ្នកព្បើ្រាស់កុំព្យចូទវ័រគឺរាល់ពពលពោក អ្នកឈប់ព្បើ 

្រាស់វាប្តែិចគឺវាតតងតត Sleep ពដាយសវវ័យ្បវតតែិ ពហើយពពល�្ះពោក  

អ្នកក៏មា្ការធ្់្ទ្់ត�រ។ �ូពច្នះព�ើម្បី្សយ បញ្្ព្ះសូមពមើលការ  

បង្្ញ�ូចខាងព្កាម៖

 មុ្ចាប់ព្តែើមត្មរូវឲ្យពោកអ្នកចុចពលើ More Power icon

រប�ៀ��ិទ Power 
  Management 
   ក្នុង Windows 7

 ពហើយផ្្ំងរបស់ Power Options បង្្ញពែើង ចំត�កពៅ ព្កាម 

ពាក្យ “Additional plans” ្តរូវ Select ពលើ High Performance 

បោ្្ប់ចុច្តង់ “Change plan settings”។

 

 

 រីឯចំ្ុចព្កាម្តរូវផ្្ស់បតែចូរមកពាក្យ “Never” រួចចុច Save ប៊ូតុង ៕
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ទំហំ

18.9 MB

ប្រព័ន្ធដំណ�ើរការ

គ្រប់ Windows

ទីតាំងថតចម្លង

www.itcity.com.kh

រយៈណពលណប្រើបរាស់

បានរហូត

New Softwares

 TextAloud ជាកម្មវីធីដែលមួយមានមុខងារបំដបលែងឯកសារគបភេទអក្សរដែលភា្រភគរើនជា

ភាសា  អង់ភ្រលែស ភៅកាន់ឯកសារគបភេទសំភេងែូរជា (*.mp3) ជាភែើម។ ជាមួយនឹងកម្មវិធី 

ភនះផងដែលអារជួយសគមរួល និងផ្តល់ឲ្យអ្នកភគបើគបាស់នូវអត្ថគបភោជន៍ែ៏ភគរើនសន្ឹកសន្្ប់ជា

ពិភសស សិស្សានុសិស្ស ដែលរង់បភងកើតនូវឯកសារសភមលែងជាភាសាអង់ភ្រលែសននអត្ថបទរបស់ខលែលួន

ឯងផ្ទល់ភៅជាសភមលែង។ លក្ខណៈភគបើគបាស់វិញមានភាពងាយគសួលគរាន់ដតភធវើការរុរ Click 

ប៉ុភ្ណ្ះ៕

អត្ថប្រយោជន៍ដ៏យបរើនពី ឯកសារប្រយេទអក្សរយៅជាឯកសារសយ្លេង
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ទំហំ

18.9 MB

ប្រព័ន្ធដំណ�ើរការ

គ្រប់ Windows

ទីតាំងថតចម្លង

www.itcity.com.kh

រយៈណពលណប្រើបរាស់

បានរហូត

New Softwares

 TextAloud ជាកម្មវីធីដែលមួយមានមុខងារបំដបលែងឯកសារគបភេទអក្សរដែលភា្រភគរើនជា

ភាសា  អង់ភ្រលែស ភៅកាន់ឯកសារគបភេទសំភេងែូរជា (*.mp3) ជាភែើម។ ជាមួយនឹងកម្មវិធី 

ភនះផងដែលអារជួយសគមរួល និងផ្តល់ឲ្យអ្នកភគបើគបាស់នូវអត្ថគបភោជន៍ែ៏ភគរើនសន្ឹកសន្្ប់ជា

ពិភសស សិស្សានុសិស្ស ដែលរង់បភងកើតនូវឯកសារសភមលែងជាភាសាអង់ភ្រលែសននអត្ថបទរបស់ខលែលួន

ឯងផ្ទល់ភៅជាសភមលែង។ លក្ខណៈភគបើគបាស់វិញមានភាពងាយគសួលគរាន់ដតភធវើការរុរ Click 

ប៉ុភ្ណ្ះ៕

អត្ថប្រយោជន៍ដ៏យបរើនពី ឯកសារប្រយេទអក្សរយៅជាឯកសារសយ្លេង
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 Sound Normalizer ្រឺជាកម្មវិធីមួយដែលជួយ និងបភងកើននូវកគមិតសភំេងរបស់ឯកសារ 

គបភេទតនន្តី ែូរជា Mp3 និង Wav files ជាភែើម។ ែំភណើរការភគបើគបាស់ ្រឺមាននូវមុខងារជាភគរើន

សគមាប់ជាតគមរូវការ ែូរជាមុខងារបភងកើនសំភេងភោយសវវ័យគបវត្ត និង មុខងារសាកល្បងនូវរងា្្ក់ 

ភេលែងដែលបានដកដគបរួរ។ មិនគតឹមដតប៉ុភ្ណ្ះ Sound Normalizer បានភធវើការ បដន្ថមនូវ ID3 

និង RMS normalization ភៅភលើឯកសារតនន្តីដែលបានយកមកដកដគបទាំងភនះភទៀតផង៕

 ែំភ្ះគសាយែ៏ល្អគបភសើរសគមាប់ការបំដបលែងគបភេទឯកសារ វីភែអូជាមួយនឹងមុខងារថ្មី 

របស់ VSO Blu-ray Converter Ultimate ដែលកម្មវិធីភនះផ្្ល់ អារភធវើការបំដបលែងនូវរាល់ 

ឯកសារ Blu-ray វីភែអូ ឬ AVCHD structure (ជាឯកសារវីភែអូដែលបានមកពីឧបករណ៏ 

សគមាប់ថតែូរជា Canon, sony, samsung ...)ភៅកាន់ DVD file វីភែអូ ឬភៅកាន់ឯកសារ   

វីភែអូភផ្សងៗជាភគរើនភទៀតជាភគរើនដែលសគមាប់ោក់ឲ្យែំភណើរការ Play ភលើឧបករណ៍ទំភនើបៗន 

ភពលបរ្ចុប្បន្នជាភែើមែូរជា PS3, XBOX360, DivX home player, iPod, iPhone, iPad 

ជាភែើម។

	 phpDesigner ជាកម្មវិធីដែលជួយសគមរួលែល់អ្នកសរភសរកូែ (Programmer)	 ភៅ 

ភលើភាសាមួយរំនួនែូរជា PHP IDE , PHP ជាមួយ HTML5, CSS3, javascript ភោយ 

ភាពបុិនគបសប់ែំភណើរការភលឿន ឆ្្តនវ និងរំភណញភពលភវលា។ ជាមួយកម្មវិធីភនះដែល ្រឺបាន 

រួមបញ្ជូលនូវមុខងារថ្មីៗសគមាប់ជាតគមរូវការអេិវឌ្ឍនូវភាសារកូែរបស់ Developers	។ ភលើសពី 

ភនះភៅភទៀត មិនគតឹមដតអារសរភសរបាន ដថមទាំងអារភធវើការវិភា្រ (analyzing) និង Run កូែ 

(debugging) ជាមួយភ្រហទំពវ័រដែលបភងកើតភេើងពីការសរភសរ PHP, HTML5, CSS3, ja-

vascript	 និង ភាសាកូែែ៏នទភផ្សងភទៀតទាំងភនះ។ ចាប់ភផ្តើមបភងកើតភ្រហទំពវ័រ ឬកម្មវិធី 	web 

apps	 របស់ភលាកអ្នកចាប់ពីឥេជូវជាមួយ phpDesigner	ជំនន់ថ្មី៕

ទំហំ
23 MB

គបពវ័ន្ែំភណើរការ
គ្រប់ Windows

ទីតាំងថតរមលែង
www.itcity.com.kh

រយៈភពលភគបើគបាស់
បានរហូត

ទំហំ
27.6 MB

គបពវ័ន្ែំភណើរការ
គ្រប់ Windows

ទីតាំងថតរមលែង
www.itcity.com.kh

រយៈភពលភគបើគបាស់
បានរហូត

ទំហំ
6 MB

គបពវ័ន្ែំភណើរការ
Mac OS X

ទីតាំងថតរមលែង
www.itcity.com.kh

រយៈភពលភគបើគបាស់
បានរហូត

ដកពិយសាធន៍ជា្ួយស្ត្ថភាពថ្ីយ�ើប្រយេទឯកសារតនន្ី

ប្រលេកៗជា្ួយ Blu-ray វីយដអូ

ដំយោះបសាយដ៏�្អសបរា្រ់ PHP កូដ
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 គបពវ័ន្ែំភណើរការ Microsoft Windows 8 បានបភងកើតភេើងសគមាប់តគមរូវការអ្នកភគបើគបាស់បា

នទូរភៅភៅគ្រប់មជ្ឈោ្្ន និងគ្រប់ទីកដនលែង ប៉ុដន្តអវីដែលជារំណុរ្រួរឲ្យចាប់អារម្មណ៍ភៅភលើ Win-

dows 8 ភនះ្រឺមិនមាននូវ Start ប៊ូតុងែូរជា ជំនន់មុនរបស់ Microsoft Windows ភទែូរជា 

xp ឬ 7 ភនះភទ។  ជួបជាមួយ Startdock Start8 ជំនន់ 1.1 បានបភងកើតភេើង និងអារភធវើឲ្យ 

គបពវ័ន្ែំភណើរការ Windows 8 មាននូវ Start ប៊ូតុងភេើងវិញ ភែើម្បីផ្តល់នូវភាពងាយគសួល 

ក្នចុងការភគបើគបាស់។ ចាប់ភផ្តើមនថងៃភនះទាំងអស់រា្្ជាមួយនឹង Start ប៊ូតុងភៅភលើគបពវ័ន្ែំភណើរការ 

Microsoft Windows 8 របស់ភលាកអ្នក៕

 Winzip ្រឺជាកម្មវិធីមួយគបភេទដែលផ្តល់ឲ្យអ្នកភគបើគបាស់នូវ វិធីសានស្តែ៏ល្អបំផុតភៅភលើការ 

បគងរួម (Compress) ឬ ពន្្ (Extract) ឯកសារទិន្ននវ័យភផ្សងៗែូរជា ឯកសារ រភគមៀង វីភែអូ 

ឬ ឯកសារសំខាន់ៗែ៏នទភផ្សងភទៀត។ ជាមួយជំនន់ថ្មីរបស់ Winzip 17 ភនះបានសិក្សាបភងកើតភេើង 

ផ្តល់នូវភាពងាយក្នចុងការគសួលភគបើគបាស់ និងមានសុវត្ថភាពខ្ពស់ភៅភលើឯកសារ ភគរះវាបានបដន្ថម 

នូវគបពវ័ន្សុវត្ថិភាព AES encryption។ ភោយដេកកម្មវិធីភនះដែរមិនគតឹមដតភគបើបានជាមួយ 

គបភេទឯកសារ (*.zip) ប៉ុភ្ណ្ះភទ ដតផ្ទចុយភៅវិញវាអារ Support ជាមួយគបភេទឯកសារ 

គបភេទ (Compress) ែ៏នទភផ្សងភទៀតែូរជា Zip, Zipx, RAR, 7Z, BZ2, LHA, CAB, IMG, 

ISO និង ឯកសារទាក់ទង់ភផ្សងភទៀតជាភគរើន៕

 អស់កងវល់ភៅភលើ Driver VGA (Video Graphics Array) ោរ់គបភេទ ATI Catalyst 

Display ភៅភលើម្៉ាសុីនកំុព្យជូទវ័ររបស់ភលាកអ្នកភទៀតភៅ ជួបជាមួយែំភ្ះគសាយែ៏គបភសើរសគមាប់

ភលាកអ្នក្រឺ កម្មវិធីដែលបភងកើតភេើងភោយគកុមហ៊ុន ATI មានភ្ម្ះថា ATI Catalyst Display 

Driver ជំនន់ 13.3 មានសមត្ថភាពបំភពញនូវកងវះខាត់ Driver VGA ដែលមិនសា្្ល់ 

ឲ្យមានសភាពគបគកតីភេើងវិញ ។ បដន្ថមពីភនះភទៀតភនះ ATI Driver ភនះែំភណើរការ Support 

ជាមួយភសរី (VGA ATI Radeon HD) ជំនន់ថ្មីែូរជា AMD Radeon HD 7900 , HD 

7700, HD 7300, HD 6900, HD 6800, HD 6600, HD 6500, HD 6550D, HD 

6530D និងមានគបមាណជាង 50 Series ភផ្សងភទៀត។ អារភគបើបានជាមួយ Driver 

ភនះគបពវ័ន្ែំភណើរការ Microsoft Windows Vista/7/8 32bit/64bit៕

ទំហំ

94.7 MB

គបពវ័ន្ែំភណើរការ

គ្រប់ Windows

ទីតាំងថតរមលែង

www.itcity.com.kh

រយៈភពលភគបើគបាស់
បានរហូត

ទំហំ

47.3 MB

គបពវ័ន្ែំភណើរការ
គ្រប់ Windows

ទីតាំងថតរមលែង
www.itcity.com.kh

រយៈភពលភគបើគបាស់
បានរហូត

ទំហំ
5 MB

គបពវ័ន្ែំភណើរការ
គ្រប់ Windows

ទីតាំងថតរមលែង
www.itcity.com.kh

រយៈភពលភគបើគបាស់
បានរហូត

វិ�បតឡ្រ់្កវិញសារជាថ្ីនូវ Start ្រ៊ូតុងសបរា្រ់ Windows8

ជយប្ើសដ៏�្អសបរា្រ់ Compress ឯកសារទិន្នន័យ
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 គបពវ័ន្ែំភណើរការ Microsoft Windows 8 បានបភងកើតភេើងសគមាប់តគមរូវការអ្នកភគបើគបាស់បា

នទូរភៅភៅគ្រប់មជ្ឈោ្្ន និងគ្រប់ទីកដនលែង ប៉ុដន្តអវីដែលជារំណុរ្រួរឲ្យចាប់អារម្មណ៍ភៅភលើ Win-

dows 8 ភនះ្រឺមិនមាននូវ Start ប៊ូតុងែូរជា ជំនន់មុនរបស់ Microsoft Windows ភទែូរជា 

xp ឬ 7 ភនះភទ។  ជួបជាមួយ Startdock Start8 ជំនន់ 1.1 បានបភងកើតភេើង និងអារភធវើឲ្យ 

គបពវ័ន្ែំភណើរការ Windows 8 មាននូវ Start ប៊ូតុងភេើងវិញ ភែើម្បីផ្តល់នូវភាពងាយគសួល 

ក្នចុងការភគបើគបាស់។ ចាប់ភផ្តើមនថងៃភនះទាំងអស់រា្្ជាមួយនឹង Start ប៊ូតុងភៅភលើគបពវ័ន្ែំភណើរការ 

Microsoft Windows 8 របស់ភលាកអ្នក៕

 Winzip ្រឺជាកម្មវិធីមួយគបភេទដែលផ្តល់ឲ្យអ្នកភគបើគបាស់នូវ វិធីសានស្តែ៏ល្អបំផុតភៅភលើការ 

បគងរួម (Compress) ឬ ពន្្ (Extract) ឯកសារទិន្ននវ័យភផ្សងៗែូរជា ឯកសារ រភគមៀង វីភែអូ 

ឬ ឯកសារសំខាន់ៗែ៏នទភផ្សងភទៀត។ ជាមួយជំនន់ថ្មីរបស់ Winzip 17 ភនះបានសិក្សាបភងកើតភេើង 

ផ្តល់នូវភាពងាយក្នចុងការគសួលភគបើគបាស់ និងមានសុវត្ថភាពខ្ពស់ភៅភលើឯកសារ ភគរះវាបានបដន្ថម 

នូវគបពវ័ន្សុវត្ថិភាព AES encryption។ ភោយដេកកម្មវិធីភនះដែរមិនគតឹមដតភគបើបានជាមួយ 

គបភេទឯកសារ (*.zip) ប៉ុភ្ណ្ះភទ ដតផ្ទចុយភៅវិញវាអារ Support ជាមួយគបភេទឯកសារ 

គបភេទ (Compress) ែ៏នទភផ្សងភទៀតែូរជា Zip, Zipx, RAR, 7Z, BZ2, LHA, CAB, IMG, 

ISO និង ឯកសារទាក់ទង់ភផ្សងភទៀតជាភគរើន៕

 អស់កងវល់ភៅភលើ Driver VGA (Video Graphics Array) ោរ់គបភេទ ATI Catalyst 

Display ភៅភលើម្៉ាសុីនកំុព្យជូទវ័ររបស់ភលាកអ្នកភទៀតភៅ ជួបជាមួយែំភ្ះគសាយែ៏គបភសើរសគមាប់

ភលាកអ្នក្រឺ កម្មវិធីដែលបភងកើតភេើងភោយគកុមហ៊ុន ATI មានភ្ម្ះថា ATI Catalyst Display 

Driver ជំនន់ 13.3 មានសមត្ថភាពបំភពញនូវកងវះខាត់ Driver VGA ដែលមិនសា្្ល់ 

ឲ្យមានសភាពគបគកតីភេើងវិញ ។ បដន្ថមពីភនះភទៀតភនះ ATI Driver ភនះែំភណើរការ Support 

ជាមួយភសរី (VGA ATI Radeon HD) ជំនន់ថ្មីែូរជា AMD Radeon HD 7900 , HD 

7700, HD 7300, HD 6900, HD 6800, HD 6600, HD 6500, HD 6550D, HD 

6530D និងមានគបមាណជាង 50 Series ភផ្សងភទៀត។ អារភគបើបានជាមួយ Driver 

ភនះគបពវ័ន្ែំភណើរការ Microsoft Windows Vista/7/8 32bit/64bit៕

ទំហំ

94.7 MB

គបពវ័ន្ែំភណើរការ

គ្រប់ Windows

ទីតាំងថតរមលែង

www.itcity.com.kh

រយៈភពលភគបើគបាស់
បានរហូត

ទំហំ

47.3 MB

គបពវ័ន្ែំភណើរការ
គ្រប់ Windows

ទីតាំងថតរមលែង
www.itcity.com.kh

រយៈភពលភគបើគបាស់
បានរហូត

ទំហំ
5 MB

គបពវ័ន្ែំភណើរការ
គ្រប់ Windows

ទីតាំងថតរមលែង
www.itcity.com.kh

រយៈភពលភគបើគបាស់
បានរហូត

វិ�បតឡ្រ់្កវិញសារជាថ្ីនូវ Start ្រ៊ូតុងសបរា្រ់ Windows8

ជយប្ើសដ៏�្អសបរា្រ់ Compress ឯកសារទិន្នន័យ
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 CrossFTP ជាកម្មវិធីមួយគបភេទដែលបភងកើតភេើងក្នចុងភរាលបំណងផ្តល់ឲ្យអ្នកភគបើគបាស់នូវ 

មុខងារជាភគរើន ងាយគសួលទាក់ទងភៅនឹងដផ្នក Uploads ទិន្ននវ័យភផ្សងៗភៅកាន់ FTP Server ។   

ដផ្នកភៅភលើមុខងារសំខាន់មួយរំនួនរបស់កម្មវិធីភនះអារភគបើគបាស់បានជាមួយការតភា្្ប់ភៅកាន់ 

Server FTP ភគរើនបានក្នចុងភពលដតមួយ មិនគតឹមដតអារភគបើជាមួយនឹងគបពវ័ន្ែំភណើរការ Micro-

soft Windows បុ៉ភ ណ្ះ្ភទ ដថមទំាងអារភគបើគបាស់បានោ្៉ងទូលំទូលាយជាមួយគបពវ័ន្ែំភណើរការ 

ែ៏នទភផ្សងភទៀតែូរជា ពពួក OpenSource (Linux, unix, CentOS...) និងគបពវ័ន្ែំភណើរការ 

របស់គកុមហ៊ុន Apple ្រឺ mac os x ជាភែើម៕

 8StartButton ជាកម្មវិធីដតមួយដែលអារមានសមត្ថភាពខ្ពស់ដែលអារភៅឲ្យគតេប់ 

មកវិញនូវមុខងារ Start Menu ដែលរាម្នភៅភលើ Microsoft Windows 8 របស់ភលាកអ្នក 

ឲ្យគតេប់មក វិញភោយភាពបុិនគបសប់ និងឆ្្តវវ័យ។ លទ្ផលជាក់ដស្តងដែល 8StartButton 

អារភធវើបានភផ្សងភទៀតភនះ្ឺរ អនុញ្្តិឲ្យភលាកអ្នកភគបើគបាស់បានភគរើនភៅមុខងារទំាងអស់ែូរជា   

មានសិទ្ដកដគបផ្្ស់ប្តជូររូបភាពក៏ែូរជា Command ភផ្សងៗភៅភលើបូ៊តុងែូរជា turn off, restart 

ឬ lock off ភៅមា៉្សីុនកុំព្យជូទវ័រជាភែើម៕

ទំហំ

4.97 MB

គបពវ័ន្ែំភណើរការ

គ្រប់ Windows

ទីតាំងថតរមលែង

www.itcity.com.kh

រយៈភពលភគបើគបាស់

បានរហូត

ទំហំ

15  MB

គបពវ័ន្ែំភណើរការ

គ្រប់ Windows

ទីតាំងថតរមលែង

www.itcity.com.kh

រយៈភពលភគបើគបាស់

បានរហូត

ទំហំ
185 MB

គបពវ័ន្ែំភណើរការ
គ្រប់ Windows          

ទីតាំងថតរមលែង
www.itcity.com.kh

រយៈភពលភគបើគបាស់
បានរហូត

 Packet Tracer ្រឺជាកម្មវិធីពិភសសមួយដែលបភងកើតភេើងភោយគកុមហ៊ុនែ៏ល្បីល្បាញមួយ 

ដផ្នក Hardware ភៅប្្្គបភទសដប៉កអឺរ៉ុប ្រឺគកុមហ៊ុន Cisco។ និោយពីសមត្ថភាពរំភរះ 

កម្មវិធីភនះវិញអារជួសគមរួលភៅែល់រាល់ការ្រណនភលើទិន្ននវ័យ និងការ Config ភផ្សងៗដែលទាក់ 

ទងភៅនឹងផលិតផលទាំងអស់ដែលបភងកើតភោយគកុមហ៊ុន Cisco ផ្្ល់។ ភៅភលើការភគបើគបាស់នន
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	 សំណួរៈ	ជម្រាបសួរ!	ខ្ញំបាទឈ ម្ោះ	ឃុន	ផានិត	ដែលជាម្បិយមិត្តនន	

ទសោសនាវែ្តតីទតីម្្ុងពត៌រានវិទោយា។	 	 ខ្ញំរានសំនួរមួយសួរឈៅែល់បង	 សព្វន្ងៃ	

ឈនះខ្ញ ំរាន្ុំពោយូទ័រ	Laptop រា៉ោ្់	Sony ជាមួយនឹងម្បព័ន្ធែំឈណើរការ									

license (Windows 7 Home) ប៉ុដនថែឈោយពិបា្្្ញងការឈម្បើ	ម្បាស់ឈព្	

ខ្ញំ្៏បានយ្ឈៅឲោយឈេតឈមលើងម្បព័ន្ធែំឈណើរ្្តីេឺ	 Windows 7 Ultimate	

ដតរាល់ឈពលដែលខ្ញំចុចឈបើ្្ម្វិធតីយ្ម្ឈម្បើម្បាស់ម្តងៗវាដតងដតឈោត

ផា្ោំងមួយេឺឲោយខ្ញំចុច	Yes ឬ	No ។	ឈតើឈធ្វើយ៉ោងណា	ឈែើមោបតី្ុំឲោយឈោតផ្ាោំងឈនះ

ឈោតរំខានឈទៀតរាល់ឈពលឈបើ្្ម្វិធតីឈលើ្ឈម្កាយ?	 	 សូមបងជួយឈោះ	

ម្រាយខ្ញំផងឈោយ្្តតីអនុឈម្រះ៕	

	 ចឈមលើយៈ	 ជម្រាបសួរ	 នឹងអរេុណចំឈោះការេំម្ទរបស់	 ផានិត។	

សម្រាប់ម្បព័ន្ធែំឈណើរការ្្តី	 ដែលប្ូនយ្ឈៅឲោយឈេតឈមលើងឈនាះវាពិតជារាន	

ល្្ខណៈងាយម្សួលឈម្បើម្បាស់ជាងម្បព័ន្ធចាស់របស់ប្ូនឈម្បើម្បាស់ពតីមុន			

license (Windows 7 Home)	 ដែលរានភ្ោប់ម្ម្រាប់ជាមួយ្ុំពោយូទ័រ	

Laptop Sony ឈនាះ។		ចំឈោះម្បព័ន្ធែំឈណើរ	ការ្្តីឈនះដែលជា	Windows 7 

Ultimate វារាននូវមុខងារឈម្បើម្បាស់ឈម្ចើនជាងមុន។	ឈៅឈលើការឈម្បើម្បាស់	

ឈែើមោបតីមិនចង់ឲោយរានផា្ោំងរំខានឈនាះប្ូនអាចអនុវត្តតាម	 3 រឈបៀបឈផោសងៗរ្ោ	

ែូចខាងឈម្កាមៈ	 

 រឈបៀបទតី១ៈ	បិទតាមរយៈ	Action Center

 ែំបូងចូលឈៅកាន់	Start > Control Panel
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ឈៅ្្ញងផា្ោំង	Control Panel ចុចឈលើ	User Account

 ចុចឈលើោ្ោយ	Change User Account Control settings

	 ឈៅ្្ញងផា្ោំង	User Account Control Settings ឈម្បើ	Mouse 

ទាញ	  ែូចរូបខាងឈម្កាមឈៅែល់ចំណុច	Never notify រួចបន្តចុចប៊ូតុង	

OK ជាការម្រាច

 រឈបៀបទតី2ៈ	បិទតាមរយៈ	Windows Registry 

 តាមរឈបៀបទតី	 ២	 ឈម្បើនូវ	 Keyboard (Start+R) រួចវាយោ្ោយ	

gpedit.msc និងចុចប៊ូតុង	OK

 ឈៅ្្ញងផ្ាោងំ	Local Group Policy Editor ចូលឈៅកាន់	Computer 

Configuration > Windows Settings >Security Settings 

>Local Policies > Security Options រួចឈៅដផ្្ខាងរ្ាោមំ្តង់ចំណុច	

User Account Control ដែលរានពតីខាងមុខអាចដ្ដម្បបានតាមតម្មរូវការ។	

	 ចំណាំៈ	ឈៅរាល់ការដ្ដម្បរួចម្តរូវដត	Restart ្ុំពោយូទ័រ	

	 រឈបៀបទតី3ៈ	ចូលឈៅឈម្បើម្បាស់	User Account Built-in Admin-

istrator 

 ជាធម្តាឈៅឈពលដែលរា៉ោសុតីន្ុំពោយូទ័រដែលបានែំឈ�ើង្្តី	 និងឈពល				

ែំឈណើរការជិតចប់េឺសុទ្ធសឹងដតទាមទារឲោយវាយនូវបញូ្លនូវ	User Name	ឬ	

្៏ឈលខសរា្ោត់	 (Password) ជានិច្។	 ម្តង់ចំណុចឈនះឈ�ើយឈនាះេឺរាន	

ន័យថា		User Name ឬ្៏ឈលខសរា្ោត់ដែលឈយើងបានោ្់ឈនាះនឹងយ្ម

្ឈម្បើម្បាស់ជាល្្ខណៈទូរឈៅដតម្តងដែលរានសិទ្ធ	 (Member of ) ឈស្ើ	

នឹង	Administrator ដែរដតប៉ុឈណាណោះ	 ប៉ុដន្តមិនរានជា	User Account 

Buil-in ឈទ។	ែូចឈច្ះឈយើងេបោបតីឈម្បើម្បាស់	User Account Buil-in វិញ	

ឈទើបរាល់ការឈម្បើម្បាស់	ឬឈបើ្្ម្វិធតីឈផោសងៗមិនរានទាមទារ	Yes ឬ	No។	

ឈែើមោបតីផ្ាោស់ប្តរូ	Right+Click ឈលើ	Computer រួចឈម្ជើសយ្ោ ោ្យ	Manage 
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 រួចឈៅ្្ញងផា្ោំង	Computer Managerment ចូលឈៅកាន់	Local 

User and Group > Users

 

 ដផ្្ខាងរា្ោំ	Right+Click ឈលើ	Administrator Account Buil-

in ឈម្ជើសយ្	Properties  

 

 ឈៅ្្ញងផា្ោំង	 Administrator Porperties ម្តរូវឈោះធតី្ឈៅម្តង់	 

Account is disabled និងបន្តចុចប៊ូតុង	OK

 ចំដណ្ឯ	Account ដែលរាន	 (Member of) Administrator 

ដែលបឈងកើតឈ�ើងឈពល	Set up windows ្ ្តីឈនាះម្តរូវ	Right+Click យ្	

ោ្ោយ	Properties ែដែល

	 រួចឈៅ្្ញងផា្ោំង	Administrator Porperties ម្តរូវធតី្ម្តង់	ចំណុច	

Account is disabled ឈែើមោបតីបិទ	User Account ឈនះ	ឈប់ឈម្បើម្បាស់		

និងចុចប៊ូតុង	OK។	ចុងបញ្ជប់	Restart រា៉ោសុតីន្ុំពោយូទ័រជាការឈម្សច៕

IT City Magazine
www.itcity.com.kh74



 រួចឈៅ្្ញងផា្ោំង	Computer Managerment ចូលឈៅកាន់	Local 

User and Group > Users

 

 ដផ្្ខាងរា្ោំ	Right+Click ឈលើ	Administrator Account Buil-

in ឈម្ជើសយ្	Properties  

 

 ឈៅ្្ញងផា្ោំង	 Administrator Porperties ម្តរូវឈោះធតី្ឈៅម្តង់	 

Account is disabled និងបន្តចុចប៊ូតុង	OK

 ចំដណ្ឯ	Account ដែលរាន	 (Member of) Administrator 

ដែលបឈងកើតឈ�ើងឈពល	Set up windows ្ ្តីឈនាះម្តរូវ	Right+Click យ្	

ោ្ោយ	Properties ែដែល

	 រួចឈៅ្្ញងផា្ោំង	Administrator Porperties ម្តរូវធតី្ម្តង់	ចំណុច	

Account is disabled ឈែើមោបតីបិទ	User Account ឈនះ	ឈប់ឈម្បើម្បាស់		

និងចុចប៊ូតុង	OK។	ចុងបញ្ជប់	Restart រា៉ោសុតីន្ុំពោយូទ័រជាការឈម្សច៕

IT City Magazine
www.itcity.com.kh74

រូបភាពអាថ៌កំបំាងរូបភាពអាថ៌កំបំាង
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	 ក្រុមហ៊រុនទស្សនាវដ្តីទតីក្រុងព័តមានវិទ្យា	ទស្សនាវដ្តីទតីក្រុងទូរស័ព្ទ	មាន្ិតិ្យសសូមជកមាបជូនអតិថិជនមិត្អ្ន្អានទាំងអស់ឲ្យបានករាបថា៖				

ក រ្ុមហ៊រុនទស្សនាវដ្តីរបស់យយើងខ្ញមំានផ្ល់ជូននូវទស្សនាវដ្តីចាប់ពតីយលខចាស់ម្ដល់យលខថ្តៗី រាកបយេទ PDF តាមរយ:យេហទំព័រ www.itcity.com.kh   
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តារាងតម្លៃ គ្រឿងឧបករណ៍តារាងតម្លៃ គ្រឿងឧបករណ៍
LCD PROJECTOR

CANON LV 7295

Tripod Screen projector 1.8m
HP ScanJet G2410C

CHOPPER2
SNOW

HP ScanJet G4010

Canon Lide 110

HP ScanJet G3110

Epson Perfection V700

Canon Lide 210

Canon Lide 700

Bixolon SRP-350 Plus

Bixolon SRP-310 Plus

EPSON TM-T88IV USB

Birch CD-100B

Birch BS-915IIBU

Cipher Lab 1000

Birch BS-388IIIBU

Tripod Screen projector 2.5m

Tripod Screen projector 2.2m

Wall screen 1.8m (70”x 70”) 

Wall screen 2.2m (84”x 84”) 

Wall screen 2.5m (96”x 96”) 

CANON LV 7290 EPSON EB-S02 EPSON EB-S10 DELL M110

$ 600 $ 740

$ 80 $ 95

$ 99

TANK
MONDRIAN

$ 135

TANK TANK
MONDRIAN MONDRIAN

$ 135 $ 135

TANK
MONDRIAN

$ 135

$ 225

$ 70

$ 140

$ 635

$ 110
$ 125

$ 80
$ 80
$ 80

$ 55

$ 90
$ 70

$ 88

$ 130

$ 120

$ 120

$ 70

$ 135

$ 645 $ 645 $ 600

WALL SCREEN PROJECTOR

BARCODE SCANER

SCANNER

PRINT RECEIPT

HEADSET
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MAINBOARD

VGA

ROUTER

តារាងតម្លៃ
គ្រឿងបន្លាស់កំុពលាយូរទ័រ

CPU

• Intel Core i7 2600 3.4GHz  $305
• Intel Core i3 2120 3.3GHz   $127
• Intel Core i5 2400 3.1GHz   $188
• Intel Core 2 Duo E8400 3.0GHz   $105
• Intel Dual Core G620 2.6GHz   $69
• Intel Pentium 4 3.2GHz   $42
• Intel Pentium 4 3.0GHz   $39
• AMD Athlon II X2 250 3.0GHz  $62
• AMD X2 5400 2.8GHz   $53

• Intel Core i7 2600 3.4GHz  $305
• Intel Core i3 2120 3.3GHz   $127
• Intel Core i5 2400 3.1GHz   $188
• Intel Core 2 Duo E8400 3.0GHz   $105
• Intel Dual Core G620 2.6GHz   $69
• Intel Pentium 4 3.2GHz   $42
• Intel Pentium 4 3.0GHz   $39
• AMD Athlon II X2 250 3.0GHz  $62
• AMD X2 5400 2.8GHz   $53

• Power Color HD 5450 1GB 64-bit  $42
• Power Color HD 6450 1GB   64-bit  $46
• Power Color HD 5670 1GB 128-bit $59
• Power Color HD 6670 1GB 128-bit $94
• Power Color HD 6870 2GB, 2DVI, 2Display Port  $505
• Asus 5450 512MB    $43
• Asus ENGT520 1GB DDR3   $69
• Asus ENGT520 2GB DDR3   $79

• Belkin 150N Moden Router   $78
• Belkin Wireless N Router    $51
• Belkin Wireless G Range Extender  $80
• Belkin N1 Vision Wireless Router   $195
• TP-Link 3G Router 150M TL-MR3220  $33
• TP-Link Wireless Access Point   $43
•  Wireless Router Linksys WRT-120N  $49
• Linksys Wireless Router WRT-E1000  $67

RAM

• DDR3 8GB Adata    $48
• DDR3 4GB Transcend    $25
• DDR3 2GB Adata    $16
• DDR2 2GB Adata    $29
• DDR2 1GB Adata    $18
• DDR1 1GB Kingston    $25
• DDR1 512MB Adata    $19
For Laptop 
• DDR3 8GB Adata    $46
• DDR3 4GB Adata    $26
• DDR3 2GB Adata    $16
• DDR2 2GB Adata    $30
• DDR2 1GB Adata    $20

HHD

FLASH DRIVE

EXTERNAL DVD-R.W+

MEDIA PLAYER

OPTICAL DRIVE

EXTERNAL HARD DISK

DC ADAPTOR

PRINTER 

PC WEBCAM

SPEAKER

KEYBOARD & MOUSE

For Destop
• Sata 3TB Seagate    $179
• Sata 2TB Seagate    $117
• Sata 1TB Seagate   $85
• Sata 1TB Samsung   $130
• Sata 500GB Seagate   $65
For Laptop
• Sata 1TB Hitachi    $108 
• Sata 500GB WD    $65

• For LCD 12V/5A    $13
• For HP/Compaq 18.5V/4.9A  $25
• For HP/Compaq 19V/3.16A   $09
• For Sony 19.5V/3A/4.1A    $10
• For Sony 16V/4A    $10
• For Acer/Asus/Hasee 19V/3.16A  $09
• For Acer/Asus/Hasee 20V/3.25 Small $10
• For Acer/Asus/Hasee 19V/4.74A  $12
• For Fujistu 16V/3.75A/3.16A/3.36A $10
• For IBM/Lenovo 20V/4.5A/3.25A  $12

• HP DeskJet 1050 A4   $55
• HP LaserJet J3608 AIO A4 Color  $110
• HP LaserJet M1132MFP A4 Black  $140 
• Epson Stylus Injet TX121 A4 Color  $110 
• Epson Stylus Photo 420W   $175
• Canon Pixma MP276 A4 Color   $80
• Canon Laser shot LBP-2900 Black  $140

• SSK/Colorvis 330/331/332/335/ND20 $12
• SSK HD 031/032/350/352 5Mega  $12
• SSK/Colorvis HD 027/ND8 5Mega  $20 
• Colorvis Blackman 130Mega  $08 
• Colorvis 317/ND20/30/40/50   $12

• EARSON ER1067  $13
• EARSON ER2010A  $25
• EARSON ER2026  $28 
• EARSON ER2801  $37 
• EARSON ER2809 II   $40
• EARSON ER2399  $235
• DELL Mini    $10

KEYBOARD
• Dell USB    $10
• Apoint USB    $5 
• Foldable USB    $6 
Mouse
• Mouse Dell     $8
• Colorvis Wireless Combo   $22

• Transcend A3 1TB USB3    $110
• Transcend M2 500GB    $72
• Adata DashDrive HV610 1TB   $102
• Adata NH13 1TB USB3.0   $109
• Adata CH94 500GB    $69
• Adata NH13 500GB USB3.0   $83

• SSK External DVD-R.W SED001  $110
• SSK External DVD-R.W MD-T100  $72
• SSK External DVD-R.W MD-S200   $102
• Transcend External DVD RW   $48

• Asus DVD RW 24x Sata    $30
• Samsung DVD RW 24x Sata   $20
• Sony DVD RW 24x Sata   $23

• Adata 8GB     $8
• Adata 16GB     $13
• Adata 32GB     $23
• SSK 8GB     $9
• Transcend 300/350/500 8GB   $8 
• Transcend 300/350/500 16GB   $13
• Transcend 300/350/500 32GB   $23 UPS

• UPS Battery 12V-8.2Ah   $13
• UPS Power Tree 1250VA   $65
• UPS Power Tree 650VA   $34
• UPS Three Ace 1200VA   $55
• UPS Three Ace 650VA  $32 

• SSK RMVB Player PD210   $32
• SSK DVR Player 3.5” SDR001  $39
• SSK Super Slim DPF 8” 8025   $79
• Gadmei HDMI Media Box MB 700   $69
• Gadmei Portable Media player p82   $99
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MacMac
តារាងតម្លៃកំុព្យូទ័រ

Computer Price List

-Display : 13.3” TFT LED 1280 x 800 Glossy

-Processor : 2.4GHz Intel Core 2 Duo 

   3MB Shared L2 Cache

-Hard Drive : 250GB 5400 rpm

-Memory : 2GB of 1066MHz DDR3

-DVD-R : 8x DL Super Drive

-Graphic Card : NVIDIA GeForce 320M with 256MB 

   of DDR3 shared with main memory

-Battery : Built-in 10-hours battery

-Weight : 2.13kg

-Wireless : Built-in Airport Extreme Wi-Fi 

   (based on 802.1 In draft specification)

   built-in Bluetooth 2.1 + EDR

   (Enhanced Data Rate) wireless technology

-Expansion : Two USB 2.0 ports

-Display : 15.4” TFT LED 1440 x 900 Glossy

-Processor : 2.2GHz quad-core intel Core i7

   6MB Shared L3 Cache

-Hard Drive : 750GB 5400 rpm

-Memory : 4GB of 1333MHz DDR3

-DVD-R : 8x Super Drive

-Graphic Card : Intel HD Graphics 3000 with 384MB of 

   DDR3 shared with main memory and AMD 

   Radeom HD 6750M with 1MB GDDR5

-Battery : Built-in 7-hours battery

-Weight : 2.54kg

-Wireless : Built-in Airport Extreme Wi-Fi 

   (based on 802.1 In draft specification)

   built-in Bluetooth 2.1 + EDR

   (Enhanced Data Rate) wireless technology

-Expansion : One Thunderbolt port,

USB 2.0 ports, one Fire Wire 

800 port, one SDXC card slot

-Display : 13.3” TFT LED 1280 x 800 Glossy

-Processor : 2.7GHz dual-core intel Core i7

   4MB Shared L3 Cache

-Hard Drive : 500GB 5400 rpm

-Memory : 4GB of 1333MHz DDR3

-DVD-R : 8x Super Drive

-Graphic Card : Intel HD Graphics 3000 with 384MB

   of DDR3 shared with main memory

-Battery : Built-in 7-hours battery

-Weight : 2.04kg

-Wireless : Built-in Airport Extreme Wi-Fi 

   (based on 802.1 In draft specification)

   built-in Bluetooth 2.1 + EDR

   (Enhanced Data Rate) wireless technology

-Expansion : One Thunderbolt port,

USB 2.0 ports, one Fire Wire 

800 port, one SDXC card slot

-Processor : 2.3GHz Dual-Core Intel Core i5

   3MB Shared L2 Cache

-Hard Drive : 500GB 5400 rpm

-Memory : 2GB of 1066MHz DDR3

-DVD-R : N/A

-Graphic Card : Intel HD Graphics 3000 with 288MB

-Expansion : Thunderbolt port, FireWire 800 port 

   Four USB 2.0 ports, HDMI port, 

   SDXC card

-Display : 15.4” TFT LED 1440 x 900 Glossy

-Processor : 2.0GHz quad-core Intel Core i7

   6MB Shared L3 Cache

-Hard Drive : 500GB 5400 rpm

-Memory : 4GB of 1333MHz DDR3

-DVD-R : 8x Super Drive

-Graphic Card : Intel HD Graphics 3000 with 384MB of 

   DDR3 shared with main memory and AMD 

   Radeom HD 6490M with 256MB GDDR5

-Battery : Built-in 7-hours battery

-Weight : 2.54kg

-Wireless : Built-in Airport Extreme Wi-Fi 

   (based on 802.1 In draft specification)

   built-in Bluetooth 2.1 + EDR

   (Enhanced Data Rate) wireless technology

-Expansion : One Thunderbolt port,

USB 2.0 ports, one Fire Wire 

800 port, one SDXC card slot

-Processor : 2.3GHz Dual-Core Intel Core i5

   3MB Shared L2 Cache

-Hard Drive : 500GB 5400 rpm

-Memory : 2GB of 1066MHz DDR3

-DVD-R : N/A

-Graphic Card : Intel HD Graphics 3000 with 288MB

-Expansion : Thunderbolt port, FireWire 800 port 

   Four USB 2.0 ports, HDMI port, 

   SDXC card
MC 516ZP/A

MC 723ZP/A

MC 724ZP/A
MC 815P/A

MC 721ZP/A
MC 816ZP/A

$ 1,075

$ 2,259

$ 1,559

$ 639

$ 1,879

$ 839
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-Expansion : One Thunderbolt port,

USB 2.0 ports, one Fire Wire 
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-Processor : 2.3GHz Dual-Core Intel Core i5

   3MB Shared L2 Cache

-Hard Drive : 500GB 5400 rpm

-Memory : 2GB of 1066MHz DDR3

-DVD-R : N/A

-Graphic Card : Intel HD Graphics 3000 with 288MB

-Expansion : Thunderbolt port, FireWire 800 port 

   Four USB 2.0 ports, HDMI port, 

   SDXC card

-Display : 15.4” TFT LED 1440 x 900 Glossy

-Processor : 2.0GHz quad-core Intel Core i7

   6MB Shared L3 Cache

-Hard Drive : 500GB 5400 rpm

-Memory : 4GB of 1333MHz DDR3

-DVD-R : 8x Super Drive

-Graphic Card : Intel HD Graphics 3000 with 384MB of 

   DDR3 shared with main memory and AMD 

   Radeom HD 6490M with 256MB GDDR5

-Battery : Built-in 7-hours battery

-Weight : 2.54kg

-Wireless : Built-in Airport Extreme Wi-Fi 

   (based on 802.1 In draft specification)

   built-in Bluetooth 2.1 + EDR

   (Enhanced Data Rate) wireless technology

-Expansion : One Thunderbolt port,

USB 2.0 ports, one Fire Wire 

800 port, one SDXC card slot

-Processor : 2.3GHz Dual-Core Intel Core i5

   3MB Shared L2 Cache

-Hard Drive : 500GB 5400 rpm

-Memory : 2GB of 1066MHz DDR3

-DVD-R : N/A

-Graphic Card : Intel HD Graphics 3000 with 288MB

-Expansion : Thunderbolt port, FireWire 800 port 

   Four USB 2.0 ports, HDMI port, 
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MC 516ZP/A
MC 723ZP/A

MC 724ZP/A
MC 815P/A

MC 721ZP/A
MC 816ZP/A

$ 1,075

$ 2,259

$ 1,559

$ 639

$ 1,879

$ 839

-Display : 21.5” TFT LED 1290 x 1080 Glossy

-Processor : 2.5GHz quad-core Intel Core i5 

   6MB Shared L3 Cache

-Hard Drive : 500GB 7200 rpm

-Memory : 4GB of 1333MHz DDR3

-DVD-R : 8x DL Super Drive

-Graphic Card : AMD Radeon HD 6750M 

   512MB GDDR5

-Expansion : One Thunderblot port,

   One FireWire 800port, 

   Our USB 2.0 port...

-Processor : One 2.8GHz Quad-Core Intel Xeon “Nehalem” 

   processor 8MB Shared L3 Cache

-Hard Drive : 1TB 7200 rpm, 3GB/s

-Memory : 3GB of 1066MHz DDR3 ECC SDRAM

-DVD-R : 18x DL Super Drive

-Graphic Card : ATI Radeon HD 5770 with 1GB GDDR5

-Expansion : Three open full-length

   PCI Express 2.0 expansion slots

   with mechanical support for

   16-lane cards, 300W combined

   maximum for all PCI Express slots3

-Display : 13.3” TFT LED 1440 x 900 Glossy

-Processor : 1.7GHz Dual-core intel Core i5

   3MB Shared L3 Cache

-Hard Drive : 256GB SSD

-Memory : 4GB of 1333MHz DDR3 (on Board)

-DVD-R : Option external MacBook Air Super drive

   (DVD RDL/DVD RW/CD RW)

-Graphic Card : Intel HD Graphics 3000 with 384MB

-Battery : Built-in 7-hours battery

-Weight : 1.35kg

-Wireless : Built-in Airport Extreme Wi-Fi 

   (based on 802.1 In draft specification)

   built-in Bluetooth 2.1 + EDR

   (Enhanced Data Rate) wireless technology

-Expansion : Two USB 2.0 ports, (up to 480 MBps)

Thunderbolt port, SD Card slot

-Display : 27” TFT LED 2560 x 1440 Glossy

-Processor : 2.7GHz quad-core Intel Core i5

   6MB Shared L3 Cache

-Hard Drive : 1TB 7200 rpm

-Memory : 4GB of 1333MHz DDR3

-DVD-R : 8x DL Super Drive

-Graphic Card : AMD Radeon HD 6770M 

   512MB GDDR5

-Expansion : Two Thunderblot port,

   One FireWire 800port, 

   Our USB 2.0 port...

-Processor : Two 2.4GHz Quad-Core Intel Xeon “Westmere” 

   processor 12MB Shared L3 Cache

-Hard Drive : 1TB 7200 rpm, 3GB/s

-Memory : 6GB of 1066MHz DDR3 ECC SDRAM

-DVD-R : 18x DL Super Drive

-Graphic Card : ATI Radeon HD 5770 with 1GB GDDR5

-Expansion : Three open full-length

   PCI Express 2.0 expansion slots

   with mechanical support for

   16-lane cards, 300W combined

   maximum for all PCI Express slots3

-Display : 11.6” TFT LED 1366 x 789 Glossy

-Processor : 1.6GHz Dual-core intel Core i5

   3MB Shared L3 Cache

-Hard Drive : 64GB Flash Storage

-Memory : 2GB of 1333MHz DDR3 (on Board)

-DVD-R : Option external MacBook Air Super drive

   (DVD RDL/DVD RW/CD RW)

-Graphic Card : Intel HD Graphics 3000 with 256MB

-Battery : Built-in 5-hours battery

-Weight : 1.08kg

-Wireless : Built-in Airport Extreme Wi-Fi 

   (based on 802.1 In draft specification)

   built-in Bluetooth 2.1 + EDR

   (Enhanced Data Rate) wireless technology

-Expansion : Two USB 2.0 ports, (up to 480 MBps)

Thunderbolt port

-Display : 21.5” TFT LED 1920 x 1080 Glossy

-Processor : 2.7GHz quad-core Intel Core i5

   6MB Shared L3 Cache

-Hard Drive : 1TB 7200 rpm

-Memory : 4GB of 1333MHz DDR3

-DVD-R : 8x DL Super Drive

-Graphic Card : AMD Radeon HD 6770M 

   512MB GDDR5

-Expansion : One Thunderblot port,

   One FireWire 800port, 

   Our USB 2.0 port...

-Processor : Two 2.4GHz Quad-Core Intel Xeon “Westmere” 

   processor 12MB Shared L3 Cache

-Hard Drive : 1TB 7200 rpm, 3GB/s

-Memory : 12GB of 1066MHz DDR3 ECC SDRAM

-DVD-R : 18x DL Super Drive

-Graphic Card : ATI Radeon HD 5770 with 1GB GDDR5

-Expansion : Three open full-length

   PCI Express 2.0 expansion slots

   with mechanical support for

   16-lane cards, 300W combined

   maximum for all PCI Express slots3

MC 965ZP/A
MC 309ZP/A

MC 560ZP/A

MC 966ZP/A
MC 813ZP/A

MC 561ZP/A

MC 968ZP/A
MC 812ZP/A

MC 771ZP/A

$ 1,339

$ 1,279

$ 2,669

$ 1,650

$ 1,779

$ 3,690

$ 1,039

$ 1,579

$ 3,999

-Display : 13.3” TFT LED 1440 x 900 Glossy

-Processor : 1.7GHz Dual-core intel Core i5

   3MB Shared L3 Cache

-Hard Drive : 128GB Flash Storage

-Memory : 4GB of 1333MHz DDR3 (on Board)

-DVD-R : Option external MacBook Air Super drive

   (DVD RDL/DVD RW/CD RW)

-Graphic Card : Intel HD Graphics 3000 with 384MB

-Battery : Built-in 7-hours battery

-Weight : 1.35kg

-Wireless : Built-in Airport Extreme Wi-Fi 

   (based on 802.1 In draft specification)

   built-in Bluetooth 2.1 + EDR

   (Enhanced Data Rate) wireless technology

-Expansion : Two USB 2.0 ports, (up to 480 MBps)

Thunderbolt port, SD Card slot







SSK Power Bank

ឧបករណ៍សាកថ្មចល័ត
SRBC531

លក្ខណៈពិសេេ

Output: 5V/400-500mAh

Input 1: DC16-20V/3A

Input 2: DC9-14V/1.5A

USB Output: DC5V/500mA

Capacity: 30000mAh (Battery)

Cycle Life: 500 times

Charging Time: 7-8 h

	 SSK Power Bank SRBC531 គឺជាឧបករណ៍សាកថ្មចល័ត	

ផ្តល់ឲ្យលោកអ្នកពឹងពាក់ក្ននុងការល្បើ្រាស់លលើការសាកថ្មឧបករណ៍																		

លអឡិច្តរូនិចរាល់លពលល្វើដំលណើរកម្សាន្តលៅទីឆ្្យៗ។	 លោយឡឡក

ស្រាប់ឧបករណ៍សាកថ្មលនះអាចល្បើ្រាស់ជាមួយឧបករណ៍ដូចជា	

Notebooks, Cell Phone, PSP, NIDI, NDSL, MP3, MP4, 

Ebook, GPS, Interphone និងឧបករណ៍ចល័តជាល្ចើនលទៀត។			

មួយវិញលទៀតវារានភាពឆ្្តវវរាល់លពលឡដលមិនរានបល ច្េញថាមពល	

មកខាងល្រៅ	លោះវានឹង	Sleep	លោយសវ័យ្បវត្តិ	លដើម្បីជួយសន្សំសំវច	

ថាមពលរានមួយក្មិតលទៀត	មិនឡតបុ៉ល្ណ្ះ	SSK Power Bank 

SRBC531	រានសមត្ថភាពសាកថ្មរានរហ័សបង្កប់លោយអំពូល	4LED	

ស្រាប់	បង្្ញពីបរិរាណថាមពលលពលកំពុងល្បើ្រាស់។	 ចំឡណក

ការរចោលលើរូបរាងរបស់វាគឺរចោយ្៉ងស័ក្តសិម	 	 និង្សបតាមសម័យ	

កាលោលពលបចចេនុប្បន្ន	 ្ពមទាំងដំលណើរការរានល្អបំផុត	 លហើយវារាន	

ទំហំ	173 x 129 x 35មម		ទម្ងន់	1029្កាម	ផ្តល់ចំណុះថាមពល	

30000mAh	រួមជាមួយការល្បើ្ រាស់រានចំនួន	500 ដង	(Cycle Life)	

ជាពិលសសវាជាជល្មើសដ៏វិលសសស្រាប់លោកអ្នកជាអ្នកជំនួញ៕	

SSK

ផលិតផលថ្មមីៗ New Products

www.itcity.com.kh86 IT City Magazine



SSK Power Bank

ឧបករណ៍សាកថ្មចល័ត
SRBC531

លក្ខណៈពិសេេ

Output: 5V/400-500mAh

Input 1: DC16-20V/3A

Input 2: DC9-14V/1.5A

USB Output: DC5V/500mA

Capacity: 30000mAh (Battery)

Cycle Life: 500 times

Charging Time: 7-8 h

	 SSK Power Bank SRBC531 គឺជាឧបករណ៍សាកថ្មចល័ត	

ផ្តល់ឲ្យលោកអ្នកពឹងពាក់ក្ននុងការល្បើ្រាស់លលើការសាកថ្មឧបករណ៍																		

លអឡិច្តរូនិចរាល់លពលល្វើដំលណើរកម្សាន្តលៅទីឆ្្យៗ។	 លោយឡឡក

ស្រាប់ឧបករណ៍សាកថ្មលនះអាចល្បើ្រាស់ជាមួយឧបករណ៍ដូចជា	

Notebooks, Cell Phone, PSP, NIDI, NDSL, MP3, MP4, 

Ebook, GPS, Interphone និងឧបករណ៍ចល័តជាល្ចើនលទៀត។			

មួយវិញលទៀតវារានភាពឆ្្តវវរាល់លពលឡដលមិនរានបល ច្េញថាមពល	

មកខាងល្រៅ	លោះវានឹង	Sleep	លោយសវ័យ្បវត្តិ	លដើម្បីជួយសន្សំសំវច	

ថាមពលរានមួយក្មិតលទៀត	មិនឡតបុ៉ល្ណ្ះ	SSK Power Bank 

SRBC531	រានសមត្ថភាពសាកថ្មរានរហ័សបង្កប់លោយអំពូល	4LED	

ស្រាប់	បង្្ញពីបរិរាណថាមពលលពលកំពុងល្បើ្រាស់។	 ចំឡណក

ការរចោលលើរូបរាងរបស់វាគឺរចោយ្៉ងស័ក្តសិម	 	 និង្សបតាមសម័យ	

កាលោលពលបចចេនុប្បន្ន	 ្ពមទាំងដំលណើរការរានល្អបំផុត	 លហើយវារាន	

ទំហំ	173 x 129 x 35មម		ទម្ងន់	1029្កាម	ផ្តល់ចំណុះថាមពល	

30000mAh	រួមជាមួយការល្បើ្ រាស់រានចំនួន	500 ដង	(Cycle Life)	

ជាពិលសសវាជាជល្មើសដ៏វិលសសស្រាប់លោកអ្នកជាអ្នកជំនួញ៕	

SSK
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3G Mobile Wi-Fi   3G Mobile Wi-Fi មូ៉ដែល M5350 មាន

សមត្ថភាពក្នុងដែករំដលកអីុនធ�ើដែតបានយ៉ាង

ល្អពិធសសសម្មាប់សម័យកាលែ៍ទំធនើប ធ�ើយផ្តល់

ឲាយធោកអ្កាន់ដតមានភាពងាយម្សរួល និងធម្បើ 

ម្បាស់ជាមរួយអីុនធ�ើដែតបានទាន់ែិត្ដជាមរួយ 

បធែចេកវិទាយា 3G Modem។ ែំដែកការរែនា 

ជាមរួយរូបរាងកាន់ដតទាន់ម័យគឺមានទំ�ំរូបរាង 

តូែល្មមម្សរួលដាក់ធៅតាមខ្លួនបានម្គប់ទីកដន្ង 

មាយា៉ ាងវ ិញធទៀតធោកអ្កអាែធម្បើម្បាស់វាជា 

លក្ខែៈ  Wi-Fi hotspot ធដាយផ្ាល់ធម្រោះ

ថាឧបករែ៍ធនោះអាែដាក់ជាមរួយ 3G SIM 

card ធ�ើយអាែជរួយបដន្ថមធលើ ការ Download 

រ�ូតែល់ 21.6Mbp ក្នុងមរួយវិនាទី និងធលាបឿន 

Upload  5.76Mbp ក្នុងមរួយវិនាទី។  មិនដត 

ប៉ុធ្ណាោះ M5350 អាែផ្តល់ 3G wireless 

សម្មាប់ដែករំដលកធៅកាន់អ្កធម្បើម្បាស់ែំនរួន 

10 ម្ពមៗគា្ន ែំដែកថាមពលថ្មអាែផ្នុកបាន 

2000mAh ដែលផ្តល់ឲាយមានភាពរីករាយ 

ជាមរួយការធម្បើម្បាស់ និងធ�វើការងារធទៀតផង។ 

ជាមរួយការបងា្ាញធដាយ  OLED  ឧបករែ៍ធនោះ 

អាែមានមុខងារ ជាធម្ែើន ដែលធោកអ្កអាែធម្បើ 

ម្បាស់ជា signal strength, network type 

(2G/3G), Wi-Fi status, message, Internet 

connection status, battery meter, 

auto mode និង traffice statisticsផងដែរ៕លក្ខណៈពិសេេ
HARDWARE FEATURES
ម្បធេទ Network:    HSPA+/HSUPA/HSDPA/UMTS

Interface:  រន្ធ micro USB ែំនរួន 1 សម្មាប់ Power Supply

ប៊ូតុង  Power:    On/Off Button/Reset Button

Antenna:   Internal Antenna

Data Rates:   DL: 21.6Mbps, UL:5.76Mbps

Dimensions:  94×56.7×19.8mm ( W x D x H )

ថាមពលផ្គត់ផ្គង:់  Internal 2000mAh Rechargeable Battery, 5VDC/1.0A

Micro SD Card Reader:  ដាក់បដន្ថមែល ់32G

WIRELESS FEATURES
Wireless Standards: IEEE 802.11b, IEEE 802.11g, IEEE 802.11n

ធ្រ�វកង:់    2.4-2.4835GHz

Wireless Security:  Support 64/128 bit WEP, WPA-PSK/WPA2-PSK,Wireless 

    MAC Filtering, Enable/Disable SSID Broadcast

DHCP:    DHCP server, DHCP Client List

ផ្សេងៗ
ម្បព័ន្ធតម្មរូវការ:   Windows 8/7/vista/XP,Mac OS, Android, iOS

ទម្ងន:់    92.5 ម្កាម (battery included)

ម៉ូដែល

ឧបករណ៍

ែ៏ទំន�ើប
M5350 

10 Users

6-7 hours
2000 mAh
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Gaming Notebook
MSI GX60

ផលិតផលថ្មីៗ New Products

www.itcity.com.kh88 IT City Magazine

 MSI GX60 គឺជាកុំព្យូទ័រ Notebook សេរីថ្មីរចនាស�ើងបង្កប់មកជាមួយ      

េមត្ថភាពដំស�ើរការខ្ពេ់ចំសោះការសេងស្គេមសោយអានុភាពរបេ់ខួរក្បាេ 

AMD CPU និង GPU។ ជាមួយម៉្េុមីនស្គេមទំ្ំ 15.6  អមីុង ក្នុងសនាះមន 

បង្កប់នូវខួរក្បាេ AMD Trinity A10 Quad-Core និងក្កា្្ិកកាត Radeon 

HD7970M រួមជាមួយសមម៉ូរុីវីសដអ ូ2GB ផងដដរ។ សដើម្បមីជក្មុញបដន្ថមចំសោះការ

សេងស្គេម ក្កុម្៊ុន MSI បដន្ថមនូវ Killer E2200 Gaming network card 

និង Keyboard េក្មប់សេងស្គេមក្បសេទ SteelSeries។ មិនដតប៉ុស្ណ្ះវាក៏

បានបដន្ថមនូវបសចចេកវិទ្យា Turboo Drive Engine េក្មប់ដំស�ើរការភា្្មៗសពេ

មនការប៉ះទងគេិចសៅសេើ អ្មីមួយ។

 កុំព្យូទ័រ GX60 បង្កប់មកជាមួយសមម៉ូរុីទំ្ ំ8GB និងថាេរឹងទំ្ំ 750GB 

ដដេមនរង្ិេជំុ 7200R ក្នុងមួយនាទមី រីឯ Blu-ray Disc Drive េក្មប់ឲ្យ 

សោកអ្ករីករាយជាមួយនឹងវីសដអូយ៉្ងរីករាយ។ វាបំោក់មកជាមួយសអក្កង់ទំ្ ំ

15.6 អ៊ីង ផ្តេ់ Resolution 1920×1080 Full HD រួមជាមួយការ 

ការោរការចាំង សដើម្បមីកាត់បន្ថយការក្េវាំងដេ្ក។ ម្យា៉្ងសទៀតសដើម្បមីស្្ើឲ្យកាន់ដត 

ពិសេេកុំព្យូទ័រយួរ ដដ សនះបញចេូេនូវឧបករ�៍បំពងេំស�ង THX Stereo និង 

Subwoofer ក្ពមទាំង បដន្ថម Audio Boost េក្មប់បសង្កើនេំស�ងផងដដរ។ 

កុំព្យូទ័រ GX60 ទទួេបានផងដដរនូវក្បោប់ពក្ងមីកេំស�ងេក្មប់កាេ និង 

Gold Flash Jack ផ្តេ់ភាពក្តឹមក្តរូវនូវេំស�ងតាមរន្ធ Audio Jack។ GX60 

អាចសក្បើក្បាេ់បានជាមួយ WiFi និងបង្កប់មកជាមួយរន្ធ 5-in-1 Card Reader 

រន្ធ USB 3.0 ចំនួនបមី  រន្ធ HDMI 1.4 និង Touchpad ចំនួនមួយ៕
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Gaming Notebook
MSI GX60
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HD7990
384 bItsx2, 925 Mhz, 
dual GPU

GTX690
256bItsx2, 915 Mhz, 
dual GPU

GTX660Ti
192bIts, 928 Mhz

GTX560Ti
256bIts, 822 Mhz

GTX650Ti
192bIts, 941 Mhz

GTX680
256bIts,1006M

Zotac GTX680/4G/D5
256bits, 1006/6008 Mhz $699 USD

GTX670
256bIts, 954 Mhz

Zotac GTX670/2G/D5
256bits, 954/6008Mhz     $499

GTX660
192bIts, 993 Mhz

Zotac GTX660/2G/D5
192 bits, 993/6008 Mhz $375

GTX650
128bIts,1071Mhz

Zotac GTX650/1G/D5
128 bits,1071/5000 Mhz $199

GT630
128bIts, 810 Mhz

Zotac GT630/1G/D3
128 bits,810/1333    $125

GT430
128bIts, 700 Mhz

Zotac GT430/4G/D3
128bit,700/1066        $145

GT520
64bIts, 810 Mhz

Zotac GT520/2G/D3
64bit,810/1066         $88

GT210
64bIts, 520 Mhz

Zotac GT210/1G/D3
64bit,520/1066,low profile    $60

HD7950
384 bIts, 900 Mhz

PowerColor AX7950/3G/D5
384 bIts,900/5000MHz ,                $499

HD7870
256 bIts, 1000 Mhz

PowerColorAX7870/2G/D5
256bIts, 1000/4800MHz           $350

HD7850
256 bIts, 860 Mhz

PowerColor AX7850/2G/D5
256bIts, 860/4800MHz             $299

HD7770
128 bIts, 1000 Mhz

PowerColor AX7770/1G/D5
128bIts, 1000/4500MHZ             $199

HD7750
128 bIts, 800 Mhz

PowerColor AX7750/2G/D3
128bIts, 800/1600MHZ                  $175

HD6570
128 bIts, 650 Mhz

PowerColor AX6570/2G/D3
128bIts, 650Mhz              $125

AMD NVIDIA NVIDIA sample cardAMD sample card

HD5570
128 bIts, 650 Mhz

PowerColor AX5570/2G/D3
128bIts, 650Mhz              $99

HD5670
128 bIts, 775 Mhz

PowerColor AX5670/1G/D3
128bIts, 775Mhz              $115

HD6450
64 bIts, 625 Mhz

PowerColor AX6450/1G/D3
64 bIts, 625 Mhz            $75

HD5450
64bIts, 650 Mhz

PowerColor AX5450/1G/D3
64 bIts, 650 Mhz            $55

GTX550Ti
192bIts, 900 Mhz

Zotac GTX550Ti/1G/D5
128 bits,900/4100 Mhz $180

HD7970
384 bIts, 925 Mhz

PowerColor AX7970/3G/D5
384 bIts,925/5500MHz                   $599

	 ត�ើតោកអ្នកគួរត�ត្រើសតរើសរវាង	AMD	និង	Nvidia Display	កា�តោយរត�ៀ�ណា?		ត្កាមតនះគឺជាតារាងតែល�ញ្ជាក់ពី	

លក្ខណៈពិតសស	និង�មមលៃស្រា�់ម៉ូតែលនីមួយៗ៖

v s
VGA display card: 
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ADATA Premier Pro

  ការគួបផ្សំយ៉្ងពិសេេ និងអស្្រ្យរបេ់សេេ៉ូរុីកាត Premier Pro 

ប្រ្េទ SDXC ទំហំ 64GB UHS-I U1 Class 10 VS រួេជាេួយ 

ការជំរុញដំស�ើការទំាង សនះ មានសៅក្នុងសេេូ៉រីុកាតទំាងពីរ ដដលជាផលិតផល 

របេ់បកុេហុ៊ន ADATA។     េ្យ្៉ងវិញសទៀតជាេួយកបេិតសល្បឿនយ្៉ងសលឿន

សោយសរដតចំ�ុចបបទាន់បបសេទ SD 3.0 ជំនាន់ចុងសបកាយកាន់ដត 

ពិសេេេបមាប់   Ultra High Speed (UHS-I) សទើបស វ្ើឲ្យវាអាចសផទេរទិន្ន័យ 

បានឆាប់រហ័េ។ េួយវិញសទៀតវាជួយឲ្យកាសេរា៉របេ់សោកអ្កសឆាព្ះសៅ

កាន់េកា្្នុភាពដ៏អស្្រ្យបពេទាំងមានភាពបតរូវគ្្ជាេួយនឹងឧបករ�៍ 

សផ្សងៗសទៀត សហើយសេេ៉ូរុីសនះអាចបបតិបត្ិសល្បឿនបញ្ចូនទិន្ន័យសៅដល់ 

95MB ឫ ផទេនុកទិន្ន័យ 45 MB ក្នុងេួយវិនាទី។ សលើេពីសនះគឺភាពល្អឥតស្្្ះ 

េបមាប់សល្បឿនដ៏ខ្ពេ់ក្នុងការថតយករូបភាពរួេជាេួយភាពរលូនក្នុងការ 

ថតវីសដអូបាន ច្បាេ់កបេិត Full HD សទៀតផង៕

បង្កើនដំង�ើរការកាន់តែខ្ពស់

SDXC

UHS-I U1



សមត្ថភាពទ្វេដងនៃ

WIFI network
ម៉ូដដលថ្មីរបស់ TPLINK

	 លោកអ្នកពិតជាចង់បានឧបករណ៍	 WIFI 

network ដែលមានការចនាបបកបលៅលោយភាព

អស្ចារចាយ	 និងសមត្ថភាពលែើមចាបីយកលៅបំលពញក្ននុង	

កិច្ចការងារបបចាំថ្ងៃ។	 	ពិតណាស់លនាះគឺ	 Zyxel 

3000 ជាឧបករណ៍	WIFI network ម៉ូដែល		

្្ ីម ួយម៉ ូដែលល�ៀតដែលបតរូវបានបករុមហ៊ រុន	

TPLINK ល្វើការរចនាល�ើងយ៉ចាងពិលសសបសស់់	

ស្ចាត	រឹងមំា	និងបំពាក់មកជាមួយចំមរុខងារពិលសស

ជាលបចើនដែលគួរជា�ី	 លពញចិត្ត។	 វាអាចកំណត់	

ជា	 		Wireless LAN Management con-

troller លហើយមាន	 WNA3000-V Series 

អាចបគប់បគងលលើ	 NWA3000 Series AP 

ចំនួន	24 ល្ចាេងចា�ៀត		ដែលបគប់បគងជាបបលេ�	

AP មចាយ៉ចាងវិញល�ៀតបានបំពាក់	 Seamless 

roaming ជាមួយ	 SSID លែើមចាបីីឲចាយមាន	

ែំលណើរការឆ្លងកាត់បគប	់AP (Access points) 

ទាំងអស់	 ឧទាហរណ៍បបសិនលបើលោកអ្នកបាន	

logged on លៅកាន់	AP លៅជាន់�ី1	លនាះលោក	

អ្នកមិនបតរូវការ	re-log លៅជាន់�ី	4		ល�។	លោយ	

ដ�កសបមាប់បបព័ន្ធសរុវត្តិភាព	 បតរូវបានភា្ចាប់មក	

ជាមួយ	 RADIUS server ដែលមាន	 WPA/

WPA2 personal និង Enterprise Eertifi-

cation លហើយ	 	 NWA3000-N Series 

មរុខងាររបស់វាអាចភ្ាចាប់ជាមួយ	 ADIUS server 

ដែលអាច	្ ្តល់ជា	Centralized  Authenti-

cation, Authorization និង Accounting  

management សបមាប់ករុំពចាយូ�័រតភ្ាចាប់	 លហើយ	

លបបើបបាស់ Network Service។		 មចាយ៉ងល�ៀត	

NWA3000-N Series AP បានបំពាក់	

មកជាមួយ	Standard 802.3af ឬ 802.3at 

PoE ដែលអាចឲចាយ	APs លបបើបបាស់ដខចាេដែលមាន	

និង��ួលថាមពលពី	 PoE switches មិន							

ដតប៉រុលណាណចាះវាមានភាពងាយបសូលក្ននុងការតំចា�ើង	

និង	Controller AP លបើកលោយសវ័យបបវត្តិ	និង	

ការបគប់បគងជាបករុម					រួមជាមួយការ ្្តលនូ់វការពារ	

លោយសវ័យបបវត្តិដែលបានបលងកើតរវាង Con-

troller AP និង APs៕
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ADATA Premier Pro

  ការគួបផ្សំយ៉្ងពិសេេ និងអស្្រ្យរបេ់សេេ៉ូរុីកាត Premier Pro 

ប្រ្េទ SDXC ទំហំ 64GB UHS-I U1 Class 10 VS រួេជាេួយ 

ការជំរុញដំស�ើការទំាង សនះ មានសៅក្នុងសេេូ៉រីុកាតទំាងពីរ ដដលជាផលិតផល 

របេ់បកុេហុ៊ន ADATA។     េ្យ្៉ងវិញសទៀតជាេួយកបេិតសល្បឿនយ្៉ងសលឿន

សោយសរដតចំ�ុចបបទាន់បបសេទ SD 3.0 ជំនាន់ចុងសបកាយកាន់ដត 

ពិសេេេបមាប់   Ultra High Speed (UHS-I) សទើបស វ្ើឲ្យវាអាចសផទេរទិន្ន័យ 

បានឆាប់រហ័េ។ េួយវិញសទៀតវាជួយឲ្យកាសេរា៉របេ់សោកអ្កសឆាព្ះសៅ

កាន់េកា្្នុភាពដ៏អស្្រ្យបពេទាំងមានភាពបតរូវគ្្ជាេួយនឹងឧបករ�៍ 

សផ្សងៗសទៀត សហើយសេេ៉ូរុីសនះអាចបបតិបត្ិសល្បឿនបញ្ចូនទិន្ន័យសៅដល់ 

95MB ឫ ផទេនុកទិន្ន័យ 45 MB ក្នុងេួយវិនាទី។ សលើេពីសនះគឺភាពល្អឥតស្្្ះ 

េបមាប់សល្បឿនដ៏ខ្ពេ់ក្នុងការថតយករូបភាពរួេជាេួយភាពរលូនក្នុងការ 

ថតវីសដអូបាន ច្បាេ់កបេិត Full HD សទៀតផង៕

បង្កើនដំង�ើរការកាន់តែខ្ពស់

SDXC

UHS-I U1







Sanwa 

PC Koubou Amphis BTO

 ក្រុមហ៊រុន PC Koubou បានបង្ហាញផលិផល

ខ្លួនសេរីថ្មីមួយកបសេទសទៀតសហើយ សោះគឺ្រុំពហាយូទ័រ 

េករាប់សលងសហគេម ម៉ូដែល Amphis BTO Di 

GS7300-Ci7-QX-CODBOII។ ចំសោះកបព័ន្ធ 

េរាេធាតរុរបេ់វារានបង្កប់ម្ជាមួយែូចជាខួរ ហ្ាបាល 

Intel Core i7-3770K សលហាបឿន 3.50GHz/ Intel 

Z77 Express Chipset / ករាហ្ិ្រាត Ge-

Force GTX 670 2GB OC Edition/ អងគេចងចា ំ

8GB កបសេទ DDR3/ ថាេរឹង 1TB/ DVD Super 

Multi Drive/ 700W 80PLUS Power Supply 

និងសកបើកបព័ន្ធែំស�ើររារ Windows 7 Home 

Premium 64-bit (SP1)៕

កុំព្យូទ័រសម្រាប់លេងល្គេមជំនាន់ថ្មី
Di GS7300-Ci7-QX-CODBOII

 តាមរយៈរូបរាងឧប្រ�៍ដែលសោ្អ្ន្បានស�ើញសនះ វាគឺជា Card Reader 

េករាប់ទូរេ័ព្ទ Android (Android Smartphone) សោះគឺ Sanwa 400-GA-

DR003W។ រាររចោយ៉ហាងពិសេេេករាប់ទូរេ័ព្ទ Android របេ់សោ្អ្ន្ Card 

Reader សនះរានរន្ធ Card ចំនួនពមីរេករាប់សមម៉ូររុី SD និង microSD សោយដែ្វា 

្៏រានផ្តល់នូវ Interface បមីសផហាេងសទៀតេករាប់ស្្ើរារតភ្ហាប់ែូចជា: រន្ធ micro-USB/ 

រន្ធ USB និងរន្ធ HDMI ផងដែរ៕

Android Smartphone Card Reader
400-GADR003W 
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Transcend

 នៅខណៈនេលនេះនោកអ្នកកាេ់តែមាេការភ្ញាក់ន្អ ើលជាមួយឧបករណ៍ 

របស់ Transcend នស៊រីថ្មីនោះគ ឺ SSD720 ជាឧបករណ៍្្ទុកទិេ្នេ័យជំោេ់ចុង 

ន្កាយនេ SATA III 6Gb/s solid state drive (SSD) ន�ើយទទួលចំនោះការ 

រចោនលើរូបរាងយ៉ញាងនសតើងែូច េិងមាេក្មាស់នសតើងជាងឧបករណ៍ដ៏នទ្ែរឹមតែ 7មម 

ប៉ុន្ណញាះ រួមជាមួយនលញាបឿេបញ្ចូលទិេ្នេ័យក្នទុងក្មិែនលញាបឿេនទវេដងគ្ញាេេមីរនលឿេជាង   

Serial ATA II 3Gb/s interface ជំោេ់មុេ។  នោយតែកស្មាប់ការបំោក់នោយ 

SATA III 6Gb/s ជាមួយ SandForce Controller នទើបន្វេើឲញាយ SSD720 អាច 

បញ្ចូេទិេ្នេ័យក្នទុងក្មិែនលញាបឿេ 560MB ក្នទុងមួយវិោទមីនេការអាេ រីឯ 540MB   

ក្នទុងមួយវិោទមីនេនលញាបឿេ្្ទុកទិេ្នេ័យ។  កាេ់តែេិនសសជាងនេះនោកអ្នកអាចទាញ 

យកេូវកម្វិ្មី SSD Scope ស្មាប់ន្វេើការសំអាែ េិង្ែរួែេិេិែញាយបញ្ញា Error 

នដើមញាបមីជួយ រកញាសា SSD720 ឲញាយមាេដំនណើរការបាេនលញាបឿេជាមួយបនច្កវិទញាយា S.M.A.R.T. 

តថមនទៀែ្ង។ បតេថែមេមីនេះនទៀែវាមិេគួរឲញាយនជឿចំនោះក្មិែនេការន្្រឧបករណ៍នេះ

អាចន វ្េើបាេនលើក្មិែនលញាបឿេ្រាល 4k Random File ន�ើយអាច្្ទុករ�ូែដល់ 

93,000 IOPS េិងសមថែែភេបញ្ចូេនៅកាេ់ទំ�ំ 4.7GB DVD ្ែរឹមតែ 15 

វិោទមីតែបុ៉ន ណ្ញាះ៕

ជំនាន់ថ្មីបង្កើនសមត្ថភាពង្វេដ្
SSD720
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